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Your printer and the recommended supplies have been designed and tested to meet strict safety 
requirements. Attention to the following information ensures the continued safe operation of your Xerox 
printer. 
 

1 Safety 
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Warning Symbols 

Symbol Description 

 

WARNING or CAUTION: 
Ignoring this warning could cause serious injury or even death. 
To avoid personal injury, use caution. 
To avoid property damage, use caution. 

 

WARNING: 
Hot surface on or in the printer. Use caution to avoid personal injury. 

 

WARNING: 
Moving parts. To avoid personal injury, use caution. 
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Notices and Safety 

Carefully read the following instructions before operating your printer. Refer to these instructions to 
ensure the continued safe operation of your printer. 

Your Xerox® printer and supplies are designed and tested to meet strict safety requirements. Safety 
requirements include safety agency evaluation and certification, and compliance with electromagnetic 
regulations and established environmental standards. 

The safety and environment testing and performance of this product have been verified using Xerox® 
materials only. 
 

 WARNING: Unauthorized alterations, which can include the addition of new functions or connection 
of external devices, can affect the product certification. For details, contact your Xerox representative. 

 
 

Emergency Turn Off 

If any of the following conditions occur, turn off the printer immediately and disconnect the power cord 
from the electrical outlet. Contact an authorized Xerox service representative to correct the problem if: 
• The equipment emits unusual odors or makes unusual noises. 
• The power cable is damaged or frayed. 
• A wall panel circuit breaker, fuse, or other safety device has been tripped. 
• Liquid is spilled into the printer. 
• The printer is exposed to water. 
• Any part of the printer is damaged. 
 

General Guidelines 
 

 WARNINGS: 

• Do not push objects into slots or openings on the printer. Touching a voltage point or shorting out 
a part could result in fire or electric shock. 

• Do not remove the covers or guards that are fastened with screws unless you are installing 
optional equipment and are instructed to do so. Turn off the printer when performing these 
installations. Disconnect the power cord when removing covers and guards for installing optional 
equipment. Except for user-installable options, there are no parts that you can maintain or service 
behind these covers. 
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The following are hazards to your safety: 
• The power cord is damaged or frayed. 
• Liquid is spilled into the printer. 
• The printer is exposed to water. 
• The printer emits smoke, or the surface is unusually hot. 
• The printer emits unusual noise or odors. 
• The printer causes a circuit breaker, fuse, or other safety device to activate. 

If any of these conditions occur, do the following: 
1. Turn off the printer immediately. 
2. Disconnect the power cord from the electrical outlet. 
3. Call an authorized service representative. 
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Electrical Safety 

Carefully read the following instructions before operating your printer. Refer to these instructions to 
ensure the continued safe operation of your printer. 

Your Xerox® printer and supplies are designed and tested to meet strict safety requirements. Safety 
requirements include safety agency evaluation and certification, and compliance with electromagnetic 
regulations and established environmental standards. 

The safety and environment testing and performance of this product have been verified using Xerox® 
materials only. 
 

 WARNING: Unauthorized alterations, which can include the addition of new functions or connection 
of external devices, can affect the product certification. For details, contact your Xerox representative. 

 
 

Electrical Supply 

The electrical supply for the device must meet the requirements stated on the data plate on the rear of 
the device. If you are not sure that your electrical supply meets the requirements, consult your local 
electricity provider or a licensed electrician. 
 

 WARNING: The device must be connected to a grounded electrical circuit. The device is supplied with 
a grounded electrical plug that fits into a grounded electrical outlet. The power cord plug only fits into 
a grounded electrical outlet. The power cord design is a safety feature. If you are unable to insert the 
power cord plug into your electrical outlet, consult your local electricity provider or a licensed 
electrician. Always connect the device to a properly grounded electrical outlet. 

 
 

Emergency Turn Off 

If any of the following conditions occur, turn off the printer immediately and disconnect the power cord 
from the electrical outlet. Contact an authorized Xerox service representative to correct the problem if: 
• The equipment emits unusual odors or makes unusual noises. 
• The power cable is damaged or frayed. 
• A wall panel circuit breaker, fuse, or other safety device has been tripped. 
• Liquid is spilled into the printer. 
• The printer is exposed to water. 
• Any part of the printer is damaged. 
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Power Cord Safety Information 

Carefully read the following instructions before operating your printer. For details, contact your Xerox 
representative. 
 

 WARNINGS: 

• The electrical supply for the device must meet the requirements stated on the data plate on the 
rear of the device. If you are not sure that your electrical supply meets the requirements, consult 
your local electricity provider or a licensed electrician. 

• Do not use an extension cord. 
• Do not remove or modify the power cord. 

 

Refer to these instructions to ensure the continued safe operation of your printer. 
• Use the power cord supplied with your printer. 
• Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the 

cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to check the 
outlet. 

• Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a 
ground connection terminal. 

 

 WARNING: Avoid the potential of electrical shock by ensuring that the printer is grounded properly. 
Electrical products can be hazardous if misused. 

 

• Verify that the printer is plugged into an outlet that is providing the correct voltage and power. 
Review the electrical specification of the printer with an electrician if necessary. 

• Do not place the printer in an area where people can step on the power cord. 
• Do not place objects on the power cord. 
• Replace the power cord if it becomes frayed or worn. 
• Do not unplug or plug the power cord while the printer is turned on. 
• To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord. 
• The electrical outlet must be near the printer and must be easily accessible. 

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary to 
disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet. For 
details, see Turning the Printer On and Off on page 39. 
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Operational Safety 

Your printer and supplies were designed and tested to meet strict safety requirements. These include 
safety agency examination, approval, and compliance with established environmental standards. 

Your attention to the following safety guidelines helps to ensure the continued, safe operation of your 
printer. 
 

Printer Location 
• Place the printer on a level, solid, non-vibrating surface with adequate strength to hold the weight of 

the printer. To find the weight for your printer configuration, see Physical Specifications on page 
284. 

• Do not block or cover the slots or openings on the printer. These openings are provided for 
ventilation and to prevent overheating of the printer. 

• Place the printer in an area where there is adequate space for operation and servicing. 
• Place the printer in a dust-free area. 
• Do not store or operate the printer in an extremely hot, cold, or humid environment. 
• Do not place the printer near a heat source. 
• Do not place the printer in direct sunlight to avoid exposure to light-sensitive components. 
• Do not place the printer where it is directly exposed to the cold air flow from an air conditioning 

system. 
• Do not place the printer in locations susceptible to vibrations. 
• For optimum performance, use the printer at elevations recommended in Elevation on page 289. 
 

Operational Guidelines 
• Do not remove the paper source tray that you selected using either the print driver or control panel 

while the printer is printing. 
• Do not open the doors when the printer is printing. 
• Do not move the printer when it is printing. 
• Keep hands, hair, neckties, and so on, away from the exit and feed rollers. 
• Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove 

the protective covers. 
• Ensure that the rear right cover is attached. Open this cover when connecting an interface cable. 
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Consumables Information 
• Store all supplies in accordance with the instructions given on the package or container. 
• Keep all supplies away from the reach of children. 
• Never throw toner, print/drum cartridges, or toner containers into an open flame. 
• When handling supplies, avoid skin or eye contact. Eye contact can cause irritation and 

inflammation. Do not attempt to disassemble supplies, which can increase the risk of skin or eye 
contact. 

 

 CAUTION: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreement, 
and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance 
caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for this printer. The 
Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary 
outside these areas. Please contact your Xerox representative for details. 

 
 

Vacuum Cleaner Use for Toner Spills 

Use a broom or wet cloth to wipe off spilled toner. To minimize generation of dust particles, sweep or 
wipe slowly. Avoid using a vacuum. If you must use a vacuum, ensure the unit is designed to contain 
combustible dusts. Ensure that the vacuum includes an explosion rated motor and non-conductive hose. 
 

Ozone Release 

This printer produces ozone during normal operation. The amount of ozone produced is dependent on 
copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone. 
Install the printer in a well-ventilated room. 

For more information in the United States and Canada, go to www.xerox.com/environment. In other 
markets, please contact your local Xerox representative or go to www.xerox.com/environment_europe. 
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Safety 

 

Maintenance Safety 

Your Xerox® printer and supplies are designed and tested to meet strict safety requirements. Safety 
requirements include safety agency evaluation and certification, and compliance with electromagnetic 
regulations and established environmental standards. Refer to these instructions to ensure the continued 
safe operation of your printer. For details, contact your Xerox representative. 
• Follow all warnings and instructions marked on, or supplied with, the product, options, and supplies. 
• Do not attempt any maintenance procedure that is not specifically described in the documentation 

supplied with your printer. 
• Always exercise care when moving or relocating your printer. Contact your Xerox representative to 

arrange the relocation of your printer. 
• Never throw toner, print/drum cartridges, or toner containers into an open flame. 
 

 WARNINGS: 

• Before cleaning the printer, unplug it from the electrical outlet. 
• Do not use aerosol cleaners. Aerosol cleaners can cause explosions or fires when used on 

electromechanical equipment. 
• The metallic surfaces in the fuser area are hot. To avoid personal injury, use caution. 
• Do not attempt to remove paper that is jammed deeply inside the product. Switch off the 

product promptly and contact your local Xerox representative. 
• Do not apply excessive force on the document glass. 
• Do not override any electrical or mechanical interlock devices. 
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Safety 

 

Printer Symbols 

Symbol Description 

 

WARNING or CAUTION: 
Ignoring this warning could cause serious injury or even death. 
To avoid personal injury, use caution. 
To avoid property damage, use caution. 

 

WARNING: 
Hot surface on or in the printer. Use caution to avoid personal injury. 

 

Do not burn the waste container. 

 

Do not expose the drum cartridge to light for more than 10 minutes. 

 

Do not touch the drum cartridge. 

 

Hot surface. Wait the indicated time before handling. 

 

WARNING: 
Moving parts. To avoid personal injury, use caution. 
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Safety 

 

Environmental, Health, and Safety Contact 
Information 

For more information on Environment, Health, and Safety in relation to this Xerox product and supplies, 
contact the following customer help lines: 
United States and Canada: 1-800-ASK-XEROX (1-800-275-9376) 

Europe: +44 1707 353 434 

For product safety information in the United States and Canada, go to www.xerox.com/environment. 

For product safety information in Europe, go to www.xerox.com/environment_europe. 
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Features 

 

Parts of the Printer 

This section includes: 
• Left Front View .................................................................................................................................................................. 24 
• Left Rear View ................................................................................................................................................................... 25 
• Internal Components ..................................................................................................................................................... 25 
• Document Feeder ............................................................................................................................................................ 26 
• Control Panel ..................................................................................................................................................................... 26 
• Business Ready Finisher with Optional Booklet Maker ...................................................................................... 28 
• Business Ready Finisher with Optional C/Z Folder .............................................................................................. 28 
• Wireless Network Adapter ............................................................................................................................................ 29 
 

Left Front View 

 

1. Leveler Foot 
2. Tray 5 
3. Left Tray 
4. USB Port 
5. Document Cover 
6. Document Glass 
7. Control Panel 
8. Center Output Tray 
9. Center Bottom Tray 
10. Secondary Power Switch 
11. Front Door 
12. Trays 1–4 
13. Locking Casters 
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Left Rear View 

 
1. Circuit Breaker 
2. Rear Right Cover 
3. USB Memory Card Connections 
4. USB Port, Type A 
5. USB Port, Type B 
6. Status Indicator 
7. Side 2 Scan Cable 
8. USB Memory Port, for service only 

9. Ethernet Connection 
10. Foreign Device Interface 
11. Fax Connections (optional) 
12. Door D Release Lever 
13. Door A Release Lever 
14. Door B Release Lever 
15. Door C Release Lever 

 

Note: Ensure that the rear right cover is attached. To connect an interface cable, open this cover. 
 

Internal Components 

 

1. Second Bias Transfer Roller 
2. Fuser Assembly 
3. Drum Cartridge Release Lever 
4. Toner Cartridges 
5. Main Power Switch 
6. Transfer Belt Cleaner 
7. Waste Container 
8. Drum Cartridges 
9. Drum Cartridge Cover 
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Document Feeder 

  
1. Confirmation Indicator 
2. Top Cover 
3. Document Guides 
4. Document Feeder Tray 

5. Document Output Tray 
6. CVT Glass 
7. Document Glass 

 
 

Control Panel 

The control panel consists of the touch screen, USB port, and buttons you press to control the functions 
available on the printer. The control panel: 
• Displays the current operating status of the printer. 
• Provides access to copy, print, scan, and fax features. 
• Provides access to information pages. 
• Prompts you to load paper, replace supplies, and clear jams. 
• Displays errors and warnings. 
• Connects to a USB Flash drive for scan and print access. 
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Item Name Description 

1 Machine Status 
Button This button displays the status of the printer on the touch screen. 

2 Job Status Button This button displays lists of all active, secure, or completed jobs on the touch screen. 

3 Services Button This button returns to the active service from the Job Status or Machine Status screens, or 
to a preset service. 

4 USB Port The port provides USB Flash drive connection for storage use for the Scan to USB and 
Print from USB functions. 

5 Services Home 
Button 

This button provides access to printer features, such as copy, scan, and fax, on the touch 
screen. 

6 Touch Screen 
Display The screen displays information, and provides access to printer functions. 

7 Log In/Out Button This button provides access to password-protected features. 

8 Help Button This button displays information about the current selection on the touch screen. 

9 Language Button This button changes the touch screen language and keyboard settings. 

10 Energy Saver Button This button enters and exits the low-power mode. 

11 Interrupt Button This button pauses the current job to run a more urgent print, copy, or fax job. 

12 Clear All Button 
This button clears previous and changed settings for the current selection. To 
reset all features to their default settings and clear existing scans, press this 
button twice. 

13 Stop Button This button stops the current job temporarily. To cancel or resume your job, follow the 
onscreen instructions. 

14 Start Button This button starts the selected copy, scan, fax, or Print From job, such as Print from USB. 

15 Alphanumeric 
Keypad The keypad enters alphanumeric information. 

16 C (clear) Button This button deletes numeric values or the last digit entered using the alphanumeric keys.  

17 Dial Pause Button This button inserts a pause in a telephone number when it transmits a fax. 
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Business Ready Finisher with Optional Booklet Maker 

 
1. Horizontal Transport Unit 
2. Finisher Front Cover 
3. Right Top Tray 
4. Right Middle Tray 

5. Staple Cartridge 
6. Booklet Maker Tray 
7. Booklet Staple Unit 
8. Booklet Maker Unit 

 
 

Business Ready Finisher with Optional C/Z Folder 

 
 

1. Folder Front Cover 
2. Folder Bin Release Button 
3. Folder Bin 
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Wireless Network Adapter 

The wireless network adapter is a USB device that transfers data between the printer and a wireless local 
area network (LAN). The wireless network adapter supports common wireless security protocols, such as 
WEP, WPA, WPA2, and 802.1X standard port-based network access control. 

The wireless network adapter allows multiple users on a wireless LAN to print to and scan from Xerox® 
printers. The wireless network adapter also supports printers that include network scan and fax features. 
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Information Pages 

Your printer has a printable set of information pages stored on its internal hard drive. Information pages 
include configuration and font information, demonstration pages, and more. 
1. At the printer control panel, press the Machine Status button. 
2. On the Machine Information tab, touch Information Pages, then touch the desired information 

page. 
3. Touch Print. 
 

Note: Information pages can also be printed from CentreWare Internet Services. 
 
 

Printing the Configuration Report 
1. At the printer control panel, press the Machine Status button. 
2. On the Machine Information tab, touch Information Pages>Configuration Report>Print. 
3. Touch Close after the report prints. 
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Administration Features 

This section includes: 
• Accessing the Printer....................................................................................................................................................... 31 
• CentreWare Internet Services ..................................................................................................................................... 33 
• Finding the IP Address of the Printer ....................................................................................................................... 34 
• Automatic Data Collection ........................................................................................................................................... 34 
• Billing and Usage Information ................................................................................................................................... 34 

For details, see the System Administrator Guide at www.xerox.com/office/WC7970docs. 
 

Accessing the Printer 

The system administrator can set access rights on the printer to ensure that unauthorized users cannot 
access the printer. If the system administrator configures authentication and authorization, users require 
a login and password to access some or all of the features of the printer. The administrator can also 
configure accounting to require an accounting code to access tracked features. 
 

Authentication 

Authentication is the process of confirming your identity. When the system administrator enables 
authentication, the printer compares the information that you provide to another source of information, 
such as an LDAP directory. The information can be a user name and password, or the information stored 
on a magnetic or proximity ID card. If the information is valid, you are considered an authenticated user. 

The system administrator can set permissions so that authentication is required when accessing features 
at the control panel, in CentreWare Internet Services, or in the print driver. 

If the administrator configures local or network authentication, you identify yourself by typing your user 
name and password at the control panel or in CentreWare Internet Services. If the administrator 
configures card reader authentication, you identify yourself by swiping a magnetic or proximity card at 
the control panel and typing a passcode. 
 

Note: The system administrator can allow you to type your user name and password when Smart 
Card authentication is the primary authentication method. If the administrator configures an 
alternative authentication method, and you misplace your card, you can still access the printer. 
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Features 

 

Authorization 

Authorization is the function of specifying the features that you are allowed to access, and the process of 
approving or disapproving your access. The system administrator can configure the printer to allow you 
to access the printer, but restrict your access to certain features, tools, and services. For example, the 
printer can allow you access to copying but restrict your access to color printing. The system administrator 
can also control your access to features at specific times during the day. For example, the system 
administrator can restrict a group of users from printing during peak business hours. If you attempt to 
print using a restricted method or during a restricted time, the job does not print. Instead, the printer 
prints an error page and the job appears with an error message in the Job Status lists. 

Where the system administrator stores the authorization information determines the authorization type. 
• Local authorization stores the login information on the printer in the user Information Database. 
• Network authorization stores the login information in an external database, such as an LDAP 

directory. 

The system administrator sets authorization permissions. To set or edit user permissions for access to 
printer features, you must log in as the administrator. 
 

Accounting 

Accounting monitors the print, copy, scan, and fax impressions produced and who produces them. 

The system administrator must create user accounts and enable the accounting feature. When 
accounting is enabled, you must log in to the printer before accessing services. You must also provide your 
account details in the print driver before printing documents from a computer. The system administrator 
can set limits to restrict the total number of jobs by type that a user can produce. The administrator can 
also generate reports listing usage data for individual users and groups. 

For details, see the System Administrator Guide at www.xerox.com/office/WC7970docs. 
 

Logging In 

Logging in is the process by which you identify yourself to the printer for authentication. If 
authentication is set, to access printer features, you log in with your user credentials. 
 

Logging In at the Control Panel 
1. At the control panel, either press Log In/Out or touch Guest. 
2. If an administrator has configured more than one authentication server, select your domain, realm, 

or tree. 
a. Touch Domain, Realm, or Tree. 
b. From the list, touch your domain, realm, or tree. 
c. Touch Save. 

3. Type your user name, then touch Next. 
4. Type your password, then touch Done. 
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Logging In to CentreWare Internet Services 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 
 

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on 
page 34. 

 

2. At the top of the page, next to the lock and key icon, click Login. 
3. Type the User ID in the space provided. 
4. Type the password in the space provided. 
5. Click Login. 
 

Administrator Password 

The administrator password is required when accessing locked settings in CentreWare Internet Services or 
at the control panel. Most printer models have a default configuration that restricts access to some 
settings. Access is restricted for settings on the Properties tab in CentreWare Internet Services, and 
settings on the Tools tab on the control panel touch screen. 
 

Logging In as the System Administrator at the Control Panel 
1. At the control panel, press Log In/Out. 
2. Type admin, then touch Next. 
3. Type your password, then touch Done. 

Note: The system administrator user name is admin and the default password is 1111. 
 

CentreWare Internet Services 

CentreWare Internet Services is the administration and configuration software installed on the 
embedded Web server in the printer. It allows you to configure and administer the printer from a Web 
browser. 

CentreWare Internet Services requires: 
• A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux 

environments. 
• TCP/IP and HTTP enabled in the printer. 
• A network-connected computer with a Web browser that supports JavaScript. 

For details, see the Help in CentreWare Internet Services or the System Administrator Guide. 
 

Accessing CentreWare Internet Services 

At your computer, open a Web browser, in the address field, type the IP address of the printer, then press 
Enter or Return. 
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Finding the IP Address of the Printer 

You can view the IP address of your printer on the control panel or on the Configuration Report. On the 
Configuration Report, IP address information is located in the Connectivity Protocols section. 

To view the IP address of the printer on the control panel: 
1. At the printer control panel, press the Machine Status button. 
2. Touch the Machine Information tab. 

− If the system administrator has set the Display Network Settings to show the IP address, it 
appears in the center panel. 

− If the IP address is not displayed, print the Configuration Report or contact your system 
administrator. 

To print a Configuration Report: 
1. At the printer control panel, press the Machine Status button. 
2. On the Machine Information tab, touch Information Pages>Configuration Report>Print. 
3. Touch Close after the report prints. 
 

Automatic Data Collection 

This printer automatically collects data and transmits it to a secure offsite location. Xerox or a designated 
servicer uses this data to support and service the printer, or for billing, supplies replenishment, or product 
improvement. Automatically transmitted data can include product registration, meter read, supply level, 
printer configuration and settings, software version, and problem or fault code data. Xerox cannot read, 
view, or download the content of your documents residing on or passing through your printer or any of 
your information management systems. 

To turn off automatic data collection: 

On the Welcome page in CentreWare Internet Services, click the link in the note regarding automated 
services. 
 

Billing and Usage Information 

Billing and printer usage information appears on the Billing Information screen. The impression counts 
shown are used for billing. 
 

For details, see Billing and Usage Information on page 206. 
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More Information 

You can obtain more information about your printer from these sources: 
 

Resource Location 

Installation Guide Packaged with the printer. 

Other documentation for your printer www.xerox.com/office/WC7970docs 

Recommended Media List United States 
www.xerox.com/printer-supplies/recommended-paper/e
nus 
European Union www.xerox.com/europaper 

Technical support information for your printer; 
including online technical support, Online Support 
Assistant, and driver downloads. 

www.xerox.com/office/WC7970support 

Information about menus or error messages Press the control panel Help (?) button. 

Information Pages Print from the control panel, or from CentreWare 
Internet Services, click Status>Information Pages. 

CentreWare Internet Services documentation In CentreWare Internet Services, click Help. 

Order supplies for your printer www.xerox.com/office/WC7970supplies 

A resource for tools and information, including 
interactive tutorials, printing templates, helpful tips, 
and customized features to meet your individual 
needs. 

www.xerox.com/office/businessresourcecenter 

Local sales and support center www.xerox.com/office/worldcontacts 

Printer registration www.xerox.com/office/register 

Xerox® Direct online store www.direct.xerox.com/ 
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Features 

 

Welcome Center 

If you need assistance during or after printer installation, visit the Xerox® website for online solutions and 
support at www.xerox.com/office/worldcontacts. 

If you require further assistance, contact the Xerox® Welcome Center for the United States and Canada 
at 1-800-835-6100. 

If a local Xerox representative telephone number was provided during printer installation, record the 
telephone number in the following space. 

#_________________________________ 

If you need additional help using your printer: 
1. Refer to this user guide. 
2. Contact the system administrator. 
3. Visit the Xerox® website at www.xerox.com/office/WC7970support. 

To assist you, the Welcome Center needs the following information: 
• The nature of the problem. 
• The serial number of the printer. 
• The fault code. 
• The name and location of your company. 
 

Locating the Serial Number 

To contact Xerox for assistance, you need the printer serial number. The serial number is behind door A, 
toward the rear of the printer on a metal plate. 

To view the serial number at the printer control panel, press the Machine Status button, then touch the 
Machine Information tab. 
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This chapter includes: 
• Installation and Setup Overview ................................................................................................................................ 38 
• Modifying General Settings ......................................................................................................................................... 42 
• Installing the Software .................................................................................................................................................. 44 
 

See also: 
Installation Guide packaged with your printer. 
System Administrator Guide at www.xerox.com/office/WC7970docs. 
 
 

3 Installation and Setup 
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Installation and Setup 

 

Installation and Setup Overview 

Before printing, your computer and the printer must be plugged in, turned on, and connected. Configure 
the initial settings of the printer, then install the driver software and utilities on your computer. 

You can connect to your printer directly from your computer using USB, or connect over a network using 
an Ethernet cable or wireless connection. Hardware and cabling requirements vary for the different 
connection methods. Routers, network hubs, network switches, modems, Ethernet cables, and USB cables 
are not included with your printer and must be purchased separately. Xerox recommends an Ethernet 
connection because it is typically faster than a USB connection, and it provides access to CentreWare 
Internet Services. It also provides access to email, workflow scanning, and server fax services. 

For details on configuring the printer settings, see the System Administrator Guide at 
www.xerox.com/office/WC7970docs. 
 

Initial Printer Setup 

Make sure that the printer is set up before installing the printer software. Setup includes enabling the 
optional features and assigning an IP address for the Ethernet network connection. If the printer has not 
been previously turned on and configured, see the System Administrator Guide at 
www.xerox.com/office/WC7970docs. 
 

Physically Connecting the Printer to the Network 

Use a Category 5 or better Ethernet cable to connect the printer to the network. An Ethernet network is 
used for one or more computers and supports many printers and systems simultaneously. An Ethernet 
connection provides direct access to printer settings using CentreWare Internet Services. 

To connect the printer: 
1. Connect the power cord to the printer, and plug the cord into an electrical outlet. 
2. Connect one end of a Category 5 or better Ethernet cable to the Ethernet port on the printer. 

Connect the other end of the Ethernet cable to a correctly configured network port on a hub or 
router. 

3. Turn on the printer. 
 

Note: For details on configuring wireless network settings, see the System Administrator Guide at 
www.xerox.com/office/WC7970docs. 
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Installation and Setup 

 

Connecting to a Telephone Line 
1. Ensure that the printer is turned off. 
2. Connect a standard RJ11 cable, No. 26 American Wire Gauge (AWG) or larger, to the Line port on the 

back of the printer. 
3. Connect the other end of the RJ11 cable to an operating telephone line. 
4. Enable and configure the Fax functions. 

For details, see Selecting Fax Options on page 154, Selecting Server Fax Options on page 163, or 
Selecting Internet Fax Options on page 168. 
 

Turning the Printer On and Off 

This printer has two power switches. The main power switch located behind the front door controls the 
main power to the printer. The secondary power switch on the top of the printer controls power to the 
printer electronic components, and initiates a software-controlled shutdown when turned off. Using the 
secondary power switch to turn on and off the printer is the preferred method. To operate the printer, 
turn on both switches. First turn on the main power switch, then turn on the secondary power switch. 
 

 CAUTION: Do not plug or unplug the power cord while the power switch is in the On position. 
 

To turn on the printer: 
1. Open the front door. 

 
2. Turn on the main power switch. 
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3. Close the front door. 

 
4. Turn on the secondary power switch. 

Note: When the optional Business Ready finisher is installed, the secondary power switch is behind a 
clear plastic door. 

 

  

Secondary Power Switch Secondary Power Switch with BR Finisher 

To connect a cable: 
1. Ensure that there are no jobs in the queue. 
2. Turn off the secondary power switch, then wait 10 seconds after the touch screen goes dark before 

you proceed. 

Note: When the optional Business Ready finisher is installed, the secondary power switch is behind a 
clear plastic door. 

3. Open the front door. 
4. Turn off the main power switch. 
5. Close the front door. 

To turn off the printer: 
1. Ensure that there are no jobs in the queue. 
2. Turn off the secondary power switch, then wait 10 seconds after the touch screen goes dark before 

you proceed. 

Note: When the optional Business Ready finisher is installed, the secondary power switch is behind a 
clear plastic door. 

3. Open the front door. 
4. Turn off the main power switch. 
5. Close the front door. 
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Preventing Printer Malfunction 

To prevent printer malfunction or damage to the internal hard drive: 
1. Ensure that there are no jobs in the queue. 
2. Turn off the secondary power switch, then wait 10 seconds after the touch screen goes dark before 

you proceed. 

Note: When the optional Business Ready finisher is installed, the secondary power switch is behind a 
clear plastic door. 

3. Open the front door. 
4. Turn off the main power switch. 
5. Close the front door. 
 

USB Cover 

To prevent users from accessing the USB port on the front of the printer, install the USB cover. While the 
cover prevents physical access to the USB port, the port is still active. For details on enabling or disabling 
USB ports, see the System Administrator Guide at www.xerox.com/office/WC7970docs. 

If your printer model has a cover for the USB port on the control panel, you can install or remove the 
cover. You can find the installation instructions and the necessary part in the compartment inside of Tray 
1. 

 
 

Optimizing Printer Performance 

Several factors influence printer performance, including temperature, humidity, air pressure, and the 
chemical characteristics of the paper and coatings. The printer must form an electrostatic image on the 
paper, which depends on the ability of the air to hold and transfer electrical charges. The paper and 
coatings must hold an electrical charge in the areas where the toner must adhere. 

To optimize the performance of your printer: 
1. At the printer control panel, press the Machine Status button, then touch the Tools tab. 
2. Touch Troubleshooting>Calibration>Print Calibration>Next. 
3. Follow the onscreen instructions to run the Print Calibration procedure. 
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Modifying General Settings 

You can modify printer settings such as the language, date and time, units of measurement, display 
brightness, and startup page from the control panel. 
1. At the printer control panel, press the Machine Status button, then touch the Tools tab. 
2. Touch Device Settings>General, then touch the setting you want to change: 

− Energy Saver specifies when the printer goes into energy-saving mode. 
− Date and Time allows you to set the time zone, date, time, and display format. 
− Language/Keyboard Selection allows you to set the language and keyboard layout. 
− Custom Keyboard Button allows you to assign text to the custom key on the virtual keyboard. 

Note: This is a partial list. If a feature does not appear, contact the system administrator or log in as 
a system administrator. For details, see Logging In as the System Administrator at the Control Panel 
on page 33. 

3. Touch Save. 
 

Setting Energy Saver Mode 

You can set the time the printer spends idle in ready mode before the printer transitions to a lower power 
level. 

To configure Energy Saver settings: 
1. At the printer control panel, press the Machine Status button, then touch the Tools tab. 
2. Touch Device Settings>General>Energy Saver. 

Note: If this feature does not appear, log in as a system administrator. For details, see Logging In as 
the System Administrator at the Control Panel on page 33. 

3. Under From Standby Mode to Energy Saver Mode, to set the time in minutes, touch the arrow 
buttons. Standby Mode uses more energy, but wakes faster than Energy Saver Mode. 

4. Under From Energy Saver Mode to Sleep Mode, to set the time in minutes, touch the arrow buttons. 
Energy Saver Mode uses more energy, but wakes faster than Sleep Mode. 

5. Touch Save. 
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Setting the Date and Time at the Control Panel 
1. At the printer control panel, press the Machine Status button, then touch the Tools tab. 
2. Touch Device Settings>General>Date and Time. 

Note: If this feature does not appear, log in as a system administrator. For details, see Logging In as 
the System Administrator at the Control Panel on page 33. 

3. To set the time zone, touch Time Zone, then touch the arrows to adjust the time zone. 
4. To set the date, touch Date, select a format, then set the date. 
5. To use 24 hour format, select Display 24 hour clock. To set the time, touch Time, then set the time. 

Note: The date and time are set automatically through Network Time Protocol (NTP). To modify 
these settings, go to the Properties tab in CentreWare Internet Services and change the Date and 
Time Setup to Manual (NTP Disabled). 

6. Touch Save. 
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Installing the Software 

This section includes: 
• Operating System Requirements ............................................................................................................................... 44 
• Installing Drivers and Utilities for Windows .......................................................................................................... 44 
• Installing Print Drivers and Utilities for Macintosh OS X Versions 10.7 and Later .................................. 45 
• Installing Print Drivers and Utilities for UNIX and Linux Printing ................................................................. 46 
• Other Drivers ...................................................................................................................................................................... 48 

Before installing driver software, verify that the printer is plugged in, turned on, connected correctly, and 
has a valid IP address. The IP address usually appears in the upper right corner of the control panel. If you 
cannot find the IP address, see Finding the IP Address of Your Printer on page 34. 

If the Software and Documentation disc is not available, download the latest drivers from 
www.xerox.com/office/WC7970drivers. 
 

Operating System Requirements 
• Windows XP SP3 and later; Windows Server 2003 and later 
• Macintosh OS X version 10.7 and later. 
• Novell Netware 6.0 and later 
• UNIX and Linux: Your printer supports connection to various UNIX platforms through the network 

interface. 
 

Installing Drivers and Utilities for Windows 

To access all the features of your printer, install the Xerox® print driver and the Xerox® scan driver. 

To install the print and scan driver software: 
1. Insert the Software and Documentation disc into the appropriate drive on your computer. The 

installer starts automatically. 
If the installer does not start automatically, navigate to the drive, and double-click the Setup.exe 
installer file. 

2. To change the language, click Language. 
3. Select your language, then click OK. 
4. Click Install Drivers>Install Print and Scan Drivers. 
5. To accept the license agreement, click I Agree. 
6. From the list of discovered printers, select your printer, then click Next. 
7. If your printer does not appear in the list of discovered printers, click Extended Search. 
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8. If your printer still does not appear in the list of discovered printers, and you know the IP address: 
a. Click the Network Printer icon at the top of the window. 
b. Enter the IP address or the DNS name of the printer. 
c. Click Search. 
d. From the list of discovered printers, select your printer, then click Next. 

9. If the printer still does not appear in the list of discovered printers, and you do not know the IP 
address: 
a. Click Advanced Search. 
b. If you know the gateway address and subnet mask, click the top button and enter the addresses 

into the Gateway and Subnet Mask fields. 
c. If you know the address of another printer on the same subnet, click the middle button and 

enter the address in the IP Address field. 
d. Click Search. 
e. From the list of discovered printers, select your printer, then click Next. 

 

Note: When the printer appears in the Discovered Printers window, it displays the IP address. Record 
the IP address for future use. 

 

10. Select the desired driver. 
11. Click Install. 

If the installer prompts you for the IP address, enter the IP address of the printer. 
If the installer prompts you to restart your computer, click Restart to complete the installation of the 
drivers. 

12. To complete the installation, click Finish. 
 

Installing Print Drivers and Utilities for Macintosh OS X Versions 10.7 and 
Later 

To access all the features of your printer, install the Xerox® print driver and the Xerox® scan driver. 

To install the print and scan driver software: 
1. Insert the Software and Documentation disc into the appropriate drive on your computer. 
2. Open Xerox® Print Drivers 3.xx.x.dmg/.pkg as needed for your printer. 
3. To run Xerox® Print Drivers 3.xx.x.dmg/.pkg, double-click the appropriate file name. 
4. When prompted, click Continue. 
5. To accept the license agreement, click I Agree. 
6. To accept the current installation location, click Install, or select another location for the installation 

files, then click Install. 
7. Enter your password, then click OK. 
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8. From the list of discovered printers, select your printer, then click Next. 
If your printer does not appear in the list of discovered printers: 
a. Click the Network Printer Icon. 
b. Type the IP address of your printer, then click Continue. 
c. Select your printer in the list of discovered printers, then click Continue. 

9. To accept the print queue message, click OK. 
10. Select or clear the Set Printer as Default and Print a Test Page check boxes. 
11. Click Continue, then click Close. 

Note: The printer is added automatically to the printer queue in Macintosh OS X versions 10.7 and 
later. 

To verify the installation of printer options with the print driver: 
1. From the Apple menu, click Printer Preferences>Print & Scan. 
2. Select the printer in the list, then click Options and Supplies. 
3. Click Driver, then confirm that your printer is selected. 
4. Confirm that all of the options installed on the printer appear correct. 
5. If you change settings, click OK, close the window, then exit System Preferences. 
 

Installing Print Drivers and Utilities for UNIX and Linux Printing 

For details about UNIX and Linux drivers, see the System Administrator Guide at 
www.xerox.com/office/WC7970docs. 
 

Xerox® Print Driver Package 

The Xerox® Print Driver package provides tools for you to manage printers connected in UNIX and Linux 
environments. 
 

Xerox® Print Drivers 

You can use a Xerox® print driver to select printer features. All operating systems include the Office 
Standard print driver, which can print to a wide range of Xerox devices that share common features. You 
can use a Linux-based print driver to print to a specific model. 
 

Xerox® Printer Manager 

Xerox® Printer Manager allows you to: 
• Configure local and network-connected printers. 
• Set up a printer on your network as well as monitor the operation of the printer once installed. 
• Provide a common look and feel across the many different suppliers of UNIX and Linux operating 

systems. 
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Installing Xerox® Print Driver Package 

Before you begin: 

Ensure that you have root or superuser privileges to install Xerox® Printer Manager. 

Note: When installing drivers for a network printer, if you do not see your printer in the list, click the 
IP Address or DNS Name button. In the IP Address or DNS Name field, type the IP address of your 
printer, then click Search to locate your printer. If you do not know the IP address of the printer, see 
Finding the IP Address of Your Printer on page 34. 

1. Download the appropriate package for your operating system. 
The available files are: 
− XeroxOSDPkg-AIXpowerpc-x.xx.xxx.xxxx.rpm for the IBM PowerPC family. 
− XeroxOSDPkg-HPUXia64-x.xx.xxx.xxxx.depot.gz to support HP Itanium workstations. 
− XeroxOSDPkg-SunOSi386-x.xx.xxx.xxxx.pkg.gz for Sun Solaris x86 systems. 
− XeroxOSDPkg-SunOSsparc-x.xx.xxx.xxxx.pkg.gz for Sun Solaris SPARC systems. 
− Xeroxv5Pkg-Linuxi686-x.xx.xxx.xxxx.rpm to support RPM-based 32-bit Linux environments. 
− Xeroxv5Pkg-Linuxi686-x.xx.xxx.xxxx.deb to support Debian-based 32-bit Linux environments. 
− Xeroxv5Pkg-Linuxx86_64-x.xx.xxx.xxxx.rpm to support RPM-based 64-bit Linux environments. 
− Xeroxv5Pkg-Linuxx86_64-x.xx.xxx.xxxx.deb to support Debian-based 64-bit Linux environments. 

2. To install the Xerox® Print Driver package, open the package with your OS package manager or use 
the appropriate command-line utility for your OS. 
− AIX: rpm -U XeroxOSDPkg-AIXpowerpc-x.xx.xxx.xxxx.rpm 
− HPUX: swinstall -s XeroxOSDPkg-HPUXia64-x.xx.xxx.xxxx.depot.gz \* 
− Solaris (x86 based): pkgadd -d XeroxOSDPkg-SunOSi386-x.xx.xxx.xxxx.pkg 
− Solaris (SPARC based): pkgadd -d XeroxOSDPkg-SunOSsparc-x.xx.xxx.xxxx.pkg 
− Linux (RPM based 32-bit): rpm -U Xeroxv5Pkg-Linuxi686-x.xx.xxx.xxxx.rpm 
− Linux (Debian based 32-bit): dpkg -i Xeroxv5Pkg-Linuxi686-x.xx.xxx.xxxx.deb 
− Linux (RPM based 64-bit): rpm -U Xeroxv5Pkg-Linuxx86_64-x.xx.xxx.xxxx.rpm 
− Linux (Debian based 64-bit): dpkg -i Xeroxv5Pkg-Linuxx86_64-x.xx.xxx.xxxx.deb 
The package installs files into /opt/Xerox/prtsys. 

 

Launching Xerox® Printer Manager 

To launch Xerox® Printer Manager from a terminal window prompt as root, type xeroxprtmgr, then press 
Enter or Return. 
 

 Xerox® WorkCentre® 7970 Multifunction Printer 47 
 User Guide 
 



Installation and Setup 

 

Other Drivers 

The following drivers are available for download at www.xerox.com/office/WC7970drivers. 
• The Xerox® Global Print Driver works with any printer on your network, including those printers made 

by other manufacturers. It configures itself for your individual printer upon installation. 
• The Xerox® Mobile Express Driver works with any printer available to your computer that supports 

standard PostScript. It configures itself for the printer you select every time you print. If you travel 
frequently to the same sites, you can save your favorite printers in that location and the driver saves 
your settings. 
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Supported Paper 

This section includes: 
• Recommended Media .................................................................................................................................................... 50 
• Ordering Paper .................................................................................................................................................................. 50 
• General Paper Loading Guidelines ............................................................................................................................ 50 
• Paper That Can Damage Your Printer ...................................................................................................................... 51 
• Paper Storage Guidelines .............................................................................................................................................. 51 
• Supported Paper Types and Weights ....................................................................................................................... 52 
• Supported Standard Paper Sizes ................................................................................................................................ 52 
• Supported Paper Sizes and Weights for Automatic 2-Sided Printing........................................................... 53 
• Supported Paper Sizes for the Envelope Tray ....................................................................................................... 54 
• Supported Custom Paper Sizes ................................................................................................................................... 54 

Your printer is designed to use various paper and other media types. To ensure the best print quality and 
to avoid jams, follow the guidelines in this section. 

For best results, use Xerox paper and media recommended for your printer. 
 

Recommended Media 

A list of paper and media recommended for your printer is available at: 
• www.xerox.com/paperRecommended Media List (United States) 
• www.xerox.com/europaperRecommended Media List (Europe) 
 

Ordering Paper 

To order paper, transparencies, or other media, contact your local reseller or go to 
www.xerox.com/office/WC7970supplies. 
 
 

General Paper Loading Guidelines 
• Do not overfill the paper trays. Do not load paper above the maximum fill line in the tray. 
• Adjust the paper guides to fit the paper size. 
• Fan paper before loading it in the paper tray. 
• If excessive jams occur, use paper or other approved media from a new package. 
• Use only recommended Xerox® transparencies. Print quality could vary with other transparencies. 
• Do not print on label media once a label has been removed from a sheet. 
• Use only paper envelopes. Print envelopes 1-sided only. 
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Paper That Can Damage Your Printer 

Some paper and other media types can cause poor output quality, increased paper jams, or damage your 
printer. Do not use the following: 
• Rough or porous paper 
• Inkjet paper 
• Non-laser glossy or coated paper 
• Paper that has been photocopied 
• Paper that has been folded or wrinkled 
• Paper with cutouts or perforations 
• Stapled paper 
• Envelopes with windows, metal clasps, side seams, or adhesives with release strips 
• Padded envelopes 
• Plastic media 
• Iron on transfer paper 
 

 CAUTION: The Xerox® Warranty, Service Agreement, or Xerox® Total Satisfaction Guarantee does 
not cover damage caused by using unsupported paper or special media. The Xerox® Total Satisfaction 
Guarantee is available in the United States and Canada. Coverage could vary outside these areas. 
Contact your Xerox representative for details. 

 
 

Paper Storage Guidelines 

Storing your paper and other media properly contributes to optimum print quality. 
• Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from 

ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly 
damaging to paper. 

• Reduce the exposure of paper to strong lights for long periods of time. 
• Maintain constant temperatures and relative humidity. 
• Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to collect 

moisture. 
• Store paper flat, either on pallets, cartons, shelves, or in cabinets. 
• Avoid food or drinks in the area where paper is stored or handled. 
• Do not open sealed packages of paper until you are ready to load them into the printer. Leave stored 

paper in the original packaging. The paper wrapper protects the paper from moisture loss or gain. 
• Some special media is packaged inside resealable plastic bags. Store the media inside the bag until 

you are ready to use it. Keep unused media in the bag and reseal it for protection. 
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Supported Paper Types and Weights 
 

Trays Types and Weights 

Trays 1–5 Plain, Bond, Hole Punched, Letterhead, Pre-Printed, Recycled, Plain 
Reloaded, and Custom (60–105 g/m²) 
Lightweight Cardstock, and Lightweight Cardstock Reloaded (106–169 
g/m²) 
Cardstock, and Cardstock Reloaded (170–256 g/m²) 
Lightweight Glossy Cardstock, and Lightweight Glossy Card Reloaded 
(106–169 g/m²) 
Glossy Cardstock, and Glossy Cardstock Reloaded (170–256 g/m²) 
Labels (106–169 g/m²) 
Transparency 
Envelope (75–90 g/m²) (Tray 1, only with Envelope Tray installed in the 
slot) 

Tray 5 Lightweight (55–59 g/m²) 
Heavyweight Cardstock, and Heavyweight Cardstock Reloaded (257–
280 g/m²) 
Heavyweight Glossy Cardstock, and Heavyweight Glossy Card Reloaded 
(257–280 g/m²) 
Envelope (75–90 g/m²) 

 
 

Supported Standard Paper Sizes 
 

Tray Number European Standard Sizes North American Standard Sizes 

Printer Tray 1 A5 (148 x 210 mm) 
A4 (210 x 297 mm) 
A3 (297 x 420 mm) 
B5 (176 x 250 mm) 
B4 (250 x 353 mm) 
JIS B5 (182 x 257 mm) 
JIS B4 (257 x 364 mm) 

Statement (5.5 x 8.5 in.) 
Executive (7.25 x 10.5 in.) 
Letter (8.5 x 11 in.) 
US Folio (8.5 x 13 in.) 
Legal (8.5 x 14 in.) 
Tabloid (11 x 17 in.) 

Trays 2–4 of the 3-Tray 
Module 
 

Tray 2 of the High-Capacity 
Tandem Tray Module 
 

Tray 2 of the 1-Tray Module 

A5 (148 x 210 mm) 
A4 (210 x 297 mm) 
A3 (297 x 420 mm) 
B5 (176 x 250 mm) 
B4 (250 x 353 mm) 
JIS B5 (182 x 257 mm) 
JIS B4 (257 x 364 mm) 
SRA3 (320 x 450 mm) 

Statement (5.5 x 8.5 in.) 
Executive (7.25 x 10.5 in.) 
Letter (8.5 x 11 in.) 
8.5 x 13 in. 
Legal (8.5 x 14 in.) 
Tabloid (11 x 17 in.) 
12 x 18 in. 
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Tray Number European Standard Sizes North American Standard Sizes 

Trays 3 and 4 of the 
High-Capacity Tandem Tray 
Module 
 

Tray 6 of the High-Capacity 
Feeder 

A4 (210 x 297 mm) 
JIS B5 (182 x 257 mm) 

Executive (7.25 x 10.5 in.) 
Letter (8.5 x 11 in.) 

 

Tray 5 only Postcard (100 x 148 mm) 
Postcard (148 x 200 mm) 
A6 (105 x 148 mm) 
A5 (148 x 210 mm) 
A4 (210 x 297 mm) 
A4 Oversized (223 x 297 mm) 
A3 (297 x 420 mm) 
B6 (125 x 176 mm) 
B5 (176 x 250 mm) 
B4 (250 x 353 mm) 
JIS B6 (128 x 182 mm) 
JIS B5 (182 x 257 mm) 
215 x 315 mm 
JIS B4 (257 x 364 mm) 
SRA3 (320 x 450 mm) 
DL envelope (110 x 220 mm) 
C4 envelope (229 x 324 mm) 
C5 envelope (162 x 229 mm) 

Postcard (3.5 x 5 in.) 
Postcard (4 x 6 in.) 
5 x 7 in. 
Postcard (6 x 9 in.) 
Statement (5.5 x 8.5 in.) 
8 x 10 in. 
Executive (7.25 x 10.5 in.) 
Letter (8.5 x 11 in.) 
9 x 11 in. 
8.5 x 13 in. 
Legal (8.5 x 14 in.) 
Tabloid (11 x 17 in.) 
12 x 18 in. 
12 x 19 in. 
Envelope (6 x 9 in.) 
Envelope (9 x 12 in.) 
Monarch Envelope (3.9 x 7.5 in.) 
No. 10 Envelope (4.1 x 9.5 in.) 

 

 
 

Supported Paper Sizes and Weights for Automatic 2-Sided Printing 
 

Standard European Sizes Standard North American Sizes 

Postcard (148 x 200 mm) 
A5 (148 x 210 mm) 
A4 (210 x 297 mm) 
A4 Oversized (223 x 297 mm) 
A3 (297 x 420 mm) 
JIS B6 (128 x 182 mm) 
JIS B5 (182 x 257 mm) 
215 x 315 mm 
JIS B4 (257 x 364 mm) 
SRA3 (320 x 450 mm) 

Postcard (6 x 9 in.) 
Statement (5.5 x 8.5 in.) 
8 x 10 in. 
Executive (7.25 x 10.5 in.) 
Letter 
9 x 11 in. 
US Folio (8.5 x 13 in.) 
Legal (8.5 x 14 in.) 
Tabloid (11 x 17 in.) 
Tabloid Extra (12 x 18 in.) 
12 x 19 in. 
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In addition to standard paper sizes and weights, you can use custom paper sizes and weights for 
automatic 2-sided printing. 
 

 CAUTIONS: 

• Do not use transparencies, envelopes, labels, or reloaded paper for automatic 2-sided printing. 
• Do not use media that does not meet the minimum size and weight requirements for automatic 

2-sided printing. 
• Do not use media that exceeds the maximum size and weight requirements for automatic 

2-sided printing. 
 

You can use the following custom paper sizes for automatic 2-sided printing. 
• Minimum print size 128 x 140 mm (5 x 5.5 in.) 
• Maximum print size 320 x 483 mm (12 x 19 in.) 

You can use the following custom paper weights for automatic 2-sided printing. 
• Minimum weight 60 g/m² 
• Maximum weight 256 g/m² 
 

Supported Paper Sizes for the Envelope Tray 
 

Standard Sizes Custom Sizes 

C5 (162 x 229 mm, 6.4 x 9.0 in.) 
DL (110 x 220 mm, 4.33 x 8.66 in.) 
Monarch (88 x 191 mm, 3.9 x 7.5 in.) 
Number 10 Commercial (105 x 241 mm, 4.125 x 9.5 in.) 

Minimum: 148 x 98 mm (5.8 x 3.9 in.) 
Maximum: 241 x 162 mm (9.5 x 6.4 in.) 

 
 

Supported Custom Paper Sizes 
 

Tray Number Paper Sizes 

Printer Tray 1 Minimum: 140 x 182 mm (5.5 x 7.2 in.) 
Maximum: 297 x 432 mm (11.7 x 17 in.) 

Trays 2–4 of the 3-Tray Module 
 

Tray 2 of the High-Capacity Tandem Tray Module 
 

Tray 2 of the 1-Tray Module 

Minimum: 140 x 182 mm (5.5 x 7.2 in.) 
Maximum: 320 x 457 mm (12.6 x 18 in.) 

 

Tray 5 Minimum: 89 x 98 mm (3.5 x 3.9 in.) 
Maximum: 320 x 483 mm (12.6 x 19 in.) 

Envelope Tray Width: 148–241 mm (5.8–9.5 in.) 
Length: 98–162 mm (3.9–6.4 in.) 
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Loading Paper 

This section includes: 
• Loading Paper in Trays 1–4 .......................................................................................................................................... 55 
• Setting the Guide Locks in the 500-Sheet Adjustable Trays ............................................................................ 58 
• Changing Paper Size, Type, and Color ..................................................................................................................... 59 
• Loading Paper in Trays 3 and 4 of the Tandem Tray Module ........................................................................ 59 
• Loading Paper in Tray 5 (Bypass Tray) .................................................................................................................... 61 
• Loading Paper in Tray 6 (High-Capacity Feeder) ................................................................................................. 62 
• Configuring Tray 6 in the High-Capacity Feeder ................................................................................................. 63 
 

Loading Paper in Trays 1–4 
1. Pull out the tray until it stops. 

 
2. Ensure that the guide locks are set in the correct position for the standard or custom size paper you 

are loading. For details, see Setting the Guide Locks in the 500-Sheet Adjustable Trays on page 58. 
3. Remove any paper that is a different size or type. 
4. Move the length and width guides out: 

a. Pinch the guide lever on each guide. 
b. Slide the guides outward until they stop. 
c. Release the levers. 
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5. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. 
This procedure separates any sheets that are stuck together and reduces the possibility of jams. 

 
Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to 
use it. 

6. Load the paper in the tray. Do one of the following: 
− For long-edge feed, insert letterhead and pre-printed paper face down with the top edge toward 

the front. Load hole punched paper with the holes to the left. 
− Load labels face up with the top edge toward the front of the tray. 

 
− For short-edge feed, insert letterhead and pre-printed paper face down with the top edge to the 

left. Load hole punched paper with the holes toward the back. 
− Load labels face up with the top edge to the right. 

 
Note: Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to 
jam. 
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7. Adjust the length and width guides to fit the paper. 

 
8. Close the tray. 

 
9. Do one of the following: 

− To confirm the paper size, type, and color when a tray is set to Fully Adjustable, touch Confirm. 
− To select a new paper size, touch Size. To select a new paper type, touch Type. To select a new 

paper color, touch Color. When finished, touch Confirm. 
− To change the paper size, type, or color when the tray is set to Dedicated mode, press the 

Machine Status button. Then touch Tools>Device Settings>Paper Management>Tray 
Contents. Select the tray, touch Change Size or Change Description. Touch Save when you 
finish. 

Notes: 

• To change the size, type, and color of paper when the control panel is locked, log in as the 
system administrator. 

• For details, see Changing Paper Size, Type, and Color on page 59. 
• If this feature does not appear, log in as a system administrator. For details, see Logging In as 

the System Administrator at the Control Panel on page 33. 
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Setting the Guide Locks in the 500-Sheet Adjustable Trays 

You can adjust the guides in trays 1–4 to accommodate standard or custom paper sizes. In the standard 
position, the guides move into the supported standard paper settings. In the custom position, the guides 
move in 1 mm increments. 

To move the guide locks from the standard to the custom paper size position: 
1. Pull out the tray until it stops. 

 
Note: For best results, remove any paper from the tray, pinch the guide levers, and slide the guides 
inward. 

2. Pry up the retainer with your fingertip, pulling the lower edge toward you. 

 
3. To engage the fine-adjustment block, pinch the levers and slide the guide lock to the left as shown. 
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4. Replace the retainer and snap it into place. 

 
5. Load the custom-size paper in the tray. The tray guides move in increments of 1 mm. 
 

Changing Paper Size, Type, and Color 

When trays 1–4 are set to Adjustable mode, open the selected tray and load the desired paper. When you 
close the tray, the control panel prompts you to set the paper size, type, and color. 

When tray 5 is set to Adjustable mode, you can change paper settings each time you load the tray. When 
you load paper into an empty tray, the control panel prompts you to set the paper size, type, and color. 

When a paper tray is set to Dedicated mode, the control panel prompts you to load a specific paper size, 
color, and type. If you move the guides to load a different paper size in trays 1–4, the control panel 
displays an error message. Once you load the different paper, change the size, type, and color of paper at 
the control panel to clear the error message. 

To set the paper size, type, or color for a dedicated tray: 
1. At the printer control panel, press the Machine Status button. 
2. Touch the Tools tab, then touch Device Settings>Paper Management. 
3. Touch Tray Contents, then select a dedicated tray. 
4. Select Change Size or Change Description. 
5. Scroll through the list as needed, and touch the desired paper setting. 
6. Touch Save. 

Note: To access the Paper Management menu, you can be required to log in as the system 
administrator. For details, see the System Administrator Guide at 
www.xerox.com/office/WC7970docs. 
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Loading Paper in Trays 3 and 4 of the Tandem Tray Module 

The tandem tray module holds larger amounts of paper for fewer printing interruptions. It contains three 
trays. Tray 2 holds paper sizes up to SRA3/12 x 18 in. Trays 3 and 4 hold A4/letter size paper only. 
 

Note: Do not load custom size paper into tray 3 or tray 4 of the tandem tray module. 
 

To load tray 2, see Loading Paper in Trays 1-4 on page 55. 
1. Pull tray 3 or tray 4 out until it stops. 
2. Fan the edges of the paper before loading it into the paper trays. This procedure separates any 

sheets of paper that are stuck together and reduces the possibility of paper jams. 
 

Note: To avoid paper jams and misfeeds, do not remove paper from its packaging until necessary. 

 
 

3. Stack the paper against the left rear corner of the tray as shown. 

 
4. Adjust the guides so that they touch the edges of the stack. 
5. Close the tray. 
6. Verify the size, type, and color of the paper. Change the selection for any incorrect setting. 
7. On the printer touch screen, touch Confirm. 
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Loading Paper in Tray 5 (Bypass Tray) 

The bypass tray supports the widest variety of media types. It is primarily intended for small quantity jobs 
using special media. The tray extension provides support for larger paper. 
 

Notes: 

• For faster print speeds, load paper 320 mm (12.6 in.) or shorter with the long edge going into the 
printer (LEF). 

• Load paper longer than 320 mm (12.6 in.) with the short edge going into the printer (SEF). 
• Load hole punched paper with the holes on the trailing edge (left). 
• Do not load paper above the maximum fill line. 

 

1. Open the bypass tray by rotating it outward. 

 
2. Insert the paper either long edge or short edge first. 

 
3. Center the paper, then slide the guides until they are just touching the edges of the stack. 
4. Verify the size, type, and color of the paper. Change the selection for any incorrect setting. 
5. On the printer touch screen, touch Confirm. 
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Loading Paper in Tray 6 (High-Capacity Feeder) 
1. Pull Tray 6 out of the feeder until it stops. 
2. Open the side gate until it stops. 
3. Fan the edges of the paper before loading it into the paper trays. This procedure separates any 

sheets of paper that are stuck together and reduces the possibility of paper jams. 
 

Note: To avoid paper jams and misfeeds, do not remove paper from its packaging until necessary. 

 
 

4. Load the paper against the right side of the tray. 
For 1-sided printing: 
− Place the print side face down. 
− Place pre-punched paper with the holes toward the left side of the tray. 
− Place letterhead or the top of the page toward the front of the tray. 

 
 

Note: Do not load paper above the maximum fill line. Overfilling can cause paper jams. 
 

For 2-sided printing: 
− Place the print side (page 1) face up. 
− Place pre-punched paper with the holes toward the right side of the tray. 
− Place letterhead or the top of the page toward the front of the tray. 
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5. Slide the guides so they touch the edges of the paper. 
6. Close the tray. 
7. Verify the size, type, and color of the paper. Change the selection for any incorrect setting. 
8. On the printer touch screen, touch Confirm. 

 
 
 

Configuring Tray 6 in the High-Capacity Feeder 

Tray 6 is a dedicated high-capacity feeder. It must be configured to support the paper in use. If the tray 
has never been used, it must be configured for the desired paper size. If you are changing the paper size, 
you must reconfigure the tray for the new paper size. For details on supported paper sizes, see Supported 
Paper on page 50. 

Before changing the drawer configuration, always compare the paper size to the Tray 6 configuration. If 
the paper size matches, no adjustment is needed. 
1. Remove the screw that holds the spacer plate at the back of the tray. 
2. Lift the spacer plate to remove it. 
3. Place the tabs at the bottom of the plate into the slots in the bottom of the drawer that correspond 

with the paper size. 
4. Slide the top of the spacer plate to engage the peg on the back of the tray into the matching hole in 

the plate. 
5. Install the screw to secure the spacer plate. 
6. Repeat steps 1–5 for the spacer plate at the front of Tray 6. 
7. Locate the pin at the top of the side gate. 
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8. Lift the pin and guide it to the desired paper size in the slot on top of the side gate. 
9. Release the pin to lock it into place. 
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Printing on Special Paper 

This section includes: 
• Envelopes ............................................................................................................................................................................ 65 
• Labels .................................................................................................................................................................................... 68 
• Glossy Cardstock .............................................................................................................................................................. 72 
• Transparencies .................................................................................................................................................................. 73 

To order paper, transparencies, or other media, contact your local reseller or go to 
www.xerox.com/office/WC7970supplies. 
 

See also: 
www.xerox.com/paperRecommended Media List (United States) 
www.xerox.com/europaperRecommended Media List (Europe) 
 
 

Envelopes 

Envelopes can be printed only from tray 5, or from tray 1 if the optional envelope tray is installed. 
 

Guidelines for Printing Envelopes 
• Print quality depends on the quality and construction of the envelopes. Try another envelope brand 

if you do not get desired results. 
• Maintain constant temperatures and relative humidity. 
• Store unused envelopes in their packaging to avoid excess moisture and dryness which can affect 

print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before or 
during printing. 

• Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book on 
top of them. 

• In the print driver software, select Envelope as the paper type. 
• Do not use padded envelopes. Use envelopes that lie flat on a surface. 
• Do not use envelopes with heat activated glue. 
• Do not use envelopes with press and seal flaps. 
• Use only paper envelopes. 
• Do not use envelopes with windows or metal clasps. 
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Loading Envelopes in Tray 5 
1. Open tray 5 by rotating it outward. 
2. Load envelopes in the tray with the flaps closed, flaps up, and flaps on the leading edge, toward the 

right. 

 
3. Center the stack, then slide the guides until they lightly touch the edges of the stack. 
4. Verify the size, type, and color of the envelope. Change the selection for any incorrect setting. Select 

the size before the type. 
5. On the printer touch screen, touch Confirm. 
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Loading the Envelope Tray 
1. Pull out the envelope tray until it stops. 

 
2. Load the envelopes in the envelope tray with the flaps closed, flaps down, and on the leading edge, 

toward the left. 

Notes: 

• Maximum stack height of 43 mm (1.7 in.) 
• The envelope tray accepts envelope weights from 75–90 g/m². 

 
3. Adjust the paper guides so they rest lightly against the edges of the envelopes. 

 
4. Close the tray. Set the paper size, type, and color at the control panel. For details, see Changing 

Paper Size, Type, and Color on page 59. 
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Labels 

You can print labels from any tray. 
 

Guidelines for Printing Labels 
• Use labels designed for laser printing. 
• Do not use vinyl labels. 
• Do not feed a sheet of labels through the printer more than once. 
• Do not use dry gum labels. 
• Print only on one side of the sheet of labels. Use full sheet labels only. 
• Store unused labels flat in their original packaging. Leave the sheets of labels inside the original 

packaging until ready to use. Return any unused sheets of labels to the original packaging and reseal 
it. 

• Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions. Storing 
them in extreme conditions can cause print-quality problems or cause them to jam in the printer. 

• Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and 
jam in the printer. 

• In the print driver software, select Label as the paper type. 
• Before loading labels, remove all other paper from the tray. 
 

 CAUTION: Do not use any sheet where labels are missing, curled, or pulled away from the backing 
sheet. It could damage the printer. 
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Loading Labels in Trays 1–4 
1. Pull out the tray until it stops. 

 
2. Ensure that the guide locks are set in the correct position for the size labels you are loading. For 

details, see Setting the Guide Locks in the 500-Sheet Adjustable Trays on page 58. 

Note: Trays 1–4 accept labels (106–169 g/m²). 

− For long-edge feed, load labels face up with the top edge toward the front of the tray. 

 
3. For short-edge feed, load labels face up with the top edge facing to the right. 

 
4. Close the tray. Set the paper size, type, and color at the control panel. For details, see Changing 

Paper Size, Type, and Color on page 59. 
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Loading Labels in Tray 5 
1. Open tray 5 and pull out the extension tray for larger sizes. If already opened, remove any paper that 

is a different size or type. 

 
2. Move the width guides to the edges of the tray. 
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3. Load the labels in the tray. Do one of the following: 
− For long-edge feed, load labels face down with the top edge toward the front of the tray. 

 
− For short-edge feed, load labels face down with the top edge to the left. 

 
Notes: 

• Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to jam. 
• Do not print on label media once a label has been removed from a sheet. 
• To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to use 

it. 
4. Adjust the width guides until they touch the edges of the paper. 
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5. When prompted, select an option: 
− To confirm the paper type and size, touch Confirm. 
− To select a new paper size, touch Size. To select a new paper type, touch Type. To select a new 

paper color, touch Color. When finished, touch Confirm. 

Notes: 

• To change the size, type, and color of paper when the control panel is locked, log in as the 
system administrator. 

• For details, see Changing Paper Size, Type, and Color on page 59. 
 

Glossy Cardstock 

You can print Lightweight Glossy Cardstock and Glossy Cardstock from any tray. You can print 
Heavyweight Glossy Cardstock from tray 5 only. 
 

Guidelines for Printing on Gloss Paper 
• Do not open sealed packages of gloss paper until you are ready to load them into the printer. 
• Leave gloss paper in the original wrapper, and leave the packages in the shipping carton until ready 

to use. 
• Remove all other paper from the tray before loading gloss paper. 
• Load only the amount of gloss paper you are planning to use. Do not leave gloss paper in the tray 

when you are finished printing. Reinsert unused paper in the original wrapper and seal. 
• Rotate stock frequently. Long periods of storage in extreme conditions can cause gloss paper to curl 

and jam in the printer. 
• In the print driver software, select the desired gloss paper type or select the tray loaded with the 

desired paper. 
 

Loading Gloss Paper in Tray 5 (Bypass Tray) 
1. Remove all other paper from the tray before loading gloss paper. 
2. Load only the amount of paper you plan to use. 
3. Load the paper with the glossy side or print side down. 
4. Verify the size, type, and color of the paper. Change the selection for any incorrect setting. 
5. On the printer touch screen, touch Confirm. 
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Transparencies 

Transparencies can be printed from trays 1–5. For best results, use only recommended Xerox® 
transparencies. 
 

 CAUTION: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does not 
cover damage caused by using unsupported paper or specialty media. The Xerox Total Satisfaction 
Guarantee is available in the United States and Canada. Coverage could vary outside these areas. 
Please contact your local representative for details. 

 
 

Guidelines for Printing on Transparencies 
• Remove all paper before loading transparencies in the tray. 
• Handle transparencies by the edges using both hands. Fingerprints or creases can cause poor print 

quality. 
• Do not load more than 20 transparencies. Overloading the tray can cause the printer to jam. 
• Load transparencies face up into tray 5 (bypass tray) and face down into trays 1–4. 
• Do not use transparencies with stripes on the side. 
• Do not fan transparencies. 
• After loading transparencies, change the paper type to Transparency on the printer touch screen. 
• In the print driver software, select Transparency as the paper type. 
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Printing Overview 

Before printing, your computer and the printer must be plugged in, turned on, and connected to an active 
network. Make sure that you have the correct print driver software installed on your computer. For details, 
see Installing the Software on page 44. 
1. Select the appropriate paper. 
2. Load paper in the appropriate tray. On the printer control panel, specify the size, color, and type. 
3. Access the print settings in your software application. For most software applications, press CTRL+P 

for Windows, or CMD+P for Macintosh. 
4. Select your printer from the list. 
5. Access the print driver settings by selecting Properties or Preferences for Windows, or Xerox® 

Features for Macintosh. The title of the button can vary depending on your application. 
6. Modify the print driver settings as necessary, then click OK. 
7. Click Print to send the job to the printer. 
 

See also: 
Loading Paper on page 55 
Selecting Printing Options on page 77 
Printing on Both Sides of the Paper on page 86 
Printing on Special Paper on page 65 
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Selecting Printing Options 

This section includes: 
• Print Driver Help................................................................................................................................................................ 77 
• Windows Printing Options ............................................................................................................................................ 78 
• Macintosh Printing Options ......................................................................................................................................... 80 
• Linux Printing Options .................................................................................................................................................... 81 

Printing options, also called print driver software options, are specified as Printing Preferences in 
Windows, and Xerox® Features in Macintosh. Printing options include settings for 2-sided printing, page 
layout, and print quality. Printing options that are set from Printers and Faxes Printing Preferences 
become the default setting. Printing options that are set from within the software application are 
temporary. The application and the computer do not save the settings after the application is closed. 
 

Print Driver Help 

Xerox® print driver software Help information is available from the Printing Preferences window. Click the 
Help (?) button in the bottom left corner of the Printing Preferences window to see the Help. 

 

Information about Printing Preferences appears in the Help window on two tabs: 
• Contents provides a list of the tabs at the top and the areas at the bottom of the Printing 

Preferences window. Use the Contents tab to find explanations for each of the fields and areas in 
Printing Preferences. 

• Search provides a field where you can enter the topic or function for which you need information. 
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Windows Printing Options 

Setting Default Printing Options for Windows 

When you print from any software application, the printer uses the print job settings specified in the 
Printing Preferences window. You can specify your most common printing options and save them so that 
you do not have to change them every time you print. 

For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in 
Printing Preferences. 

To select default printing options: 
1. Navigate to the list of printers on your computer: 

− For Windows XP SP3, click Start>Settings>Printers and Faxes. 
− For Windows Server 2003 and later, click Start>Settings>Printers. 
− For Windows 7, click Start>Devices and Printers. 

2. In the list, right-click the icon for your printer and click Printing Preferences. 
3. In the Printing Preferences window, click a tab, select the options, then click OK to save. 

Note: For more information about Windows print driver options, click the Help button (?) in the 
Printing Preferences window. 

 

Selecting Printing Options for an Individual Job for Windows 

To use special printing options for a particular job, change the Printing Preferences from the application 
before sending the job to the printer. For example, if you want to use the Enhanced print-quality mode 
when printing a particular document, select Enhanced in Printing Preferences before printing the job. 
1. With the document open in your software application, access the print settings. For most software 

applications, click File>Print or press CTRL+P. 
2. To open the Properties window, select your printer, then click the Properties or Preferences button. 

The title of the button varies depending on your application. 
3. Click a tab in the Properties window, then make selections. 
4. To save your selections and close the Properties window, click OK. 
5. To send the job to the printer, click OK. 
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Selecting Finishing Options for Windows 

If your printer has a finisher installed, you can select finishing options in the Properties window of the 
print driver. 

Note: Not all options listed are supported on all printers. Some options apply only to a specific printer 
model, configuration, operating system, or driver type. 

To select finishing options in the PostScript and PCL print drivers: 
1. In the print driver, click the Printing Options tab. 
2. To select a finishing option, to the right of the Finishing list, click the arrow. 

Note: The print driver displays stapling positions for paper fed on the long edge. If paper feeds on 
the short edge instead of the long edge, the finisher can insert the staple in the wrong location. 

3. To select the output tray, click the arrow to the right of the Output Destination field, then select an 
option: 
− Automatically Select: You can use this option to have the printer determine the output 

destination based on the number of sets and the stapling option selected. The printer sends 
multiple sets or stapled sets to the finisher output tray. 

− Center Tray: You can use this option to select the output tray in the middle of the printer. 
− Left Tray: You can use this option to select the output tray on the left side of the printer. 
− Folder Tray: You can use this option to select the output tray for the CZ Folder. 
− Right Top Tray: You can use this option to select the output tray on top of the Business Ready 

finisher. 
− Right Middle Tray: You can use this option to select the output tray in the middle of the 

Business Ready finisher. 
− Booklet Tray: You can use this option to select the output tray on the bottom of the Business 

Ready finisher. 
4. Do one of the following: 

− To save the settings, click the arrow to the right of the Saved Settings field at the bottom of the 
window, then click OK. 

− To send the job to the printer, click OK. 
 

Saving a Set of Commonly Used Printing Options for Windows 

You can define and save a set of options, so that you can apply them to future print jobs. 

To save a set of printing options: 
1. With the document open in your application, click File>Print. 
2. Select the printer, then click Properties. Click the tabs in the Properties window, then select the 

desired settings. 
3. To save the settings, click the arrow to the right of the Saved Settings field at the bottom of the 

window, then click Save As. 
4. Type a name for the set of printing options, then to save the set of options in the Saved Settings list, 

click OK. 
5. To print using these options, select the name from the list. 
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Macintosh Printing Options 

Selecting Printing Options for Macintosh 

To use specific printing options, change the settings before sending the job to the printer. 
1. With the document open in your application, click File>Print. 
2. Select your printer from the list. 
3. Select Xerox® Features from the Copies & Pages menu. 
4. Select the desired printing options from the drop-down lists. 
5. Click Print to send the job to the printer. 
 
 

Selecting Finishing Options for Macintosh 

If your printer has a finisher installed, select finishing options in the Xerox® Features of the print driver. 

To select finishing options in the Macintosh print driver: 
1. In the print driver, click Copies & Pages, then select Xerox® Features. 
2. To select stapling options, click the arrow to the right of the Finishing field, then select an option. 
3. To select the output tray, click the arrow to the right of the Output Destination field, then select an 

option: 
− Automatically Select: You can use this option to have the printer determine the output 

destination based on the number of sets and the stapling option selected. The printer sends 
multiple sets or stapled sets to the finisher output tray. 

− Center Tray: You can use this option to select the output tray in the middle of the printer. 
− Left Tray: You can use this option to select the output tray on the left side of the printer. 
− Folder Tray: You can use this option to select the output tray for the CZ Folder. 
− Right Top Tray: You can use this option to select the output tray on top of the Business Ready 

finisher. 
− Right Middle Tray: You can use this option to select the output tray in the middle of the 

Business Ready finisher. 
− Booklet Tray: You can use this option to select the output tray on the bottom of the Business 

Ready finisher. 
4. To send the job to the printer, click OK. 
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Saving a Set of Commonly Used Printing Options for Macintosh 

You can define and save a set of options, so that you can apply them to future print jobs. 

To save a set of printing options: 
1. With the document open in your application, click File>Print. 
2. Select your printer from the Printers list. 
3. Select the desired printing options from the drop-down lists in the Print dialog box. 
4. Click Presets>Save As. 
5. Type a name for the printing options, then click OK to save the set of options in the Presets list. 
6. To print using these options, select the name from the Presets list. 
 
 

Linux Printing Options 

Launching Xerox® Printer Manager 

To launch Xerox® Printer Manager from a terminal window prompt as root, type xeroxprtmgr, then press 
Enter or Return. 
 

Printing from a Linux Workstation 

To print from a Linux workstation: 
1. Create a print queue. 
2. With the desired document or graphic open in your application, open the Print dialog box. For most 

software applications, click File>Print or press CTRL+P. 
3. Select the target print queue. 
4. Close the Print dialog box. 
5. In the Xerox® GUI print driver, select the available printer features. 
6. Click Print. 

The Xerox® print driver accepts job ticket settings files that select additional settings or features. You 
can also submit print requests through the command line using lp/lpr. 

To create a job ticket using the Xerox® GUI print driver: 
1. Open the Xerox® GUI print driver. 
2. Select the desired options. 
3. Click Save As, then store the job ticket in a public location, such as /tmp. 

Note: Personally identifiable information, such as a Secure Print passcode, is not saved in the job 
ticket. You can specify the information on the command line. 
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To create a job ticket using the command line: 
1. On the command line, as the root user, type xeroxprtmgr. 
2. Select the desired options. 
3. Click Save As, then store the job ticket in a public location, such as /tmp. 

Note: Personally identifiable information, such as a Secure Print passcode, is not saved in the job 
ticket. You can specify the information on the command line. 

The following commands are examples of how to print using a job ticket: 
• lp -d{Target_Queue} -oJT={Absolute_Path_To_Job_Ticket} {Path_To_Print_File} 
• lp -dMyQueue -oJT=/tmp/DuplexedLetterhead /home/user/PrintReadyFile 
• lp -dMyQueue -oJT=/tmp/Secure -oSecurePasscode=1234 /home/user/PrintReadyFile 
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Managing Jobs 

This section includes: 
• Managing Jobs at the Control Panel ........................................................................................................................ 83 
• Managing Secure and Held Print Jobs ..................................................................................................................... 84 
• Managing Jobs in CentreWare Internet Services ................................................................................................ 85 
 

Managing Jobs at the Control Panel 

From the control panel Job Status, you can view lists of active jobs, secure jobs, or completed jobs. You 
can pause, delete, print, or view job progress or job details for a selected job. For details, see Printing 
Special Job Types on page 95. 

To pause printing: 
1. At the control panel, press the Interrupt button. The printer continues to print while it determines 

the best place to pause the spooled print job. 
2. To resume printing, press the Interrupt button again. 

To pause the print job with the option to delete it: 
1. At the control panel, press the Stop button. 
2. Do one of the following: 

− To delete the print job, touch Cancel Printing. 
− To resume the print job, touch Resume Printing. 

Note: If you do not make a selection within 60 seconds, the job automatically resumes. 

To view active, secure, or completed jobs: 
1. At the control panel, press the Job Status button. 
2. To see a list of specific job types, touch a tab. 

− To view jobs that are processing or waiting to process, touch the Active Jobs tab. 
− To view Secure Print jobs, touch the Secure Print Jobs, or My Secure Jobs tab. Touch the folder, 

enter the passcode number using the keypad, then touch OK. 
− To view completed jobs, touch the Completed Jobs tab. 

3. To refine the list, touch the Down arrow. 
4. To see details about a job, touch the job. 
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To delete a job: 
1. At the control panel, press the Job Status button. 
2. From any of the job type tabs, touch the job. 
3. Touch Delete. 

Notes: 

• The system administrator can restrict users from deleting jobs. If a system administrator has 
restricted job deletion, you can view the jobs, but not delete them. 

• Only the user that sent the job or the system administrator can delete a secure print job. 

From the Print From menu, you can view lists of saved jobs, jobs stored on a USB Flash drive, or jobs 
stored in printer folders. You can select and print jobs from any of the lists. To print the job, see Printing 
Special Job Types on page 95. 

To view saved jobs: 
1. At the printer control panel, press the Services button. 
2. Touch Print From, then touch Saved Jobs. 
3. To view the saved jobs, touch a folder. 
4. To see details about a job, touch the job. 
 

Managing Secure and Held Print Jobs 

When you send a secure print job, the job is held until you release it by typing a passcode at the control 
panel. 

To view a list of secure print jobs: 
1. At the printer control panel, press the Job Status button. 
2. Touch Secure Print Jobs or My Secure Jobs. For details, see Secure Print on page 95. 
3. Note: Only the user that sent the job or the system administrator can delete a secure print job. 

If the system administrator has configured the Hold All Jobs feature, any job sent to the printer is held 
until you release it. For details, see Releasing Held Print Jobs on page 101. 

Unidentified jobs are jobs that are not associated with a user name. Unidentified jobs originate from a 
computer that does not require a user to log in. Examples are a job sent from a DOS or UNIX window 
using LPR, Port 9100, or from the Jobs tab in CentreWare Internet Services. 

To view a list of the unidentified jobs and release them: 
1. Touch the Unidentified Print Jobs tab. 
2. Do one of the following: 

− To release a held job, touch the job, then touch Release. 
− To release all held jobs, touch Release All Jobs. 

A print job can be held by the printer when it is unable to complete a print job. For example, it needs 
attention, paper, or supplies. When the condition is resolved, the printer automatically resumes printing. 
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Managing Jobs in CentreWare Internet Services 

You can view a list of active jobs and delete print jobs from the Active Jobs list in CentreWare Internet 
Services. You can also print, copy, move, or delete saved jobs. For details, see the Help in CentreWare 
Internet Services. 
 

 Xerox® WorkCentre® 7970 Multifunction Printer 85 
 User Guide 
 



Printing 

 

Printing Features 

This section includes: 
• Printing on Both Sides of the Paper .......................................................................................................................... 86 
• Selecting Paper Options for Printing ......................................................................................................................... 87 
• Printing Multiple Pages to a Single Sheet ............................................................................................................... 87 
• Printing Booklets .............................................................................................................................................................. 88 
• Using Image Options...................................................................................................................................................... 88 
• Printing Cover Pages ....................................................................................................................................................... 89 
• Printing Insert Pages ....................................................................................................................................................... 90 
• Printing Exception Pages ............................................................................................................................................... 90 
• Scaling .................................................................................................................................................................................. 91 
• Printing Watermarks ....................................................................................................................................................... 92 
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Printing on Both Sides of the Paper 

Paper Types for Automatic 2-Sided Printing 

The printer can print a 2-sided document automatically on supported paper. Before printing a 2-sided 
document, verify that the paper type and weight are supported. For details, see Supported Paper Types 
and Weights for Automatic 2-Sided Printing on page 53. 
 

Printing a 2-Sided Document 

Options for Automatic 2-Sided Printing are specified in the print driver. The print driver uses the settings 
for portrait or landscape orientation from the application for printing the document. 
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2-Sided Page Layout Options 

You can specify the page layout for 2-sided printing, which determines how the printed pages turn. These 
settings override the application page orientation settings. 
 

Portrait Landscape 

 

 

 

 

 

 

 

 
Portrait 
2-Sided Print 

Portrait 
2-Sided Print, Flip on Short 
Edge 

Landscape 
2-Sided Print 

Landscape 
2-Sided Print, Flip on Short 
Edge 

  
 

Selecting Paper Options for Printing 

There are two ways to select the paper for your print job. You can let the printer select which paper to use 
based on the document size, paper type, and paper color you specify. You can also select a specific tray 
loaded with the desired paper. 
 

Printing Multiple Pages to a Single Sheet 

When printing a multiple-page document, you can print more than one page on a single sheet of paper. 
Print 1, 2, 4, 6, 9, or 16 pages per side by selecting Pages Per Sheet on the Page Layout tab. Page Layout is 
on the Document Options tab. 
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Printing Booklets 

With 2-sided printing, you can print a document in the form of a small booklet. Create booklets from any 
paper size that is supported for 2-sided printing. The driver automatically reduces each page image and 
prints four page images per sheet of paper, two page images on each side. The pages are printed in the 
correct order so that you can fold and staple the pages to create the booklet. 

When you print booklets using the Windows PostScript or Macintosh driver, you can specify the gutter 
and creep. 
• Gutter: Specifies the horizontal distance in points between the page images. A point is 0.35 mm 

(1/72 in.). 
• Creep: Specifies how much the page images shift outward in tenths of a point. Shifting compensates 

for the thickness of the folded paper, which can cause the page images to shift outward slightly 
when folded. You can select a value from zero to 1 point. 

  

Gutter Creep 

 

 

 

 

Using Image Options 

The Image Options control the way the printer uses color to produce your document. The Windows 
PostScript and the Macintosh drivers provide the widest range of color controls and corrections. Each 
system has standard modes of color control for normal use and custom color options for the more 
advanced users. Image Options are on the Image Options tab of the Properties window. There, they are 
divided into Color Correction, Color By Words, and Color Adjustments tabs. For details on accessing the 
Properties window, see Printing Overview on page 76. 

The Color Correction tab provides standard color modes: 
• Xerox Black and White converts all color in the document to black and white or shades of gray. 
• Xerox Automatic Color applies the best color correction to text, graphics, and images. Xerox 

recommends this setting. 
• Color Correction provides a selection of commercial press, spot color, CIE, and gray image 

simulations to match your document color. This tab also provides a Custom Automatic Color option 
for advanced color corrections based on RGB Color, CMYK Color, Spot Color, CIE Color, or Gray. 

The two remaining tabs provide additional ways of adjusting the colors for more specific color 
requirements. 
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The Color By Words tab provides a three-step process for defining custom color correction. By making a 
selection from each of the three fields, you create a sentence for controlling the color characteristics of 
the document. You can create several sentences to more precisely control the color content of the 
document. As you create a Color By Words sentence, it appears in the window below the selection fields. 
The sentence structure is made of three parts: 
• What Color to Change? provides a list to select a color or range of colors to adjust, such as All 

Foliage-Green Colors. 
• How Much Change? lets you select how much effect to make, such as A Lot More, to the selected 

color. 
• What Type of Change? lets you select the type of change, such as Vivid, from a list. 

The Color Adjustments tab provides a set of six sliders for adjusting the individual components of the 
selected colors. You can use the sliders to adjust the lightness, contrast, saturation, cyan, magenta, and 
yellow components of the color. 
 

Printing Cover Pages 

A cover page is the first or last page of a document. You can select paper sources for the cover pages that 
are different from the source used for the body of a document. For example, you can use your company 
letterhead for the first page of a document. You can also use heavyweight paper for the first and last 
pages of a report. You can use any applicable paper tray as the source for printing cover pages. 

Select one of these options for printing cover pages: 
• No Covers does not print cover pages. No cover pages are added to the document. 
• Front Only prints the first page on paper from the specified tray. 
• Back Only prints the back page on paper from the specified tray. 
• Front and Back: Same prints the front and back cover pages from the same tray. 
• Front and Back: Different prints the front and back cover pages from different trays. 

After making a selection for printing the cover pages, you can select the paper for the front and back 
covers by size, color, or type. You can also use blank or pre-printed paper, and you can print side one, side 
two, or both sides of the cover pages. 
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Printing Insert Pages 

You can add blank or pre-printed insert pages before page one of each document or after designated 
pages within a document. Adding an insert after designated pages within a document separates sections, 
or acts as a marker or placeholder. Ensure that you specify the paper to use for the insert pages. 
• Insert Options provides the options to place an insert After Page X, where X is the specified page, or 

Before Page 1. 
• Insert Quantity specifies the number of pages to insert at each location. 
• Pages specifies the page or range of pages that use the exception page characteristics. Separate 

individual pages or page ranges with commas. Specify pages within a range with a hyphen. For 
example, to specify pages 1, 6, 9, 10, and 11, type 1,6,9-11. 

• Paper displays the default size, color, and type of paper selected in Use Job Settings. Click the Down 
arrow to the right of the Paper field to select a different paper size, color, or type. 

• Job Setting displays the attributes of the paper for the remainder of the job. 
 

Printing Exception Pages 

Exception pages have different settings from the rest of the pages in the job. You can specify differences 
such as page size, page type, and page color. You can also change the side of the paper on which to print 
as your job requires. A print job can contain multiple exceptions. 

For example, your print job contains 30 pages. You want five pages to print on only one side of a special 
paper, and the remainder of the pages printed 2-sided on regular paper. You can use exception pages to 
print the job. 

In the Add Exceptions window, you can set the characteristics of the exception pages and select the 
alternate paper source: 
• Pages specifies the page or range of pages that use the exception page characteristics. Separate 

individual pages or page ranges with commas. Specify pages within a range with a hyphen. For 
example, to specify pages 1, 6, 9, 10, and 11, type 1,6,9-11. 

• Paper displays the default size, color, and type of paper selected in Use Job Settings. Click the Down 
arrow to the right of the Paper field to select a different paper size, color, or type. 

• 2-Sided Printing allows you to select 2-sided printing options. Click the Down arrow to select an 
option: 
− 1-Sided Print prints the exception pages on one side only. 
− 2-Sided Print prints the exception pages on both sides of the paper and flips the pages on the 

long edge. The job then can be bound on the long edge of the pages. 
− 2-Sided Print, Flip on Short Edge prints the exception pages on both sides of the paper and 

flips the pages on the short edge. The job then can be bound on the short edge of the pages. 
− Use Job Setting prints the job using the attributes shown in the Job Settings box. 

• Job Setting displays the attributes of the paper for the remainder of the job. 

Note: Some combinations of 2-sided printing with certain paper types and sizes can produce 
unexpected results. 
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Scaling 

You can reduce the image to as little as 25% of its original size or enlarge it as much as 400%. In 
Windows, the Scale Options are located in the print driver on the Printing Options tab. 
 

50% 100% 200% 

   

1. To access Scaling Options, to the right of the Paper field, click the arrow, then select Other 
Size>Advanced Paper Size. 

2. Select an option. 
− No Scaling: You can use this option to retain the original image size. 
− Automatically Scale: You can use this option to change the print from one standard paper size 

to another. The Original Document Size is scaled to fit on the selected output paper size shown 
in the Output Paper Size field. 

• Manually Scale: You can use this option to change the output print size by a specified percentage. 
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Printing Watermarks 

A watermark is special purpose text that can be printed across one or more pages. For example, you can 
add a word like Copy, Draft, or Confidential as a watermark instead of stamping it on a document before 
distribution. 

 
Notes: 

• Not all options listed are supported on all printers. Some options apply only to a specific printer 
model, configuration, operating system, or driver type. 

• Watermarks are not supported for some print drivers when booklet is selected or when more 
than one page is printed on a sheet of paper. 

Using the watermark options, you can do the following: 
• Create a watermark or edit an existing watermark using the Watermark Editor: 

− A Text Watermark uses the characters typed in the Text field as the watermark. You can create 
a text watermark to print on a document. Select options such as font size, font type, font color, 
and angle. 

− A Picture Watermark uses an image as the watermark. The picture file can be in .bmp, .gif, or 
.jpg format. You can create a picture watermark to print on a document, and select options 
including size and position on the page. 

− A Time Stamp Watermark uses a time stamp as the watermark. You can create a time stamp 
watermark to print on a document. Time stamp elements include the day, date, time, and time 
zone. 

• Place a watermark on the first page or on every page in a document. 
• Print a watermark in the foreground or background or blend it with the print job. 

To print a Watermark: 
1. Click Document Options>Watermark. 
2. From the Watermark menu, select the watermark. 
3. Click Layering, then select how to print the watermark: 

− Print in Background prints the watermark behind the text and graphics in the document. 
− Blend combines the watermark with the text and graphics in the document. A blended 

watermark is translucent, so you can see both the watermark and the document content. 
− Print in Foreground prints the watermark over the text and graphics in the document. 
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4. Click Pages, then select the pages on which to print the watermark: 
− Print on All Pages prints the watermark on all pages of your document. 
− Print on Page 1 Only prints the watermark only on the first page of the document. 

5. Click OK. 
 

Printing Mirror Images 

If the PostScript driver is installed, you can print pages as a mirror image. Images mirror left to right when 
printed. 
 

Creating and Saving Custom Sizes 

You can print custom-size paper from Trays 1–5. Custom size paper settings are saved in the print driver 
and are available for you to select in all your applications. See Supported Custom Paper Sizes on page 50 
for paper sizes that are supported for each tray. 

To create and save custom sizes for Windows: 
1. In the print driver, click the Printing Options tab. 
2. For Paper, click the arrow, then select Other Size>Advanced Paper Size>Output Paper Size>New. 
3. In the New Custom Paper Size window, enter the height and width of the new size. 
4. To specify the units of measurement, at the bottom of the window, click the Measurements button, 

then select Inches or Millimeters. 
5. To save, in the Name field, type a title for the new size, then click OK. 

To create and save custom sizes for Macintosh: 
1. In the application, click File>Page Setup. 
2. Click Paper Sizes, then select Manage Custom Sizes. 
3. To add a new size, in the Manage Paper Sizes window, click the plus sign (+). 
4. At the top of the window, double-click My Custom Size, then type a name for the new custom size. 
5. Enter the height and width of the new custom size. 
6. Click Print Margins, then select the printer from the list. Or set the top, bottom, right, and left 

margins. 
7. To save the settings, click OK. 
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Selecting Job Completion Notification for Windows 

You can select to be notified when your job finishes printing. A message appears on your computer screen 
with the name of the job and the name of the printer where it was printed. 

Note: This feature is available on a computer printing to a network printer. 

To be notified when your print job completes: 
1. In the print driver, click the Printing Options tab. 
2. Click Notification>Notify for Completed Jobs>Enabled. 
3. Click OK. 
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Printing Special Job Types 

This section includes: 
• Secure Print ........................................................................................................................................................................ 95 
• Sample Set .......................................................................................................................................................................... 97 
• Delay Print .......................................................................................................................................................................... 98 
• Saved Job ............................................................................................................................................................................ 98 

Special job types allow you to send a print job from your computer, then print it from the printer control 
panel. 

Select special job types in the print driver from the Printing Options tab. 
 

Secure Print 

Secure print allows you to associate a 4–10 digit passcode with a print job when sending it to the printer. 
The job is held at the printer until you enter the passcode at the control panel. 

When printing a series of secure print jobs, you can assign a default passcode in the Printing Preferences 
of the print driver. Then you can use the default passcode for all print jobs sent from that computer. If 
you must use a different passcode, you can override it in the application print driver. 
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Sending a Secure Print Job 
1. On the Printing Options tab, from the Job Type list, select Secure Print. 
2. Type a 4–10 digit passcode for the Secure Print job. 
3. In the Confirm Passcode field, type the passcode again. 

Notes: 

• If you do not supply a passcode, the printer assigns a passcode and displays it in the Passcode 
Required window. You can use the passcode supplied by the printer, or you can type your own 
passcode to use in the Secure Print window. 

• The passcode is associated with your user name. After you set a passcode, it becomes the 
default passcode for any print job that requires a passcode on all Xerox® printers. You can reset 
the passcode at any time from any window that contains the passcode. 

4. Click OK. 
5. Verify that the paper is the correct size, type, and weight. If not, change the paper settings. 

Note: To select the paper for your print job, click Paper>Select By Tray. 

6. Select an option for 2-sided printing. 
7. If your printer has a finisher installed, click the arrow to the right of Finishing, then select a stapling 

option. The image next to Stapling shows the staple position. 
8. Select a print-quality mode. 
9. Select an output destination. 
10. Select another tab or click OK. 
11. To send the job to the printer, in the Print window, select the number of copies to print, then click OK 

or Print. 
 

Releasing a Secure Print 
1. At the control panel, press the Job Status button. 
2. Touch the Secure Print Jobs or My Secure Jobs tab. 
3. Touch the folder that holds the print job. 
4. Using the keypad, enter the passcode that you assigned to the print job, then touch OK. 
5. Touch the corresponding print job in the list, then touch Release. 
 

Deleting a Secure Print 
1. At the control panel, press the Job Status button. 
2. Touch the Secure Print Jobs or My Secure Jobs tab. 
3. Touch the folder that holds the print job. 
4. Enter the passcode number that you assigned to the print job using the keypad. 
5. Touch the corresponding print job in the list, then touch Delete. 
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Sample Set 

The Sample Set job type allows you to print a sample copy of a multiple-copy job and hold the remaining 
copies at the printer. After you review the sample copy, you can select the job name from the printer 
control panel to print the additional copies. 
 

Sending a Sample Set Print Job 
1. On the Printing Options tab, from the Job Type list, select Sample Set. 
2. Verify that the paper is the correct size, type, and weight. If not, change the paper settings. 

Note: To select the paper for your print job, click Paper>Select By Tray. 

3. Select an option for 2-sided printing. 
4. If your printer has a finisher installed, click the arrow to the right of Finishing, then select a stapling 

option. The image next to Stapling shows the staple position. 
5. Select a print-quality mode. 
6. Select an output destination. 
7. Select another tab or click OK. 
8. To send the job to the printer, in the Print window, select the number of copies to print, then click OK 

or Print. 
A sample copy prints immediately. The sample copy is not counted as part of the print job. 

9. After reviewing the copy, use the printer control panel to print or delete the remaining copies. 

Note: You can use Sample Set as a part of the Earth Smart settings. In Earth Smart settings, set 
Sample Set as your default Job Type. 

10. To print the job, select it from the job list on the printer control panel. 
11. Press OK. 
 

Releasing the Remaining Prints After Printing a Sample Set 
1. At the control panel, touch Job Status. 
2. Touch the corresponding print job in the list. 

Note: The control panel displays Held: Sample Set next to the job name. 

3. Touch Release. 
The remainder of the job prints, and the job is deleted from the printer hard drive. 
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Delay Print 

You can delay a print job for up to 24 hours from the original job submission time. Enter the time at which 
you would like the job to print. If the time you enter is earlier than the time that you submit the print job, 
it prints on the following day. The Delayed Print default time is midnight. 
 

Sending a Delay Print Job 
1. On the Printing Options tab, from the Job Type list, select Delay Print. 
2. In the Delay Print window, select the Tab key to move from the hour section to the minutes section. 

To select the time to send the print job, click the arrow buttons. 
− For a 12-hour time format, type the hour (1–12), minutes (00–59), then select A.M. or P.M. To 

toggle between A.M. and P.M., click A.M. or P.M., then use the Up arrow or Down arrow buttons. 
− For a 24-hour time format, type the hour (1–23) and the minutes (00–59). 

Note: The regional settings on your computer determine the time format. 

3. Click OK. 
4. Select other desired printing options and click OK. 
5. Click OK or Print. 

Note: To print the job after you send it but before the scheduled time, release the job at the printer 
control panel. 

 

Saved Job 

Saved Job or Store File in Folder stores a public or private job in the printer and prints the job as requested 
at the printer control panel. This option is useful for documents that you print frequently. You can assign 
a passcode to a private job to prevent unauthorized printing. 

To print saved jobs, see Printing from Saved Jobs on page 102. 
 

Sending a Public Saved Job 
1. On the Printing Options tab, from the Job Type list, select Saved Job. 
2. In the Saved Job window, for Job Name, do one of the following: 

− Type a name for the job. 
− Click the arrow to the right of the field and select a name from the list. 
− Click the arrow to the right of the field and select Use Document Name to use the name of the 

document. 

Note: The print driver retains 10 names. When adding an 11th name, the name used least is deleted 
automatically from the list. To remove names from the list other than the selected name, select 
Clear List. 

3. In Save To or Folder Number, specify where you want the file saved on the printer. Do one of the 
following: 
− Type the name of the destination folder. 
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− Click the arrow to the right of the field, then select a folder name from the list. 
− Click the arrow to the right of the field, then select Default Public Folder. 

4. To print the job now and also save the job, select the Print and Save check box. 
5. Select Public. 
6. Click OK. 
7. Verify that the paper is the correct size, type, and weight. If not, change the paper settings. 

Note: To select the paper for your print job, click Paper>Select By Tray. 

8. Select an option for 2-sided printing. 
9. If your printer has a finisher installed, click the arrow to the right of Finishing, then select a stapling 

option. The image next to Stapling shows the staple position. 
10. Select a print-quality mode. 
11. Select an output destination. 
12. Select another tab or click OK. 
13. To send the job to the printer, in the Print window, select the number of copies to print, then click OK 

or Print. 
A sample copy prints immediately. The sample copy is not counted as part of the print job. 

14. To print the job, select it from the job list on the printer control panel. 
15. Press OK. 

After the job is saved, you can print it as needed. For details, see Printing from Saved Jobs on page 
102. 

 

Sending a Private Saved Job 
1. On the Printing Options tab, from the Job Type list, select Saved Job. 
2. In the Saved Job window, for Job Name, do one of the following: 

− Type a name for the job. 
− Click the arrow to the right of the field and select a name from the list. 
− Click the arrow to the right of the field and select Use Document Name to use the name of the 

document. 

Note: The print driver retains 10 names. When adding an 11th name, the name used least is deleted 
automatically from the list. To remove names from the list other than the selected name, select 
Clear List. 

3. In Save To or Folder Number, specify where you want the file saved on the printer. Do one of the 
following: 
− Type the name of the destination folder. 
− Click the arrow to the right of the field, then select a folder name from the list. 
− Click the arrow to the right of the field, then select Default Public Folder. 
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4. To print the job now and also save the job, select the Print and Save check box. 
5. To store your job at the printer, select Private. 
6. In the Passcode field, type a passcode. The passcode is associated with your user name. After you set 

a passcode, it becomes the default passcode for any print job that requires a passcode on all Xerox® 
printers. You can reset the passcode at any time from any window that contains the passcode. 

7. In the Confirm Passcode field, type the passcode again. 
8. Click OK. 
9. Verify that the paper is the correct size, type, and weight. If not, change the paper settings. 

Note: To select the paper for your print job, click Paper>Select By Tray. 

10. Select an option for 2-sided printing. 
11. If your printer has a finisher installed, click the arrow to the right of Finishing, then select a stapling 

option. The image next to Stapling shows the staple position. 
12. Select a print-quality mode. 
13. Select an output destination. 
14. Select another tab or click OK. 
15. To print the job, select it from the job list on the printer control panel. 
16. Press OK. 

After the job is saved, you can print it as needed. For details, see Printing from Saved Jobs on page 
102. 
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Held Print Jobs 

Jobs can be held or paused for various reasons. For example, if the printer is out of paper, the job holds. If 
you send a sample job, the first copy of the job prints and the rest of the copies hold until you release 
them. If the system administrator has configured the Hold All Jobs feature, any job sent to the printer is 
held until you release it. 
 

Releasing Held Print Jobs 
1. At the control panel, press the Job Status button. 
2. Touch Active Jobs. 
3. To determine why a job was held, touch the job, then touch Details. 
4. Do one of the following: 

− To release a held job, touch the job, then touch Release. 
− To release all held jobs, touch Release All Jobs. 
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Print From 

Print From allows printing of documents stored on the printer, on a computer on a network, or on a USB 
Flash drive. 
 

Printing from a USB Flash Drive 

You can print .pdf, .tiff, and .xps files directly from a USB Flash drive. 

Notes: 

• If USB ports are disabled, you cannot use a USB card reader for authentication, update the 
software, or print from a USB Flash drive. 

• The system administrator must set up this feature before you can use it. For details, see the 
System Administrator Guide at www.xerox.com/office/WC7970docs. 

To print from a USB Flash drive: 
1. Insert your USB Flash drive in the USB port on the printer control panel. The Print from USB window 

appears. 
The list at the bottom of the window displays the folders and printable files on the USB Flash drive. 

2. To scroll through the list and locate the printable file, next to the list, use the arrows. 
If the print file is in a folder, to open the folder, touch the name. 

3. Touch the name of the printable file. 
4. Select the number of copies, output color, paper size, paper color, paper type, 2-sided printing, and 

finishing options. 
5. Press the green Start button. 

To go back to the last screen, touch Back. 
To look for other folders and printable files, touch Browse. 

 

Printing from Saved Jobs 

To print from saved jobs: 
1. At the control panel, press the Services button, then touch Print From. 
2. Select Saved Jobs, then touch the name of the folder containing the saved job. 
3. Touch the name of the saved job that you want to print. 

Note: To print a private saved job, touch the name of the job, then enter the passcode. 

4. Select the number of copies, output color, paper size, paper color, paper type, 2-sided printing, and 
finishing options. 

5. Press the green Start button. 
6. After the job prints, to return to the list of saved jobs, touch Browse. 

To return to the list of folders, touch Back. 
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Printing from Mailbox 

Print from mailbox allows you to print a file that is stored in a folder on the printer hard drive. 

To print from a mailbox: 
1. At the control panel, press the Services button, then touch Print From. 
2. Select Mailbox, then touch the name of the folder containing the document. 

Note: If Mailbox is not displayed, use CentreWare Internet Services to enable the Scan to Mailbox 
and Print From Mailbox features. Then create a scan to mailbox folder. For details, see the System 
Administrator Guide at www.xerox.com/office/WC7970docs. 

3. Touch the name of the document that you want to print. 
4. Select the number of copies, output color, paper size, paper color, paper type, 2-sided printing, and 

finishing options. 
5. Press the green Start button. 

After the job prints, to return to the list of documents in the mailbox, touch Browse. 
To return to the list of folders, touch Back. 

 

Printing from CentreWare Internet Services 

You can print .pdf, .ps, .pcl, and .xps files directly from CentreWare Internet Services without having to 
open another application or the print driver. The files can be stored on a local computer hard drive, mass 
storage device, or network drive. 

To print from CentreWare Internet Services: 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on 
page 34. 

2. In CentreWare Internet Services, click the Print tab. 
3. To select the file from a local network or remote location, click Browse, select the file, then click 

Open. 
4. For Printing, select the desired options for the job. 

− Normal Print prints a job immediately. 
− Secure Print prints a job after you enter your passcode at the printer control panel. 
− Sample Set, or Proof Print, prints one copy of a multiple-copy print job and holds the remaining 

copies at the printer. 
− Save Job for Reprint saves a print job in a folder on the print server for future printing. You can 

specify a job name and folder. 
− Delay Print prints a job at a specified time up to 24 hours from the original job submission. 

5. If Accounting is enabled, enter your User ID and account information. 
6. Click Submit Job. 

Note: To ensure that the job was sent to the queue, wait for the job submission confirmation 
message to appear before you close this page. 
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Basic Copying 

1. To clear previous settings, press the yellow Clear All button on the control panel. 
2. Load your original documents: 

− Use the document glass for single pages or paper that cannot be fed using the document 
feeder. Place the first page of the document face down, in the top left corner of the document 
glass. 

− Use the document feeder for multiple or single pages. Remove any staples and paper clips from 
the pages and place them face up in the document feeder. 

3. Press the Services Home button, then touch Copy. 
4. Use the alphanumeric keypad on the control panel to enter the number of copies. The number of 

copies appears in the upper right corner of the touch screen. 
 

Note: To correct the number of copies entered using the alphanumeric keypad, press the C button, 
then re-enter the number. 

 

5. Change the copy settings as needed. For details, see Selecting Copy Settings on page 108. 
6. Press the green Start button. 
 

Notes: 

• To pause or cancel a copy job, press the red Stop button on the control panel. 
• To interrupt a copy job, press the Interrupt button on the control panel. 
• On the touch screen, touch Resume Scanning to continue the job, or Cancel Scanning to cancel the 

job completely. 
  
 

Document Glass 

 

• Lift the document feeder cover and place the 
first page face down in the upper left corner of 
the document glass. 

• Align the originals to the matching paper size 
printed on the edge of the glass. 

• The document glass accepts paper sizes up to 
297 x 432 mm (11.7 x 17 in.). 

• The document glass automatically detects 
standard paper sizes. 
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Duplex Automatic Document Feeder 

 

 

Insert originals face up, with page one on top. 
The duplex automatic document feeder scans 
both sides of 2-sided documents at the same 
time. 
• The confirmation indicator illuminates when 

you load the originals correctly. 
• Adjust the paper guides so they fit against 

the originals. 
• The document feeder automatically detects 

standard paper sizes. 
• The automatic document feeder 

accommodates the following original paper 
weights: 38–128 g/m². 

• The automatic document feeder 
accommodates the following originals: 85 x 
125 mm (3.3 x 4.9 in.) through 297 x 432 
mm (11.7 x 17 in.). 

• The automatic document feeder 
accommodates approximately the following 
quantity of paper by weight: 130 sheets of 
80 g/m² paper. 
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Selecting Copy Settings 

This section includes: 
• Basic Settings .................................................................................................................................................................. 109 
• Image-Quality Settings................................................................................................................................................ 112 
• Layout Settings ............................................................................................................................................................... 115 
• Output Format Settings ............................................................................................................................................... 118 
• ID Card Copying ............................................................................................................................................................. 125 
• Advanced Copying ......................................................................................................................................................... 129 
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Basic Settings 

This section includes: 
• Selecting Color or Black and White Copies ........................................................................................................... 109 
• Reducing or Enlarging the Image ............................................................................................................................ 109 
• Selecting the Paper Tray ............................................................................................................................................. 110 
• Selecting 2-Sided Copy Options ............................................................................................................................... 110 
• Selecting Collated Copies ........................................................................................................................................... 111 
• Selecting Uncollated Copies ...................................................................................................................................... 111 
• Stapling Copies ............................................................................................................................................................... 111 
 

Selecting Color or Black and White Copies 

If the original document contains color, you can create copies in full color, a single color, or in black and 
white. 

To select the output color: 
1. Press the Services Home button, then touch Copy. 
2. Under Output Color, select an option: 

− Auto Detect detects the color content in the original document. If the original is a color 
document, the printer makes copies in full color. If the original is a black and white document, 
the printer makes copies in black only. 

− Black & White copies in black and white only. Colors in the original are converted to shades of 
gray. 

− More provides additional choices: 
• Color copies in full color output using all four printing colors, cyan, magenta, yellow, and 

black. 
• Single Color copies in shades of a single color. Under Colors, select a color. The sample 

page shows your color selection. 
3. Touch OK. 
 

Reducing or Enlarging the Image 

You can reduce the image to as little as 25% of its original size or enlarge it as much as 400%. 

To reduce or enlarge the image: 
1. Press the Services Home button, then touch Copy. 
2. Touch an option: 

− To reduce or enlarge the percentage incrementally, under Reduce/Enlarge, touch Plus (+) or 
Minus (-). 

− To reduce or enlarge the percentage using the alphanumeric keypad to type a specific value, 
under Reduce/Enlarge, touch the current displayed value. 
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− To reduce or enlarge proportionally, touch Reduce/Enlarge, then touch Proportional %. 
• To reduce or enlarge the percentage incrementally, touch Plus (+) or Minus (-). 
• To reduce or enlarge the percentage using the alphanumeric keypad, touch the current 

displayed value. 
• Presets (X-Y%) allow you to select from a list of preset values. Touch More for additional 

preset values. 
• To center the image on the page, select the Auto Center check box. 

− To reduce or enlarge the width and length of the image by different percentages, touch 
Reduce/Enlarge, then touch Independent %. 
• Width:X% allows you to reduce or enlarge the width of the image incrementally using the 

alphanumeric keypad or the Plus (+) and Minus (-) buttons. 
• Length:Y% allows you to reduce or enlarge the length of the image incrementally using the 

alphanumeric keypad or the Plus (+) and Minus (-) buttons. 
• Presets (Y/X) allow you to select from a list of preset values. Touch More for additional 

preset values. 
• To center the image on the page, select the Auto Center check box. 

3. Touch OK. 
 

Selecting the Paper Tray 

Select a paper tray loaded with the desired paper to make copies on letterhead, colored paper, 
transparencies, or different paper sizes. 

To select the tray to use for copies: 
1. Press the Services Home button, then touch Copy. 
2. Under Paper Supply, touch the desired tray. 
3. If the desired tray is not listed, select another tray: 

a. Touch More for additional options. 
b. Touch the desired tray. 

4. Touch OK. 
 

Selecting 2-Sided Copy Options 

Use the document feeder or the document glass to copy one or both sides of a 2-sided original. 

To select 2-sided copy options: 
1. Press the Services Home button, then touch Copy. 
2. Under 2-Sided Copying, select one of the following: 

− 1->1 Sided scans only one side of the originals and produces 1-sided copies. 
− 1->2 Sided scans only one side of the originals and produces 2-sided copies. To rotate the 

second sides, touch Rotate Side 2. 
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− 2->2 Sided scans both sides of the originals and produces 2-sided copies. To rotate the second 
sides, touch Rotate Side 2. 

− 2->1 Sided scans both sides of the originals and produces 1-sided copies. 
3. Press the green Start button. 

− The document feeder automatically copies both sides of the 2-sided original. 
− A message appears on the control panel when it is time to place the next original on the 

document glass. 
 

Selecting Collated Copies 

You can automatically collate multi-page copy jobs. For example, when making three 1-sided copies of a 
six-page document, the copies are printed in this order: 

1, 2, 3, 4, 5, 6; 1, 2, 3, 4, 5, 6; 1, 2, 3, 4, 5, 6 

To select collated copies: 
1. Press the Services Home button, then touch Copy. 
2. Under Copy Output, touch Collated if it is not already selected. 
 

Selecting Uncollated Copies 

Uncollated copies print in the following order: 

1, 1, 1, 2, 2, 2, 3, 3, 3, 4, 4, 4, 5, 5, 5, 6, 6, 6 

To select uncollated copies: 
1. Press the Services Home button, then touch Copy. 

If your printer has a finisher, under Copy Output, touch More. 
2. Under Collation, touch Uncollated. 
3. Touch OK. 
 

Stapling Copies 

If your printer has a finisher, it can staple your copies. 

To select stapling: 
1. Press the Services Home button, then touch Copy. 
2. Under Copy Output, select an option. 
3. For additional stapling options, touch More. 

a. Under Staple, select an option. 
b. To change the orientation of the page, touch Original Orientation, then select an option. 
c. To change the paper source, touch Paper Supply, then select an option. 
d. To enable the hole punch feature, touch Hole Punch, then select an option. 

4. Touch OK. 
 

 Xerox® WorkCentre® 7970 Multifunction Printer 111 
 User Guide 
 



Copying 

 

Image-Quality Settings 

This section includes: 
• Specifying the Original Type ..................................................................................................................................... 112 
• Adjusting Brightness, Sharpness, and Saturation .............................................................................................. 112 
• Automatically Suppressing Background Variation ............................................................................................ 113 
• Adjusting the Contrast ................................................................................................................................................. 113 
• Selecting Color Effects ................................................................................................................................................. 113 
• Adjusting the Color Balance ...................................................................................................................................... 114 
 

Specifying the Original Type 

The printer optimizes the image quality of the copies based on the type of images in the original 
document and how the original was created. 

To specify the original type: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Image Quality tab, then touch Original Type. 
3. On the Original Type screen, select the appropriate settings: 

− On the left side of the screen, touch the content type of the original document. 
− If known, select how the original was produced. 

4. Touch OK. 
 

Adjusting Brightness, Sharpness, and Saturation 

You can lighten or darken copies and adjust the sharpness and saturation. 

To adjust the image: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Image Quality tab, then touch Image Options. 
3. On the Image Options screen, adjust the sliders up or down as needed: 

− Lighten/Darken lightens or darkens the image. 
− Sharpness sharpens or softens the image. 
− Saturation makes the image colors more vivid or pastel. 

4. Touch OK. 
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Automatically Suppressing Background Variation 

When scanning originals printed on thin paper, text or images printed on one side of the paper can be 
seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the printer to 
variations in light background colors. 

To change this setting: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Image Quality tab, then touch Image Enhancement. 
3. Under Background Suppression, touch Auto Suppression. 
4. Touch OK. 
 

Adjusting the Contrast 

Contrast is the relative difference between light and dark areas in an image. 

To increase or reduce the contrast of the copies: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Image Quality tab, then touch Image Enhancement. 
3. On the Image Enhancement screen, adjust the contrast: 

− Auto Contrast allows the printer to set the contrast automatically. 
− Manual Contrast allows you to adjust the contrast manually. To increase or decrease the 

contrast, move the Manual Contrast slider up or down. The middle position on the slider, 
Normal, does not change the contrast. 

4. Touch OK. 
 

Selecting Color Effects 

If you have a color original, you can adjust the color of the copy using preset color effects. For example, 
you can adjust colors to be brighter or cooler. 

To select a preset color effect: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Image Quality tab, then touch Color Presets. 

Note: This feature is not available when Output Color is set to Black and White. 

3. On the Color Presets screen, touch the desired preset color effect. The sample images show how the 
colors are adjusted. 

4. Touch OK. 
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Adjusting the Color Balance 

If you have a color original, you can adjust the balance of the printing colors between cyan, magenta, 
yellow, and black before printing your copy. 

To adjust the color balance: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Image Quality tab, then touch Color Balance. 

Note: This feature is not available when Output Color is set to Black and White. 

3. To adjust the density levels of all four colors: 
a. On the Color Balance screen, touch Basic Color. 
b. Move the sliders to adjust the level for each color. 

4. To adjust the highlight, midtone, and shadow density levels by color: 
a. On the Color Balance screen, touch Advanced Color. 
b. Touch the color you want to adjust. 
c. Move the sliders to adjust the levels for highlights, midtones, and shadows. 
d. Repeat the previous two steps for additional colors. 

5. Touch OK. 
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Layout Settings 

This section includes: 
• Specifying the Orientation of the Original ........................................................................................................... 115 
• Specifying the Size of the Original .......................................................................................................................... 115 
• Selecting Book Copying ............................................................................................................................................... 116 
• Shifting the Image ........................................................................................................................................................ 116 
• Erasing the Edges of Copies ....................................................................................................................................... 117 
• Inverting the Image ...................................................................................................................................................... 117 
 

Specifying the Orientation of the Original 

If you plan to have the copies automatically stapled, specify the orientation of the original. 
1. Press the Services Home button, then touch Copy. 
2. Touch the Layout Adjustment tab, then touch Original Orientation. 
3. On the Original Orientation screen, touch the desired orientation: 

− Portrait Originals and Landscape Originals refer to the images on the originals. 
− Upright Images and Sideways Images refer to the direction the originals are loaded in the 

document feeder. 

Note: If you are using the document glass, the orientation of the original is as seen before turning it 
over. 

4. Touch OK. 
 

Specifying the Size of the Original 

To scan the correct area of the original, specify the original size. 
1. Press the Services Home button, then touch Copy. 
2. Touch the Layout Adjustment tab, then touch Original Size. 
3. On the Original Size screen, select an option: 

− Auto Detect: This options allows the printer to determine the size of the original. 
− Preset Scan Areas specifies the area to scan when it matches a standard paper size. In the 

scrolling list, touch the desired paper size. 
− Custom Scan Area allows you to specify the height and width of the area to scan. To specify an 

area, touch the Length (Y) and Width (X) arrows. 
− Mixed Size Originals allows you to scan standard-size originals of varying sizes. Use the 

diagram on the screen to determine which original sizes can be mixed in the same job. 
4. Touch OK. 
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Selecting Book Copying 

When copying a book, magazine, or other bound document, you can copy either the left or right page 
onto a single sheet of paper. You can copy both the left and right pages onto two sheets of paper, or as a 
single image on one sheet of paper. 
 

Note: You must use the document glass to make copies from books, magazines, or other bound 
documents. Do not place bound originals in the document feeder. 

To set up book copying: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Layout Adjustment tab, then touch Book Copying. 
3. On the Book Copying screen, select an option: 

− Off copies both pages of an open book as one image on a single sheet of paper. 
− Both Pages copies the left and the right pages of an open book onto two sheets of paper. If 

Binding Edge Erase is required, touch the arrows to erase up to 50.8 mm (2 in.). 
− Left Page Only copies only the left page of an open book on a single sheet of paper. If Binding 

Edge Erase is required, touch the arrows to erase up to 25.4 mm (1 in.). 
− Right Page Only to copy only the right page of an open book on a single sheet of paper. If 

Binding Edge Erase is required, touch the arrows to erase up to 25.4 mm (1 in.) 
4. Touch OK. 
 

Shifting the Image 

You can change the placement of an image on the copy page. This is useful if the image is smaller than 
the page size. Originals must be positioned as follows for image shift to work correctly: 
• Document Feeder: Position originals face up, long edge entering the feeder first. 
• Document Glass: Position originals face down, in the back-left corner of the document glass, long 

edge to the left. 

To change the placement of the image: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Layout Adjustment tab, then touch Image Shift. 
3. On the Image Shift screen, select an option: 

− Auto Center centers the image on the page. 
− Margin Shift allows you to specify the position of the image. To specify the amount of shift for 

Side 1, touch the Up/Down and Left/Right arrows. To specify the amount of shift for Side 2, 
touch the Up/Down and Left/Right arrows, or select Mirror Side 1. 

 

Note: You can use preset values that were previously saved by the system administrator. Touch 
Presets in the lower left corner of the screen, and select a preset from the drop-down menu. 

 

4. Touch OK. 
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Erasing the Edges of Copies 

You can erase content from the edges of your copies by specifying the amount to erase on the right, left, 
top, and bottom edges. 

To erase edges on copies: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Layout Adjustment tab, then touch Edge Erase. 
3. On the Edge Erase screen, select an option: 

− All Edges erases all four edges by the same amount. To specify the amount to erase from the 
edge, touch the All Edges arrows. 

− Individual Edges specifies different amounts for the edges. To specify the amount to erase 
from each edge, touch Side 1, then touch the Left, Right, Top, and Bottom arrows. To specify 
the amount to erase from each edge, touch Side 2, then touch the Left, Right, Top, and 
Bottom arrows, or touch Mirror Side 1. 

 

Note: You can use preset values that were previously saved by the system administrator. Touch 
Presets in the lower left corner of the screen, and select a preset from the drop-down menu. 

 

4. Touch OK. 
 

Inverting the Image 

You can invert your original, as a mirror image or as a negative image. You can use one or both of these 
options. 

To invert the image: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Layout Adjustment tab, then touch Invert Image. 
3. On the Invert Image screen, select an option: 

− Mirror Image reflects each image left to right on the page. 
− Negative Image reverses the black and white values. 

4. Touch OK. 
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Output Format Settings 

This section includes: 
• Creating a Booklet ......................................................................................................................................................... 118 
• Including Covers ............................................................................................................................................................. 119 
• Specifying Chapter Start Pagination ...................................................................................................................... 119 
• Adding Inserts ................................................................................................................................................................. 120 
• Specifying Exception Pages ....................................................................................................................................... 121 
• Adding Annotations ...................................................................................................................................................... 121 
• Adding Transparency Separators ............................................................................................................................ 123 
• Printing Multiple Pages Per Side ............................................................................................................................... 123 
• Repeating an Image ..................................................................................................................................................... 124 
 

Creating a Booklet 

You can print copies in the form of a booklet. The original page images are reduced to print two images 
per side of each printed page. You can then fold and staple the pages manually, or automatically using 
the appropriate finisher. 
 

Note: In this mode, the printer scans all of the originals before printing the copies. 
 

To create a booklet: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Output Format tab, then touch Booklet Creation. 
3. On the Booklet Creation screen, touch On. 
4. To specify 2-sided originals: 

a. Touch Original Input. 
b. Touch 2-Sided Originals. 

5. To select a paper tray: 
a. Touch Paper Supply. 
b. Touch the desired tray. 

6. If your printer has a finisher installed, under Fold and Staple, select a staple or fold option. 
7. Touch OK. 
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Including Covers 

You can print the first and last pages of your copy job on different paper, such as colored or heavyweight 
paper. The printer selects the paper from a different tray. The covers can be blank or printed. 
 

Note: The paper used for the covers must be the same size as the paper used for the rest of the 
document. 

To select the type of covers and the tray to use for the cover paper: 
1. Press the Services Home button, then touch Copy. 
2. Under Paper Supply, touch the tray containing the paper for the body pages of the job. 
3. Touch the Output Format tab, then touch Special Pages. 

Note: If Booklet Creation is turned off or the paper supply is set to Auto Select, Special Pages are 
unavailable. 

4. On the Special Pages screen, touch Covers. 
5. Under Covers Options, select an option: 

− Front & Back Same includes front and back covers from the same tray. 
− Front & Back Different includes a front and a back cover from different trays. 

From the drop-down menus that appear, select options for the front and back covers: 
• Blank Cover inserts a blank cover. 
• Print on Side 1 prints on the front side of the cover. 
• Print on Side 2 prints on the back side of the cover. To rotate the image on side 2 by 

180 degrees, touch Rotate Side 2. 
• Print on Both Sides prints on both sides of the cover. To rotate the image on Side 2 by 

180 degrees, touch Rotate Side 2. 
− Front Only includes only a front cover. 
− Back Only includes only a back cover. 

6. Under Paper Supply, touch the desired tray. 
7. Touch OK. 
 

Specifying Chapter Start Pagination 

If you select 2-sided copies, you can set each chapter to start on the front or back of the page. If 
necessary, the printer leaves one side of the paper blank so that the chapter starts on the specified side of 
the paper. 

To set the start side of particular pages: 
1. Press the Services Home button, then touch Copy. 
2. Under Paper Supply, touch the tray containing the paper for the body pages of the job. 

Note: If the paper supply is set to Auto Select, Chapter Starts is unavailable. 

3. Touch the Output Format tab, then touch Special Pages>Chapter Starts. 
4. On the Chapter Starts screen, touch the Page Number field, then use the alphanumeric keypad to 

enter the page number. 
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5. Under Start Chapter, select an option: 
− On Right Page specifies the front side of the paper. 
− On Left Page specifies the back side of the paper. 

6. Touch Add. That page is added to the list on the right side of the screen. 
7. Repeat the three previous steps to set other pages. 
8. Touch Close. The page settings appear in the list on the right side of the screen. 
9. Touch OK. 
 

Adding Inserts 

You can insert blank pages or pre-printed sheets in specific locations in your copy job. You must specify 
the tray containing the inserts. 
 

Note: The paper used for the inserts must have the same width as the paper used for the rest of the 
document. Inserts cannot be added if Booklet Creation is selected. 

To add inserts: 
1. Press the Services Home button, then touch Copy. 
2. Under Paper Supply, touch the tray containing the paper for the body pages of the job. 

Note: If the paper supply is set to Auto Select, inserts cannot be added. 

3. Touch the Output Format tab, then touch Special Pages>Inserts. 
4. On the Inserts screen, touch the After Page Number field, then use the alphanumeric keypad to 

enter the page number. 
5. To specify the number of sheets to insert at that location, touch the Insert Quantity arrows. 
6. To specify the paper tray to use for the insert: 

a. Touch Paper Supply. 
b. Touch the desired tray. 
c. Touch OK. 

7. Touch Add. The insert appears in the list on the right side of the screen. 
8. Repeat the three previous steps to add additional inserts. 
9. Touch Close. The inserts appear in the list on the right side of the screen. 

Note: To edit or delete an insert, touch the insert in the list, then touch an action in the drop-down 
menu. 

10. Touch OK. 
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Specifying Exception Pages 

You can print exception pages in a copy job using paper from a different tray. The paper used for the 
exception pages must be the same size as the paper used for the rest of the document. 
 

Note: You cannot add exception pages if the paper supply is set to Auto Select, or if Booklet Creation 
is selected. 

To specify the exception pages: 
1. Press the Services Home button, then touch Copy. 

Note: If the paper supply is set to Auto Select, exception pages are unavailable. 

2. Under Paper Supply, touch the tray containing the paper for the body pages of the job. 
3. Touch the Output Format tab, then touch Special Pages>Exceptions. 
4. On the Exceptions screen, touch the beginning Page Number field. Then use the alphanumeric 

keypad to enter the starting value for the range of the exception pages. 
5. Touch the ending Page Number field, then use the alphanumeric keypad to enter the ending value 

for the range of exception pages. 

Note: To specify a single page as an exception, enter its number as the start and end of the range. 

6. To specify the paper used for the exception pages: 
a. Touch Paper Supply. 
b. Touch the tray containing paper for the exception pages. 
c. Touch OK. 

7. Touch Add. The exception pages are added to the list on the right side of the screen. 
8. Repeat the four previous steps to add additional exception pages. 
9. Touch Close. The exception pages appear in the list on the right side of the screen. 

Note: To edit or delete an exception page, touch the page in the list, then touch the desired 
operation in the drop-down menu. 

10. Touch OK. 
 

Adding Annotations 

You can automatically add annotations such as page numbers and the date to your copies. 
 

Notes: 

• Annotations are not added to covers, tabs, inserts, or blank chapter start pages. 
• Annotations cannot be added if Booklet Creation is selected. 

To add annotations: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Output Format tab, then touch Annotations. 
3. To insert page numbers: 

a. On the Annotation screen, touch Page Numbers>On. 
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b. Touch Apply To, then select an option. 
c. Touch the Starting Page Number field, then use the alphanumeric keypad to enter the page 

number. 
d. Touch an arrow to position the page number in the header or footer. The sample page shows 

the location of the page number. 
e. Touch OK. 
f. To change the text formatting, touch Format & Style, choose the desired settings, then touch 

OK. 
4. To insert a comment: 

a. Touch Comment>On. 
b. Touch Apply To, then select an option. 
c. Touch an existing comment in the list. 

Note: To create a comment, touch a blank row, use the touch screen keyboard to type the text, then 
touch OK. 

d. Touch an arrow to position the selected comment in the header or footer. The sample page 
shows the location of the comment. 

e. Touch OK. 
f. To change the text formatting, touch Format & Style, choose the desired settings, then touch 

OK. 
5. To insert the current date: 

a. Touch Date>On. 
b. Touch Apply To, then select an option. 
c. Under Format, select a format for the date. 
d. Touch an arrow to position the date in the header or footer. The sample page shows the 

location of the date. 
e. Touch OK. 
f. To change the text formatting, touch Format & Style, choose the desired settings, then touch 

OK. 
6. To insert a Bates Stamp: 

a. Touch Bates Stamp>On. 
b. Touch the Starting Page Number field, then use the alphanumeric keypad to enter the starting 

page number. Leading zeros can be included. 
c. Touch Apply To, then select an option. 
d. Under Stored Prefixes, touch an existing prefix in the list. 

Note: To create a prefix, touch a blank row, use the touch screen keyboard to type up to eight 
characters, then touch OK. 

e. Under Position, touch an arrow to position the Bates Stamp in the header or footer. The sample 
page shows the location of the Bates Stamp. 

f. Touch OK. 
g. To change the text formatting, touch Format & Style, choose the desired settings, then touch 

OK. 
7. Touch OK. 
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Adding Transparency Separators 

You can add blank sheets of paper between each printed transparency. The size and orientation of the 
separators must be the same as the transparencies. 

Note: Transparency separators cannot be added if the paper supply is set to Auto Select. 
 

To add transparency separators: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Output Format tab, then touch Transparency Separators>On. 
3. Under Separator Supply, touch the tray containing the paper to use for the separators. If the tray 

containing the separator paper is not displayed, touch More, touch the desired tray, then touch OK. 
4. Under Transparency Supply, touch the tray containing the transparencies. If the tray containing the 

transparencies is not displayed, touch More, touch the desired tray, then touch OK. 
5. Touch OK. 
 

Printing Multiple Pages Per Side 

You can copy a single page and have it print multiple times onto one or both sides of the paper. The 
printer reduces the pages proportionally to fit. 

To print multiple original pages on a side: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Output Format tab, then touch Page Layout>Pages per Side. 
3. Touch the number of original pages for each side of the paper. To specify a different number: 

a. Touch Specify Rows & Columns. 
b. Touch the Rows arrows to change the number of rows. 
c. Touch the Columns arrows to change the number of columns. 
d. Select the Rotate check box to rotate the page. 

Note: The right side of the screen contains a diagram of the image layout. 

4. Touch Original Orientation, then Portrait Originals or Landscape Originals. 
5. Touch OK. 
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Repeating an Image 

You can make multiple copies of an original image on one or both sides of the paper. This is useful for 
duplicating a small image. 

To repeat an image on a sheet of paper: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Output Format tab, then touch Page Layout>Repeat Image. 
3. Specify the number of images to print on the page: 

− Preset buttons repeat the image two, four, six, or nine times on each side of the paper. 
− Specify Rows & Columns allows you to determine the number of images. To enter the number 

of rows and columns, touch the Rows or Columns field, then use the alphanumeric keypad or 
touch the arrows. To rotate the paper, select the Rotate check box. 

− Auto Repeat allows the printer to determine the maximum number of images that can fit on 
the currently selected paper size. Touch Original Orientation, and select Upright Images or 
Sideways Images from the drop-down menu. The sample page shows the image layout. 

4. Touch OK. 
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ID Card Copying 

This section includes: 
• Copying an ID Card ....................................................................................................................................................... 125 
• Selecting Color or Black and White Copies ........................................................................................................... 126 
• Reducing or Enlarging the Image ............................................................................................................................ 126 
• Selecting the Paper Tray ............................................................................................................................................. 127 
• Specifying the Original Type ..................................................................................................................................... 127 
• Lightening or Darkening ID Card Copies .............................................................................................................. 127 
• Automatically Suppressing Background Variation ............................................................................................ 128 
 

Copying an ID Card 

You can copy both sides of an ID card or small document onto one side of paper. Each side is copied using 
the same location on the document glass. The printer stores both sides and prints them side by side on 
the paper. 

To copy an ID card: 
1. Press the Services Home button, then touch ID Card Copy. 
2. Touch the ID Card Copy tab. 
3. Verify the output color, paper supply, and reduce/enlarge settings. Change the settings as needed. 
4. Touch the Image Quality tab. 
5. Verify the original type, lighten/darken, and background suppression settings for side 1. Change the 

settings as needed. 
6. Lift the document cover. 
7. Place the ID card, or a document smaller than half the selected paper supply size, in the upper left 

corner of the document glass. 
8. Press the green Start button. 
9. Lift the document cover. 
10. Turn over the document and position it in the upper left corner of the document glass. 
11. Verify the original type, lighten/darken, and background suppression settings for side 2. Change the 

settings as needed. 
12. Press the green Start button. 
13. Lift the document cover and remove the ID card or document. 
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Selecting Color or Black and White Copies 

If the original document contains color, you can create color or black and white copies. 

To select the output color: 
1. Press the Services Home button, then touch ID Card Copy. 
2. Touch the ID Card Copy tab. 
3. Under Output Color, select an option: 

− Auto Detect detects the color content in the original document. If the original is a color 
document, the printer makes copies in full color. If the original is a black and white document, 
the printer makes copies in black only. 

− Black & White copies in black and white only. Colors in the original are converted to shades of 
gray. 

 
 

Reducing or Enlarging the Image 

You can reduce the image to as little as 25% of its original size or enlarge it as much as 400%. 

To reduce or enlarge the image: 
1. Press the Services Home button, then touch ID Card Copy. 
2. Touch the ID Card Copy tab. 
3. Under Reduce/Enlarge, touch an option: 

− To reduce or enlarge the percentage incrementally, touch Plus (+) or Minus (-). 
− To reduce or enlarge the percentage using the alphanumeric keypad to type a specific value, 

touch the current displayed value. 
− To use a preset value, touch the corresponding button. 

4. Touch More for additional options. 
− To reduce or enlarge proportionally, touch Proportional %. 

• To reduce or enlarge the percentage incrementally, touch Plus (+) or Minus (-). 
• To reduce or enlarge the percentage using the alphanumeric keypad, touch the current 

displayed value. 
• Presets (X-Y%) allow you to select from a list of preset values. Touch More for additional 

preset values. 
− To reduce or enlarge the width and length of the image by different percentages, touch 

Independent %. 
• Width:X% allows you to reduce or enlarge the width of the image incrementally using the 

alphanumeric keypad or the Plus (+) and Minus (-) buttons. 
• Length:Y% allows you to reduce or enlarge the length of the image incrementally using the 

alphanumeric keypad or the Plus (+) and Minus (-) buttons. 
• Presets (Y/X) allow you to select from a list of preset values. Touch More for additional 

preset values. 
5. Touch OK. 
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Selecting the Paper Tray 

Select a paper tray loaded with the desired paper to make copies on letterhead, colored paper, 
transparencies, or different paper sizes. 

To select the tray to use for ID card copies: 
1. Press the Services Home button, then touch ID Card Copy. 
2. Touch the ID Card Copy tab. 
3. Under Paper Supply, touch the desired tray. 
4. If the desired tray is not listed, select another tray: 

a. Touch More for additional options. 
b. Touch the desired tray. 
c. Touch OK. 

 

Specifying the Original Type 

The printer optimizes the image quality of the copies based on the type of images in the original 
document and how the original was created. 

To specify the original type: 
1. Press the Services Home button, then touch ID Card Copy. 
2. Touch the Image Quality tab. 
3. Under Original Type, select the appropriate settings: 

− Touch the content type of the original document. 
− If known, select how the original was produced. 

 

Lightening or Darkening ID Card Copies 

You can lighten or darken the copy for each side. Use the slider to lighten or darken the output for the 
first side. After the first side is complete, use the slider again to lighten or darken the second side. Both 
sides of the original are printed side by side, each using different lighten or darken settings. 

To adjust the image: 
1. Press the Services Home button, then touch ID Card Copy. 
2. Touch the Image Quality tab. 
3. To lighten or darken the image for side 1, under Lighten/Darken, adjust the slider up or down. 
4. Lift the document cover. 
5. Place the ID card, or a document smaller than half the selected paper supply size, in the upper left 

corner of the document glass. 
6. Press the green Start button. 
7. Lift the document cover. 
8. Turn over the document and position it in the upper left corner of the document glass. 
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9. To lighten or darken the image for side 2, adjust the slider up or down. 
10. Press the green Start button. 
11. Lift the document cover and remove the ID card or document. 
 

Automatically Suppressing Background Variation 

When scanning originals printed on thin paper, text or images printed on one side of the paper can be 
seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the printer to 
variations in light background colors. 

To change this setting: 
1. Press the Services Home button, then touch ID Card Copy. 
2. Touch the Image Quality tab. 
3. Under Background Suppression, touch Auto Suppression. 
 

128 Xerox® WorkCentre® 7970 Multifunction Printer 
 User Guide 
 



Copying 

 

Advanced Copying 

This section includes: 
• Building a Copy Job ....................................................................................................................................................... 129 
• Printing a Sample Copy ............................................................................................................................................... 130 
• Saving Copy Settings .................................................................................................................................................... 130 
• Retrieving Saved Copy Settings ................................................................................................................................ 130 
 

Building a Copy Job 

Use this feature to produce complex copy jobs that include a variety of originals requiring different copy 
settings. Each segment of the job can have different copy settings. Once all the segments are 
programmed, scanned, and temporarily stored in the printer, the copy job prints. 

To build a copy job with multiple segments: 
1. Press the Services Home button, then touch Copy. 
2. Program and scan the first segment: 

a. Load the originals for the first segment. 
b. Select the required settings, such as layout adjustments, image quality, and options. 
c. Touch the Job Assembly tab, then touch Build Job>On. 
d. Select or clear the Display this window between segments check box. 
e. Touch Options. 
f. Select or clear the Turn Build Job Off after Job is Submitted check box. 
g. Touch OK. 
h. Press the green Start button on the control panel. 

3. Program and scan additional segments: 
a. Load the originals for the next segment. 
b. When the Build Job screen appears, touch Program Next Segment. 
c. Using the appropriate tabs, select the required settings. 
d. Press the green Start button to scan the originals for that segment. 

4. Repeat the previous step for each remaining segment. 
5. Touch the Quantity for Final Job field, then use the alphanumeric keypad to enter the number of 

copies. 
6. In the upper right corner of the Build Job screen, touch Submit Job. 

Note: To cancel the job, touch Delete All Segments. 
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Printing a Sample Copy 

You can print a test copy of a complex copy job, before printing multiple copies. This feature prints a 
single copy and holds the remaining copies. After you inspect the sample, you can print or cancel the 
remaining copies. 
 

Note: The sample copy is not counted as part of the quantity selected. For example, if you select 
three copies, one sample copy prints, and three other copies are held until they are released for 
printing. The result is a total of four copies. 

To print a sample copy of your copy job: 
1. Press the Services Home button, then touch Copy. 
2. Touch the desired copy settings. 
3. Touch the Job Assembly tab, then touch Sample Job>On. 
4. Touch OK. 
5. On the control panel, press the green Start button. The sample copy is printed. 
6. Print the remaining copies or delete the job: 

− To release and print the remaining copies of the job, touch Submit Job. 
− If the sample copy is unsatisfactory, touch Delete All Segments. 

 

Saving Copy Settings 

To use a particular combination of copy settings for future copy jobs, you can save the settings with a 
name and retrieve them for later use. 

To save the current copy settings: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Job Assembly tab, then touch Save Current Settings. 
3. Using the touch screen keyboard, type a name for the saved settings. 
4. Touch OK. 
 

Retrieving Saved Copy Settings 

You can retrieve and use any previously saved copy settings for current jobs. 
 

Note: To save the copy settings with a name, see Saving Copy Settings on page 130. 

To retrieve saved settings: 
1. Press the Services Home button, then touch Copy. 
2. Touch the Job Assembly tab, then touch Retrieve Saved Settings. 
3. Touch the desired saved setting. 
 

Note: To delete a saved setting, touch the setting, then touch Delete Settings. 
 

4. Touch Load Settings. The saved settings are loaded for the current copy job. 
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This chapter includes: 
• Basic Scanning ................................................................................................................................................................ 132 
• Scanning to a Folder ..................................................................................................................................................... 134 
• Scanning to Network File Repositories ................................................................................................................... 137 
• Scanning to Your Home Directory ........................................................................................................................... 139 
• Setting Scan Options .................................................................................................................................................... 140 
• Scanning to a USB Flash Drive .................................................................................................................................. 145 
• Scanning to an Email Address ................................................................................................................................... 146 
• Scanning to a Destination .......................................................................................................................................... 148 

The system administrator must set up this feature before you can use it. For details, see the System 
Administrator Guide at www.xerox.com/office/WC7970docs. 

If the system administrator enables Remote Start in CentreWare Internet Services, you can scan images 
directly from the scanner to a PC. Using Microsoft Clip Organizer, you can scan, import, and store images 
from the printer. You can also scan directly from the printer to a computer using most TWAIN-compliant 
scanning applications. 
 

7 Scanning 
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Basic Scanning 

The Scanning feature provides several methods for scanning and storing an original document. The 
scanning procedure using your printer differs from that of desktop scanners. The printer is connected 
typically to a network rather than a single computer, so you select a destination for the scanned image at 
the printer. 

The printer supports the following scanning functions: 
• Scan documents and store images on the printer hard drive. 
• Scan original documents to a document repository on a network server. 
• Scan original documents to an email address. 
• Scan original documents to your home directory. 
• Scan original documents to a USB Flash drive. 
• Import scanned images into applications using TWAIN and WIA. 

To scan an image: 
1. On the control panel, press the yellow Clear All button to clear previous settings. 
2. Load your original documents: 

− Use the document glass for single pages or paper that cannot be fed using the document 
feeder. Place the first page of the document face down, in the top left corner of the document 
glass. 

− Use the document feeder for multiple or single pages. Remove any staples and paper clips from 
the pages and place them face up in the document feeder. 

3. Press the Services Home button, then touch Workflow Scanning. 
4. Touch the Down arrow, then select the template group from the menu. 
5. Select a template from the list. 
6. To change any of the scan settings, use the options at the bottom of the touch screen: 

− Output Color 
− 2-Sided Scanning 
− Original Type 
− Scan Presets 
For details, see Changing the Basic Scan Settings on page 140. 

7. Press the green Start button. 
 

Notes: 

• The printer must be connected to a network to retrieve a scan file remotely. 
• For details, see the Help in CentreWare Internet Services. 
• Print, copy, and fax jobs can print while you are scanning original documents or downloading files 

from the printer hard drive. 
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Document Glass 

 

• Lift the document feeder cover and place the 
first page face down in the upper left corner of 
the document glass. 

• Align the originals to the matching paper size 
printed on the edge of the glass. 

• The document glass accepts paper sizes up to 
297 x 432 mm (11.7 x 17 in.). 

• The document glass automatically detects 
standard paper sizes. 

 
 

Duplex Automatic Document Feeder 

 

 

Insert originals face up, with page one on top. 
The duplex automatic document feeder scans 
both sides of 2-sided documents at the same 
time. 
• The confirmation indicator illuminates when 

you load the originals correctly. 
• Adjust the paper guides so they fit against 

the originals. 
• The document feeder automatically detects 

standard paper sizes. 
• The automatic document feeder 

accommodates the following original paper 
weights: 38–128 g/m². 

• The automatic document feeder 
accommodates the following originals: 85 x 
125 mm (3.3 x 4.9 in.) through 297 x 432 
mm (11.7 x 17 in.). 

• The automatic document feeder 
accommodates approximately the following 
quantity of paper by weight: 130 sheets of 
80 g/m² paper. 
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Scanning to a Folder 

This section includes: 
• Scanning to the Public Folder .................................................................................................................................... 134 
• Scanning to a Private Folder ...................................................................................................................................... 135 
• Creating a Private Folder............................................................................................................................................. 135 
• Retrieving Scan Files ..................................................................................................................................................... 136 

Scanning to a folder is the simplest scanning method. When you scan an image at the printer, the scan 
file is stored in a folder on the internal hard drive. You then use CentreWare Internet Services to retrieve 
the stored scan file to your computer. 

The default settings create a 1-sided color portable document format (.pdf) file. You can change these 
settings using the printer control panel, or using CentreWare Internet Services at your computer. Control 
panel selections override the settings in CentreWare Internet Services. 
 

Scanning to the Public Folder 

The printer provides a public folder to store scanned images. You do not need a password to scan images 
to the public folder, or to retrieve them. All users can view scanned documents in the public folder. You 
can also create a password-protected private folder. For details, see Creating a Private Folder on page 
135. 

To scan an image to the public folder: 
1. Load the original on the document glass or in the document feeder. 
2. Press the Services Home button, then touch Workflow Scanning. 
3. Touch the Down arrow, then select All Templates from the menu. 
4. From the list, select the Default folder. 
5. To change any of the scan settings, use the options at the bottom of the touch screen. 

For details, see Changing the Basic Scan Settings on page 140. 
6. For more options, touch the Advanced Settings tab. For details, see Selecting Advanced Settings on 

page 140. 
7. Press the green Start button. The Job Progress screen appears, and the original is scanned. The file is 

stored on the printer hard drive. 
8. Use CentreWare Internet Services to move the file to your computer. For details, see Retrieving Scan 

Files on page 136. 
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Scanning to a Private Folder 

The system administrator creates private folders on the printer. Private folders can require a password. 
You can use CentreWare Internet Services to create your own private folders. For details, see Creating a 
Private Folder on page 135. 

To scan to a private folder: 
1. Load the original on the document glass or in the document feeder. 
2. Press the Services Home button, then touch Workflow Scanning. 
3. Touch the Down arrow, then select All Templates from the menu. 
4. From the list, select the private folder. 
5. On the Document Management screen, touch Enter Password for Folder, then use the touch screen 

keyboard to enter the password as needed. 
6. Touch Done. 
7. Touch OK. 
8. Press the green Start button. 
 

Creating a Private Folder 

For you to create a private folder, the scan policy to allow additional folders to be created must be 
enabled. The system administrator can create a private folder at any time. For details on enabling or 
disabling Scan to Mailbox, see the System Administrator Guide for your printer model. 

To create a private folder with a password: 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on 
page 34. 

2. Click the Scan tab. 
3. In the Display section, select Mailboxes. 

Note: If the Display section does not appear, Scan to Mailbox is not enabled. For details, see the 
System Administrator Guide at www.xerox.com/office/WC7970docs. 

4. In the Scan to Mailbox section, click Create Folder. 
5. Click the Folder Name: field, then type a name for the folder. 
6. In the Folder Password field, type a password that adheres to the password rules. 
7. In the Confirm Folder Password field, type the password again. 
8. Click Apply. 

Your private folder appears in the folder list in CentreWare Internet Services and on the printer touch 
screen under Local Templates. The contents are stored on the printer hard drive. 
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Retrieving Scan Files 

To retrieve your scanned images, use CentreWare Internet Services to copy the scan files from the printer 
to your computer. 

To retrieve your scan files: 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 
 

Note: If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on 
page 34. 

 

2. Click the Scan tab. 
3. In the Display section, select Mailboxes. 
4. In the Scan to Mailbox section, click the folder containing the scan. 

Your scan file appears in the Folder Contents window. 
 

Notes: 

• For a password protected private folder, click the Folder Password field, type the password, then 
click OK. 

• If your image file does not appear, click Update View. 
 

5. Under Action, select an option, then click Go. 
− Download saves a copy of the file to your computer. When prompted, click Save, then navigate 

to the location on your computer to save the file. Open the file or close the dialog box. 
− Reprint prints the file without saving a copy of the file to your computer. 
− Delete removes the file from the mailbox. When prompted, click OK to delete the file or Cancel 

to cancel the operation. 
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Scanning to Network File Repositories 

This section includes: 
• Scanning to a Predefined Network File Repository ........................................................................................... 137 
• Adding a Scan Destination ......................................................................................................................................... 138 

When using this feature, the images you scan are sent to a file repository on a network server. The system 
administrator configures the file repository settings. 

Using CentreWare Internet Services, you can add your own scan destinations to templates. 
 

Scanning to a Predefined Network File Repository 

To scan an image and send it to a predefined network file repository: 
1. Load the original on the document glass or in the document feeder. 
2. Press the Services Home button, then touch Workflow Scanning. 
3. Touch the Workflow Scanning tab. 
4. Touch the Down arrow, then select All Templates from the drop-down menu. 
5. From the list, select the template that the system administrator created. The template defines the 

scan settings as well as the destination of the image. 
6. To change any of the scan settings, use the options at the bottom of the touch screen. 

For details, see Changing the Basic Scan Settings on page 140. 
7. Press the green Start button. 
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Adding a Scan Destination 
1. At your computer, open a Web browser, in the address field, type the IP address of the printer, then 

press Enter or Return. 
2. Click the Scan tab. 
3. In the Display area, select Templates. 
4. Under Template Operations, click Create New Template. 
5. In the New Distribution Template area, under Add Destination to Template, click Enter a Scan 

Destination. 
6. Click the Friendly Name: field, then create a name for the template. 
7. Under Protocol, select an option. 
8. Configure the destination IP Address: Port number or Host Name: Port number. 
9. Enter the name of the destination folder as needed. In SMB, the destination folder is the shared 

folder. 
10. In Document Path, enter the name of the sub folder within the destination folder, then select a Filing 

Policy. 
11. Enter a valid login name and password. 

Note: Use the login name for the computer that holds the destination folder. The login name can 
include the domain name also, such as domain name\login name. 

12. Click Add. The template is stored on the printer hard drive. 
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Scanning to Your Home Directory 

The Scan to Home feature allows you to scan an image to your home directory. 

Note: To use the Scan to Home function, you must log in with a valid user name and passcode. For 
details, see Logging In on page 32. 

To scan an image to your home directory: 
1. Load the original on the document glass or in the document feeder. 
2. Press the Services Home button, then touch Workflow Scanning. 
3. Touch the Down arrow, then select Scan to Home Templates from the menu. 
4. From the list, select the template that the system administrator created. 
5. To change any of the scan settings, use the options at the bottom of the touch screen. 

For details, see Changing the Basic Scan Settings on page 140. 
6. For more options, touch the Advanced Settings tab. For details, see Selecting Advanced Settings on 

page 140. 
7. Press the green Start button. 
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Setting Scan Options 

This section includes: 
• Changing the Basic Scan Settings ........................................................................................................................... 140 
• Selecting Advanced Settings ..................................................................................................................................... 140 
• Selecting Layout Adjustments .................................................................................................................................. 142 
• Selecting Filing Options ............................................................................................................................................... 143 
• Building a Scan Job ....................................................................................................................................................... 143 

The scanning features in your printer use templates that define the scan settings and the destination for 
an image. 

Changing the Basic Scan Settings 

To change the basic scan settings: 
1. Press the Services Home button, then touch Workflow Scanning. 
2. Touch Output Color, then select an option: 

− Auto Detect detects the color content in the original image. If the original image is color, the 
printer scans in full color. If the original is a black and white document, the printer scans in black 
only. 

− Black & White scans in black and while only. 
− Grayscale: Detects and scans various shades of gray. 
− Color: Scans in full color. 

3. Touch 2-Sided Scanning, then select an option: 
− 1-Sided scans only one side of the original image and produces 1-sided output files. 
− 2-Sided scans both sides of the original image. 
− 2-Sided, Rotate Side 2 scans both sides of the original image, rotating the second side. 

4. Touch Original Type, then select an option. 

Note: The photo and text options allow you to specify the type of original, such as printed, 
photocopied, photograph, inkjet, or solid ink. 

5. Touch File Name, type a name for the scan file, then touch OK. 
 

Selecting Advanced Settings 

Advanced settings allow you to control image options, image enhancements, scan resolution, file size, 
and updating of templates. 

To select advanced settings: 
1. Press the Services Home button, then touch Workflow Scanning. 
2. Touch the Advanced Settings tab. 
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3. To adjust brightness, sharpness, and saturation: 
a. Touch Image Options. 
b. On the Image Options screen, adjust the sliders as needed: 

• Lighten/Darken lightens or darkens the image. 
• Sharpness sharpens or softens the image. 
• Saturation makes the image colors more vivid or pastel. 

c. Touch OK. 
4. To suppress background variation: 

a. Touch Image Enhancement. 
b. Under Background Suppression, touch Auto Suppression. 
c. Touch OK. 

5. To adjust the contrast: 
a. Touch Image Enhancement. 
b. On the Image Enhancement screen, select an option: 

• Auto Contrast allows the printer to set the contrast automatically. 
• Manual Contrast allows you to adjust the contrast manually. Move the Manual Contrast 

slider up or down to increase or decrease the contrast. The middle position on the slider, 
Normal, does not change the contrast. 

c. Touch OK. 
6. To select scan presets: 

a. Touch Scan Presets. 
b. Select an option. 
c. Touch OK. 

7. To set the resolution: 
a. Touch Resolution. 
b. On the Resolution screen, select a resolution from 72 dpi through 600 dpi. 
c. Touch OK. 

8. To set the quality and file size: 
a. Touch Quality/File Size. 
b. On the Quality/File Size screen, use the slider to select a setting. The settings range from Normal 

Quality and Small File Size to Highest Quality and Largest File Size. 
c. Touch OK. 

9. To retrieve new templates and remove outdated ones: 
a. Touch Update Templates>Update Now. 
b. Touch Update Now. 
c. Touch Close. 
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Selecting Layout Adjustments 

Layout adjustments provide additional settings for the size and orientation of the original, and erasing 
the edges. 

To select layout adjustments: 
1. Press the Services Home button, then touch Workflow Scanning. 
2. Touch the Layout Adjustment tab. 
3. To specify the orientation of the original image: 

a. Touch Original Orientation. 
b. On the Original Orientation screen, select an option: 

• Upright Images and Sideways Images refer to the direction the originals are loaded in the 
document feeder. 

• Portrait Originals and Landscape Originals refer to the images on the originals. 
c. Touch OK. 

4. To scan the correct area of the original image: 
a. Touch Original Size. 
b. On the Original Size screen, select an option: 

• Auto Detect: This options allows the printer to determine the size of the original. 
• Preset Scan Areas specifies the area to scan when it matches a standard paper size. In the 

scrolling list, touch the desired paper size. 
• Custom Scan Area allows you to specify the height and width of the area to scan. Touch 

the Height-Y and Width-X arrows to specify the area. 
• Mixed Size Originals allows you to scan standard-size originals of varying sizes. Use the 

diagram on the screen to determine which original sizes can be mixed in the same job. 
c. Touch OK. 

5. To specify the amount to erase from the edges of your image: 
a. Touch Edge Erase. 
b. On the Edge Erase screen, select an option: 

• All Edges erases all four edges by the same amount. Touch the All Edges arrows to specify 
the amount to erase from the edges. 

• Individual Edges specifies different amounts for the edges. Touch Side 1, then use the 
arrows to specify the amount to erase from each edge. Touch Side 2, then use the arrows 
to specify the amount to erase from each edge, or touch Mirror Side 1. 

c. Touch OK. 
6. To manage how the scanner treats blank pages: 

a. Touch Blank Page Management. 
b. Select an option: 

• Include Blank Pages includes scanned pages that are blank. 
• Remove Blank Pages omits scanned pages that are blank. 

c. Touch OK. 
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Selecting Filing Options 

Filing Options provide additional settings for naming images, selecting image formats, and selecting 
behavior when a file name exists. 

To select filing options: 
1. Press the Services Home button, then touch Workflow Scanning. 
2. Touch the Filing Options tab. 
3. To select a file format: 

a. Touch File Format. 
b. On the File Format screen, under Format, select an option. 
c. Under Options, for PDF, PDF/A, XPS, or TIFF, select an option: 

• Multi-page creates a multi-page document from the scanned images. 
• 1 File Per Page creates a separate file for each page scanned. 

d. Under Options, for PDF, PDF/A, or XPS, select an option: 
• Image Only creates an unsearchable image of the scanned document. 
• Searchable creates a searchable document of the scanned pages. 

e. For the searchable option, select a language from the drop-down menu. 
f. Touch OK. 

4. To select the action to take if a file already exists: 
a. Touch If File Already Exists. 
b. On the If File Already Exists screen, select an option. 
c. Touch OK. 

5. To define additional network locations as destinations for scanned documents: 
a. Touch Add File Destinations. 
b. On the Add File Destinations screen, touch the desired destinations. 
c. Touch OK. 

Note: Document Management and Add File Destinations can be modified only after scanning to 
network file repositories or scanning to home are set up. For details, see the System Administrator 
Guide at www.xerox.com/office/WC7970docs. 

 

Building a Scan Job 

Use this feature to combine an assorted group of originals for assembly into a single scan job. 

To build a scan job: 
1. Press the Services Home button, then touch Workflow Scanning. 
2. Touch the Job Assembly tab, then touch Build Job>On. 
3. Touch Options. 

a. Select or clear the Display this window between segments check box. 
b. Select or clear the Turn Build Job Off after Job is Submitted check box. 
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4. Program and scan the first segment: 
a. Load the originals for the first segment. 
b. Press the green Start button on the control panel. 

Note: If a password is required, contact the system administrator. 

5. Program and scan additional segments: 
a. Load the originals for the next segment. 
b. When the Build Job screen appears, touch Program Next Segment. 
c. Press the green Start button to scan the originals for that segment. 

6. Repeat the previous step for each remaining segment. 

Note: At any time, you can touch Delete All Segments to modify the job. 

7. When all of the segments have been programmed and scanned, touch Submit the Job. The Job 
Progress screen appears, and the individual segments are scanned as a single job. 

Note: If necessary, touch Delete>Delete Job to cancel the job. 
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Scanning to a USB Flash Drive 

1. Load the original on the document glass or in the document feeder. 
2. Insert your USB Flash drive in the USB port on the printer control panel. 

Note: If the USB Flash drive is already in the USB memory port, press Services Home, then touch 
Workflow Scanning>Scan to USB. 

3. On the USB Drive Detected screen, touch Scan to USB. 
4. To change any of the scan settings, use the options at the bottom of the touch screen. 

For details, see Changing the Basic Scan Settings on page 140. 
5. Press the green Start button. 

The Job Progress screen appears, and the original is scanned. The file is stored on your USB Flash 
drive. 

6. Remove your USB Flash drive from the printer. 
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Scanning to an Email Address 

This section includes: 
• Sending a Scanned Image to an Email Address ................................................................................................ 146 
• Setting Email Options ................................................................................................................................................... 147 

When using this feature, the images you scan are sent as email attachments. 
 

Sending a Scanned Image to an Email Address 

Before scanning to email, configure the email SMTP and From Field properties. You must have at least 
one email address in the address book. If email properties are not properly configured, the Email icon 
appears grayed out on the touch screen. 

To scan an image and send it to an email address: 
1. Load the original on the document glass or in the document feeder. 
2. Press the Services Home button, then touch Email. 
3. To enter an email address: 

a. Touch New Recipient. 
b. Touch the Down arrow, then select To: or Cc: or Bcc: from the menu. 
c. Touch the Enter email address and select Add field, then use the touch screen keyboard to 

type the email address. 
d. Touch Add. 
e. Use the touch screen keyboard to type additional email addresses. 
f. When you are finished, touch Close. 

4. To enter an email address from the network address book: 
a. Touch Address Book. 
b. Use the touch screen keyboard to type part of the name, then touch Search. 
c. Select the desired name from the list, then touch Add. 
d. Touch Close. 

5. To add a subject line: 
a. Touch Subject, then use the touch screen keyboard to type the desired text. 

Note: To modify the default subject, highlight the text in the text field, then touch X to delete it, or 
type over the existing text. 

b. Touch OK. 
6. To change any of the scan settings, use the options at the bottom of the touch screen. 

For details, see Changing the Basic Scan Settings on page 140. 
7. Press the green Start button. 
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Setting Email Options 

You can change the following email settings: 
• File Name 
• File Format 
• Message 
• Reply To 

To change the email options: 
1. Load the original on the document glass or in the document feeder. 
2. Press the Services Home button, then touch Email. 
3. To change any of the scan settings, use the options at the bottom of the touch screen. 

For details, see Changing the Basic Scan Settings on page 140. 
4. Touch the Email Options tab. 
5. Change the file name. 
6. Touch File Name. 

a. On the File Name screen, use the touch screen keyboard to delete or modify the default text. 
b. Touch Save. 

7. Change the file format and options: 
a. Touch File Format. 
b. On the File Format screen, under Format, select an option. 
c. Under Options, for PDF, PDF/A, XPS, or TIFF, select an option: 

• Multi-page creates a multi-page document from the scanned images. 
• 1 File Per Page creates a separate file for each page scanned. 

d. Under Options, for PDF, PDF/A, or XPS, select an option: 
• Image Only creates an unsearchable image of the scanned document. 
• Searchable creates a searchable document of the scanned pages. 

e. For the searchable option, select a language from the drop-down menu. 
f. Touch OK. 

8. Change the message: 
a. Touch Message. 
b. On the Message screen, use the touch screen keyboard to type a message to appear with the 

images. 
c. Touch OK. 

9. Change the Reply To address: 
a. Touch Reply To. 
b. On the Reply To screen, use the touch screen keyboard to type an email address. 
c. Touch OK. 

10. Press the green Start button. 
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Scanning to a Destination 

This section includes: 
• Sending a Scanned Image to a Destination ........................................................................................................ 148 

Use Scan to Destination to send scanned images to a remote destination, such as an FTP server or a 
personal computer. 
 

Sending a Scanned Image to a Destination 

Before scanning to a destination, configure the destination folders on the server or share the folder on a 
personal computer. In addition, you must have at least one Scan To Destination in the address book. If 
Scan To Destination properties are not properly configured, the Scan To icon appears grayed out on the 
touch screen. 

To scan an image and send it to a destination: 
1. Load the original on the document glass or in the document feeder. 
2. Press the Services Home button, then touch Scan To. 
3. On the Device Address Book page, select Scan Contacts or Scan Favorites. 

Note:If the Device Address Book does not appear, press the Clear All button and start over. 

4. In the Names list, touch a destination, then touch Add to Recipients. 
5. Repeat steps 3 and 4 for each destination as needed. 
6. Touch OK. 
7. To change any of the scan settings, use the options at the bottom of the touch screen. 

For details, see Changing the Basic Scan Settings on page 140. 
8. Press the green Start button. 

The Job Progress screen appears, and the original is scanned. The file is stored as a file at the 
destination. 
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This chapter includes: 
• Basic Faxing ..................................................................................................................................................................... 150 
• Sending an Embedded Fax ........................................................................................................................................ 152 
• Sending a Server Fax .................................................................................................................................................... 162 
• Sending an Internet Fax.............................................................................................................................................. 166 
• Sending a LAN Fax ........................................................................................................................................................ 172 
• Using the Address Book ............................................................................................................................................... 173 

The system administrator must set up this feature before you can use it. For details, see the System 
Administrator Guide at www.xerox.com/office/WC7970docs. 
 

8 Faxing 
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Basic Faxing 

You can send a fax in one of four ways: 
• Fax, or embedded fax, scans the document and sends it directly to a fax machine. 
• Server Fax scans the document and sends it to a fax server, which transmits the document to a fax 

machine. 
• Internet Fax scans the document and emails it to a recipient. 
• LAN Fax sends the current print job as a fax. For details, see the print driver software. 

To send a fax: 
1. Load your original documents: 

− Use the document glass for single pages or paper that cannot be fed using the document 
feeder. Place the first page of the document face down, in the top left corner of the document 
glass. 

− Use the document feeder for multiple or single pages. Remove any staples and paper clips from 
the pages and place them face up in the document feeder. 

2. Press the Services Home button, then touch the appropriate fax. 
3. Address the fax using one or more of the available options: 

− The Enter Number and Press Add field allows you to enter a fax number manually. Use the 
alphanumeric keypad to enter the number, then touch Add. 

− Dialing Characters allows you to insert characters such as a Dial Pause in a fax number. Use the 
touch screen keypad to enter the numerals and characters, then touch Save. 

Note: One or more dialing pauses can be required between the access number for an outside line and 
the fax number. When inserted, the dial pauses appear as commas in the fax number. 

− Favorites allows you to access selected favorite individual or group contacts from the address 
book. 

− Address Book allows you to access the printer address book. 
4. On the Fax tab, adjust the available fax options as needed. 
5. Adjust additional fax options as needed. For details, see Selecting Fax Options on page 154, 

Selecting Server Fax Options on page 163, or Selecting Internet Fax Options on page 168. 
6. Press the green Start button. The printer scans the pages and transmits the document when all 

pages have been scanned. 
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Document Glass 

 

• Lift the document feeder cover and place the 
first page face down in the upper left corner of 
the document glass. 

• Align the originals to the matching paper size 
printed on the edge of the glass. 

• The document glass accepts paper sizes up to 
297 x 432 mm (11.7 x 17 in.). 

• The document glass automatically detects 
standard paper sizes. 

 
 

Duplex Automatic Document Feeder 

 

 

Insert originals face up, with page one on top. 
The duplex automatic document feeder scans 
both sides of 2-sided documents at the same 
time. 
• The confirmation indicator illuminates when 

you load the originals correctly. 
• Adjust the paper guides so they fit against 

the originals. 
• The document feeder automatically detects 

standard paper sizes. 
• The automatic document feeder 

accommodates the following original paper 
weights: 38–128 g/m². 

• The automatic document feeder 
accommodates the following originals: 85 x 
125 mm (3.3 x 4.9 in.) through 297 x 432 
mm (11.7 x 17 in.). 

• The automatic document feeder 
accommodates approximately the following 
quantity of paper by weight: 130 sheets of 
80 g/m² paper. 
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Sending an Embedded Fax 

1. Load the original document in the document feeder or on the document glass. 
2. Press the Services Home button, then touch Fax. 
3. To address the fax, touch one or more options: 

− The Enter Number and Press Add field allows you to enter a fax number manually. Use the 
alphanumeric keypad to enter the number, then touch Add. 

− Dialing Characters allows you to insert characters such as a dial pause in a fax number. Use the 
touch screen keypad to enter the numerals and characters, then touch Add. Add more numbers, 
or touch Close. 

Note: One or more dialing pauses can be required between the access number for an outside line and 
the fax number. When inserted, the dial pauses appear as commas in the fax number. 

− Favorites allows you to access selected favorite individual or group contacts from the address 
book. 

− Address Book allows you to select fax numbers from your Address Book. Touch the Down arrow, 
then select Individual or Group from the drop-down menu. Touch the Up or Down arrows to 
scroll through the list, touch the desired contact, then select Add to Recipients from the 
drop-down menu. Select and add more contacts, or touch Close. 

4. To include a cover sheet: 
a. Touch Cover Sheet>On. 
b. Touch the To field, use the touch screen keyboard to type the name of the recipient, then touch 

Save. 
c. Touch the From field, use the touch screen keyboard to type the name of the sender, then touch 

Save. 
d. To add a comment, do one of the following: 

• Touch an existing comment, then touch Save. 
• Touch an <Available> comment, touch Edit, use the touch screen keyboard to type the 

text, then touch Save. 
 

Notes: 

• To delete an existing comment, touch the comment, then touch Clear. Touch Clear to confirm the 
action. 

• To edit an existing comment, touch the comment, then touch Edit. Use the touch screen keyboard 
to change the comment, then touch Save. 

 

5. Touch 2-sided Scanning and select an option. 
6. Touch Original Type and select an option. 
7. Touch Resolution and select an option. 
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8. Select more options as needed. For details, see Selecting Fax Options on page 154. 
9. Press the green Start button. The printer scans the pages and transmits the document when all 

pages have been scanned. 

Note: To pause the job, press the Stop button. On the touch screen, touch Resume Scanning to 
continue the job, or Cancel Scanning to cancel the job completely. If you do not make a selection 
within 60 seconds, the job automatically resumes. 
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Selecting Fax Options 

This section includes: 
• Adjusting Brightness and Sharpness ...................................................................................................................... 154 
• Automatically Suppressing Background Variation ............................................................................................ 155 
• Adjusting the Contrast ................................................................................................................................................. 155 
• Specifying the Size of the Original .......................................................................................................................... 155 
• Selecting Reducing or Splitting ................................................................................................................................. 156 
• Setting Up Book Faxing ............................................................................................................................................... 156 
• Printing a Confirmation Report ................................................................................................................................ 156 
• Selecting the Starting Rate ........................................................................................................................................ 157 
• Sending a Delayed Fax ................................................................................................................................................ 157 
• Sending Header Text .................................................................................................................................................... 157 
• Sending a Fax to a Remote Mailbox ....................................................................................................................... 158 
• Storing a Fax in a Local Mailbox .............................................................................................................................. 158 
• Printing Local Mailbox Documents.......................................................................................................................... 158 
• Deleting Local Mailbox Documents ........................................................................................................................ 159 
• Storing a Fax for Local or Remote Polling............................................................................................................. 159 
• Printing or Deleting Secure Faxes ............................................................................................................................ 160 
• Polling a Remote Fax .................................................................................................................................................... 160 
• Building a Fax Job .......................................................................................................................................................... 161 
 

Adjusting Brightness and Sharpness 

You can lighten or darken the image, and adjust the sharpness. 

To adjust the image: 
1. Press the Services Home button, then touch Fax. 
2. Touch the Image Quality tab, then touch Image Options. 
3. On the Image Options screen, adjust the sliders as needed: 

− Lighten/Darken lightens or darkens the image. 
− Sharpness sharpens or softens the image. 

4. Touch OK. 
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Automatically Suppressing Background Variation 

When scanning originals printed on thin paper, text or images printed on one side of the paper can be 
seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the printer to 
variations in light background colors. 

To select Auto Suppression: 
1. Press the Services Home button, then touch Fax. 
2. Touch the Image Quality tab, then touch Image Enhancement. 
3. Under Background Suppression, touch Auto Suppression. 
4. Touch OK. 
 

Adjusting the Contrast 

Contrast is the relative difference between light and dark areas in an image. 

To adjust the contrast: 
1. Press the Services Home button, then touch Fax. 
2. Touch the Image Quality tab, then touch Image Enhancement. 
3. On the Image Enhancement screen, select an option: 

− Manual Contrast allows you to adjust the contrast manually. Under Manual Contrast, move the 
slider up or down to increase or decrease the contrast. The middle position on the slider, Normal, 
does not change the contrast. 

− Auto Contrast allows the printer to set the contrast automatically. 
4. Touch OK. 
 

Specifying the Size of the Original 

To ensure that you are scanning the correct area of the documents, specify the original size. 

To specify the original size: 
1. Press the Services Home button, then touch Fax. 
2. Touch the Layout Adjustment tab, then touch Original Size. 
3. On the Original Size screen, select an option: 

− Auto Detect: This options allows the printer to determine the size of the original. 
− Preset Scan Areas specifies the area to scan when it matches a standard paper size. In the 

scrolling list, touch the desired paper size. 
− Custom Scan Area allows you to specify the height and width of the area to scan. To specify an 

area, touch the Length (Y) and Width (X) arrows. 
− Mixed Size Originals allows you to scan standard-size originals of varying sizes. Use the 

diagram on the screen to determine which original sizes can be mixed in the same job. 
4. Touch OK. 
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Selecting Reducing or Splitting 

You can determine the method to use for handling images that are too large. 

To select reducing or splitting: 
1. Press the Services Home button, then touch Fax. 
2. Touch the Layout Adjustment tab, then touch Reduce/Split. 
3. Touch an option: 

− Reduce to Fit shrinks large documents to fit on smaller paper. 
− Split Across Pages continues a single image across several pages. 

4. Touch OK. 
 

Setting Up Book Faxing 

You can determine the method used for scanning images in a book. 

To select book faxing: 
1. Press the Services Home button, then touch Fax. 
2. Touch the Layout Adjustment tab, then touch Book Faxing. 
3. Touch an option: 

− Off is the default setting. 
− Both Pages scans both pages of the book. 
− Left Page Only scans the left page of the book. 
− Right Page Only scans the right page of the book. 

4. To set the amount to erase, touch the Binding Edge Erase arrows as needed. 
5. Touch OK. 
 

Printing a Confirmation Report 

You can print a report that confirms when your faxes are sent or received. The report contains 
information on timeouts, busy signals, and retry failures. 

To set up a confirmation report printing: 
1. Press the Services Home button, then touch Fax. 
2. Touch the Fax Options tab, then touch Confirmation Report. 
3. Touch an option: 

− Always Print generates a report for all fax jobs. 
− Print on Error Only generates a report only for fax jobs that fail to send. 

4. Touch OK. 
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Selecting the Starting Rate 

Select the highest starting rate unless the destination for the fax you are sending has special 
requirements. 

To select the transmission speed for a fax: 
1. Press the Services Home button, then touch Fax. 
2. Touch the Fax Options tab, then touch Starting Rate. 
3. Touch an option. 
4. Touch OK. 

Note: Some telephone networks can require you to set the fax starting rate to Forced (4800 bps). 
The slower data rate ensures a more reliable transmission of data. 

 

Sending a Delayed Fax 

You can set a time in the future for the printer to send your fax job. The delay can range from 15 minutes 
through 24 hours. 

Note: Before using this feature, set the printer to the current time. 

To specify the time to send your fax: 
1. Press the Services Home button, then touch Fax. 
2. Touch the Fax Options tab, then touch Delay Send. 
3. Touch Specified Time. 

− Touch the Hour field, then touch the arrows to set a number. 
− Touch the Minute field, then touch the arrows to set a number. 
− If your printer is set to display the 12-hour clock, touch AM or PM. 

4. Touch OK. 
The fax is sent at the specified time. 

 

Sending Header Text 

The system administrator must set up this feature before you can use it. For details, see the System 
Administrator Guide at www.xerox.com/office/WC7970docs. 

To include the fax header text: 
1. Press the Services Home button, then touch Fax. 
2. Touch the Fax Options tab, then touch Send Header Text. 
3. Touch an option. 
4. Touch OK. 
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Sending a Fax to a Remote Mailbox 
1. Press the Services Home button, then touch Server Fax. 
2. Touch the Fax Options tab, then touch Mailboxes. 
3. Touch Send to Remote Mailbox. 
4. To address the fax, select an option: 

− The Fax Number field allows you to enter a fax number. Use the alphanumeric keypad to enter 
the number, then touch Add. 

− Dialing Characters allows you to insert characters such as a Dial Pause in a fax number. Use the 
touch screen keypad to enter the numerals and characters, then touch Save. 

5. Touch the Mailbox Number field, then use the alphanumeric keypad to enter the mailbox number. 
6. Touch the Mailbox Passcode field, then use the alphanumeric keypad to enter the four-digit mailbox 

passcode. 
7. Touch OK. 
 

Storing a Fax in a Local Mailbox 

The system administrator must create a mailbox before you can use this feature. For details, see the 
System Administrator Guide at www.xerox.com/office/WC7970docs. 

To store a fax in a local mailbox: 
1. Press the Services Home button, then touch Fax. 
2. Touch the Fax Options tab, then touch Mailboxes. 
3. Touch Store to Local Mailbox. 
4. Touch the Mailbox Number field, then use the alphanumeric keypad to enter the mailbox number. 
5. Touch the Mailbox Passcode field, then use the alphanumeric keypad to enter the four-digit mailbox 

passcode. 
6. Touch OK. 
 

Printing Local Mailbox Documents 

To use this feature, you must have documents stored in a mailbox. For details, see Storing a Fax in a Local 
Mailbox on page 158. 

To print local mailbox documents: 
1. Press the Services Home button, then touch Fax. 
2. Touch the Fax Options tab, then touch Mailboxes. 
3. Touch Print Local Mailbox Documents. 
4. Touch the Mailbox Number field, then use the alphanumeric keypad to enter the mailbox number. 
5. Touch the Mailbox Passcode field, then use the alphanumeric keypad to enter the four-digit mailbox 

passcode. 
6. Touch Print All Documents. The documents in the mailbox are printed. 
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Deleting Local Mailbox Documents 
1. Press the Services Home button, then touch Fax. 
2. Touch the Fax Options tab, then touch Mailboxes. 
3. Touch Delete Local Mailbox Documents. 
4. Touch the Mailbox Number field, then use the alphanumeric keypad to enter the mailbox number. 
5. Touch the Mailbox Passcode field, then use the alphanumeric keypad to enter the four-digit mailbox 

passcode. 
6. Touch Delete All Documents. 
7. To confirm, touch Delete All. All documents in the mailbox are deleted. 
 

Storing a Fax for Local or Remote Polling 

Turn on Secure or Non-Secure Local Polling to make fax documents stored on one printer available for 
remote polling by other printers. When Secure Local Polling is on, you create a list of fax numbers that are 
allowed to access the stored faxes on the printer. 

To store a fax: 
1. Press the Services Home button, then touch Fax. 
2. Touch the Fax Options tab, then touch Local Polling. 
3. Under Store for Local Polling, touch one of the following options: 

− Non-Secure Polling scans your originals and stores them as documents. Anyone with this fax 
number can access the documents. 

− Secure Polling scans your originals and stores them as documents. You specify the fax numbers 
that can access the documents. 

4. For secure polling, touch one or more of the following to add fax numbers to the access list: 
− Fax Number field allows you to enter a fax number manually. Use the alphanumeric keyboard 

to enter the number, and touch Add. 
− Address Book allows you to add individual stored fax numbers to the list. Select a fax number, 

and select Add to Recipients from the drop-down menu. Touch Close. 
− The Allow all Address Book fax numbers access check box adds all stored fax numbers to the 

list. 
 

Note: To modify existing entries in the access list, touch the entry, then select Edit, Remove, or 
Remove All from the drop-down menu. 

 

5. Touch Save. 
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Printing or Deleting Secure Faxes 
1. Press the Services Home button, then touch Fax. 
2. Touch the Fax Options tab, then touch Local Polling. 
3. Under Store for Local Polling, touch an option: 

− Print All Stored Documents prints all stored fax documents. 
− Delete All Stored Documents deletes all stored fax documents. To confirm the action, touch 

Delete All. 
 

Polling a Remote Fax 

If remote polling is turned on, you can retrieve documents that were stored using local polling on another 
fax machine. 
 

Note: If Local Polling is turned on, Remote Polling is not available. To turn off Local Polling, touch 
Local Polling>Off>Save. 

 

To poll a remote fax: 
1. Press the Services Home button, then touch Fax. 
2. Touch the Fax Options tab, then touch Remote Polling. 
3. Under Poll, touch Remote Fax. 
4. To address the fax, select one or more options: 

− The Enter Number and Press Add field allows you to enter a fax number manually. Use the 
alphanumeric keypad to enter the number, then touch + (Add). 

− Dialing Characters allows you to insert characters such as a Dial Pause in a fax number. Use the 
touch screen keypad to enter the numerals and characters, then touch Close. 

5. To set a time for the printer to retrieve faxes from other fax machines, do the following: 
a. Touch Delay Poll. 
b. To set the time, touch Delay Poll. 

• Touch the Hour field, then touch the arrows to set a number. 
• Touch the Minute field, then touch the arrows to set a number. 
• If your printer is set to display the 12-hour clock, touch AM or PM. 

c. Touch OK. 
6. To retrieve and print the faxes, touch Poll Now. 

Note: To cancel, touch Close. 
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Building a Fax Job 

Use this feature to fax an assorted group of originals, each with different settings. Each segment is 
programmed and scanned, and the images are stored temporarily in the printer. Once all segments have 
been stored, the individual segments are faxed as a single job. 

To build a fax job: 
1. Press the Services Home button, then touch the appropriate fax. 
2. Address the fax using one or more of the available options: 

− The Enter Number and Press Add field allows you to enter a fax number manually. Use the 
alphanumeric keypad to enter the number, then touch Add. 

− Dialing Characters allows you to insert characters such as a Dial Pause in a fax number. Use the 
touch screen keypad to enter the numerals and characters, then touch Save. 

− Address Book allows you to access the printer address book. 
− Favorites allows you to access selected favorite individual or group contacts from the address 

book. 
3. Touch the Job Assembly tab, then touch Build Job>On. 
4. Touch Options. 

a. Select or clear the Display this window between segments check box. 
b. Select or clear the Turn Build Job Off after Job is Submitted check box. 

5. Program and scan the first segment: 
a. Load the originals for the first segment. 
b. Select the required settings, such as layout adjustments, image quality, and options. 
c. Press the green Start button on the control panel. 

6. Program and scan additional segments: 
a. Load the originals for the next segment. 
b. When the Build Job screen appears, touch Program Next Segment. 
c. Using the appropriate tabs, select the required settings. 
d. Press the green Start button to scan the originals for that segment. 

7. Repeat the previous step for each remaining segment. 

Note: At any time, you can touch Delete Last Segment or Delete All Segments to modify the job. 

8. When all of the segments have been programmed and scanned, touch Submit the Job. The Job 
Progress screen appears, and the individual segments are faxed as a single job. 

9. On the Job Progress screen, touch Job Details to view a summary of the job. 

Note: If necessary, touch Delete>Delete Job to cancel the job. 
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Sending a Server Fax 

If a fax server is connected to the network, you can send a document to a fax machine without requiring 
a dedicated telephone line. 

When using the server fax, a document is scanned and sent to a fax repository on the network. The fax 
server then sends the fax over a telephone line to a fax machine. 

The system administrator must enable the server fax service and configure a fax repository, or filing 
location, before you can use this feature. 

To send a server fax: 
1. Load the original on the document glass or in the duplex automatic document feeder. 
2. Press the Services Home button, then touch Server Fax. 
3. To address the fax, touch one or more options: 

− The Enter Number and Press Add field allows you to enter a fax number manually. Use the 
alphanumeric keypad to enter the number, then touch Add. 

− Dialing Characters allows you to insert characters such as a dial pause in a fax number. Use the 
touch screen keypad to enter the numerals and characters, then touch Add. Add more numbers, 
or touch Close. 

− Fax Directory allows you to select fax numbers from your Fax Directory. Touch the Up or Down 
arrows to scroll through the list, touch the desired contact, then select Add to Recipients from 
the drop-down menu. Select and add more contacts, or touch Close. 

4. Touch 2-sided Scanning and select an option. 
5. Touch Original Type and select an option. 
6. Touch Resolution and select an option. 
7. Select more options as needed. For details, see Selecting Server Fax Options on page 163. 
8. Press the green Start button. The printer scans the pages and transmits the document when all 

pages have been scanned. 
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Selecting Server Fax Options 

This section includes: 
• Adjusting Brightness ..................................................................................................................................................... 163 
• Automatically Suppressing Background Variation ............................................................................................ 163 
• Adjusting the Contrast ................................................................................................................................................. 164 
• Specifying the Orientation of the Original ........................................................................................................... 164 
• Specifying the Size of the Original .......................................................................................................................... 164 
• Sending a Delayed Fax ................................................................................................................................................ 165 
• Building a Fax Job .......................................................................................................................................................... 165 
 

Adjusting Brightness 

You can lighten or darken the image. 

To adjust the image: 
1. Press the Services Home button, then touch Server Fax. 
2. Touch the Image Quality tab, then touch Image Options. 
3. On the Image Options screen, adjust the Lighten/Darken slider up or down as needed. 
4. Touch OK. 
 

Automatically Suppressing Background Variation 

When scanning originals printed on thin paper, text or images printed on one side of the paper can be 
seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the printer to 
variations in light background colors. 

To select Auto Suppression: 
1. Press the Services Home button, then touch Server Fax. 
2. Touch the Image Quality tab, then touch Image Enhancement. 
3. Under Background Suppression, touch Auto Suppression. 
4. Touch OK. 
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Adjusting the Contrast 

Contrast is the relative difference between light and dark areas in an image. 

To adjust the contrast: 
1. Press the Services Home button, then touch Server Fax. 
2. Touch the Image Quality tab, then touch Image Enhancement. 
3. On the Image Enhancement screen, select an option: 

− Manual Contrast allows you to adjust the contrast manually. Under Manual Contrast, move the 
slider up or down to increase or decrease the contrast. The middle position on the slider, Normal, 
does not change the contrast. 

− Auto Contrast allows the printer to set the contrast automatically. 
4. Touch OK. 
 

Specifying the Orientation of the Original 
1. Touch the Layout Adjustment tab, then touch Original Orientation. 
2. On the Original Orientation screen, touch the desired orientation: 

− Upright Images and Sideways Images refer to the direction the originals are loaded in the 
document feeder. 

− Portrait Originals and Landscape Originals refer to the images on the originals. 

Note: If you are using the document glass, the orientation of the original is as seen before turning it 
over. 

3. Touch OK. 
 

Specifying the Size of the Original 

To ensure that you are scanning the correct area of the documents, specify the original size. 

To specify the original size: 
1. Press the Services Home button, then touch Server Fax. 
2. Touch the Layout Adjustment tab, then touch Original Size. 
3. On the Original Size screen, select an option: 

− Auto Detect: This options allows the printer to determine the size of the original. 
− Preset Scan Areas specifies the area to scan when it matches a standard paper size. In the 

scrolling list, touch the desired paper size. 
− Custom Scan Area allows you to specify the height and width of the area to scan. To specify an 

area, touch the Length (Y) and Width (X)arrows. 
− Mixed Size Originals allows you to scan standard-size originals of varying sizes. Use the 

diagram on the screen to determine which original sizes can be mixed in the same job. 
4. Touch OK. 
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Sending a Delayed Fax 

You can set a time in the future for the printer to send your fax job. The delay can range from 15 minutes 
through 24 hours. 

Note: Before using this feature, set the printer to the current time. 

To specify the time to send your fax: 
1. Press the Services Home button, then touch Server Fax. 
2. Touch the Fax Options tab, then touch Delay Send. 
3. Touch Specified Time. 

a. Touch the Hour field, then touch the arrows to set a number. 
b. Touch the Minute field, then touch the arrows to set a number. 
c. If your printer is set to display the 12-hour clock, touch AM or PM. 

4. Touch OK. 
The fax is sent at the specified time. 

 

Building a Fax Job 

For details, see Building a Fax Job on page 161. 
 

 Xerox® WorkCentre® 7970 Multifunction Printer 165 
 User Guide 
 



Faxing 

 

Sending an Internet Fax 

If an SMTP (email) server is connected to the network, a document can be sent to an email address. This 
feature eliminates the need for a dedicated telephone line and the associated service costs. When 
sending an Internet Fax, the document is scanned and sent to an email address. 

To send an Internet fax: 
1. Load the original on the document glass or in the document feeder. 
2. Touch the Services Home button, then touch Internet Fax. 
3. Address the fax: 

a. Touch New Recipient. 
b. Touch the Down arrow, then select To: or Cc: from the menu. 
c. Touch the Enter email address and select Add field, then use the touch screen keyboard to 

type the email address. 
d. Touch Add. 
e. Use the touch screen keyboard to type additional email addresses. 
f. When you are finished, touch Close. 

4. To add a subject line: 
a. Touch Subject, then use the touch screen keyboard to type the desired text. 

Note: To modify the default subject that appears, touch X to clear the field. 

b. Touch OK. 
5. Adjust the Internet fax options as needed: 

a. Touch Output Color and select from the drop-down menu: 
• Auto Detect 
• Black & White 
• Grayscale 
• Color 

b. Touch 2-sided Scanning and select from the drop-down menu: 
• 1-Sided 
• 2-Sided 
• 2-Sided, Rotate Side 2 

c. Touch Original Type and select from the drop-down menu: 
• Photo & Text 
• Photo 
• Text 
• Map 
• Newspaper/Magazine 
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6. Adjust fax options as needed. 
7. Press the green Start button. The printer scans the pages and sends the document as an email 

attachment in .pdf or .tiff file format, when all pages have been scanned. 
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Selecting Internet Fax Options 

This section includes: 
• Adjusting Brightness and Sharpness ...................................................................................................................... 168 
• Automatically Suppressing Background Variation ............................................................................................ 168 
• Adjusting the Contrast ................................................................................................................................................. 169 
• Setting the Resolution .................................................................................................................................................. 169 
• Setting the Quality and File Size .............................................................................................................................. 169 
• Specifying the Orientation of the Original ........................................................................................................... 170 
• Specifying the Size of the Original .......................................................................................................................... 170 
• Adding a Message ......................................................................................................................................................... 170 
• Specifying a Reply To Address .................................................................................................................................. 170 
• Printing an Acknowledgment Report ...................................................................................................................... 171 
• Building a Fax Job .......................................................................................................................................................... 171 
 

Adjusting Brightness and Sharpness 

You can lighten or darken the image, and adjust the sharpness. 

To adjust the image: 
1. Touch the Services Home button, then touch Internet Fax. 
2. Touch the Advanced Settings tab, then touch Image Options. 
3. On the Image Options screen, adjust the sliders as needed: 

− Lighten/Darken lightens or darkens the image. 
− Sharpness sharpens or softens the image. 

4. Touch OK. 
 

Automatically Suppressing Background Variation 

When scanning originals printed on thin paper, text or images printed on one side of the paper can be 
seen on the other side. Use the Auto Suppression setting to reduce the sensitivity of the printer to 
variations in light background colors. 

To select Auto Suppression: 
1. Touch the Services Home button, then touch Internet Fax. 
2. Touch the Advanced Settings tab, then touch Image Enhancement. 
3. Under Background Suppression, touch Auto Suppression. 
4. Touch OK. 
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Adjusting the Contrast 

Contrast is the relative difference between light and dark areas in an image. 

To adjust the contrast: 
1. Touch the Services Home button, then touch Internet Fax. 
2. Touch the Advanced Settings tab, then touch Image Enhancement. 
3. On the Image Enhancement screen, adjust the contrast: 

− Manual Contrast allows you to adjust the contrast manually. Move the slider up or down to 
increase or decrease the contrast. The middle position on the slider, Normal, does not change 
the contrast. 

− Auto Contrast allows the printer to set the contrast automatically. 
4. Touch OK. 
 

Setting the Resolution 
1. Touch the Services Home button, then touch Internet Fax. 
2. Touch the Advanced Settings tab, then touch Resolution. 
3. On the Resolution screen, touch the desired resolution. 

− 72 dpi produces acceptable image quality for onscreen viewing, and the smallest file size. 
− 100 dpi produces good image quality for onscreen viewing, and small file size. 
− 150 dpi produces good image quality for onscreen viewing, and small file size. 
− 200 x 100 dpi produces good image quality, and moderate file size. 
− 200 dpi produces good image quality, and moderate file size. This setting is the default. 
− 300 dpi produces high image quality, and large file size. 
− 400 dpi produces higher image quality, and larger file size. 
− 600 dpi produces the highest image quality, and the largest file size. 

4. Touch OK. 

Note: Check with the system administrator to determine the largest file size that the email system 
allows. 

 

Setting the Quality and File Size 

The Quality/File Size option lets you choose from three settings that balance the quality of the image and 
the size of the file. Higher quality images result in larger file sizes, which are not ideal for sharing and 
transmitting over the network. 

To set the Internet fax quality and file size: 
1. Touch the Services Home button, then touch Internet Fax. 
2. Touch the Advanced Settings tab, then touch Quality/File Size. 
3. On the Quality/File Size screen, use the slider to select a setting. The settings range from Normal 

Quality and Small File Size to Highest Quality and Largest File Size. 
4. Touch OK. 
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Specifying the Orientation of the Original 
1. Touch the Services Home button, then touch Internet Fax. 
2. Touch the Layout Adjustment tab, then touch Original Orientation. 
3. On the Original Orientation screen, touch the desired orientation: 

− Upright Images and Sideways Images refer to the direction the originals are loaded in the 
document feeder. 

− Portrait Originals and Landscape Originals refer to the images on the originals. 

Note: If you are using the document glass, the orientation of the original is as seen before turning it 
over. 

4. Touch OK. 
 

Specifying the Size of the Original 

To ensure that you are scanning the correct area of the documents, specify the original size. 

To specify the original size: 
1. Touch the Services Home button, then touch Internet Fax. 
2. Touch the Layout Adjustment tab, then touch Original Size. 
3. On the Original Size screen, select an option: 

− Auto Detect: This options allows the printer to determine the size of the original. 
− Preset Scan Areas specifies the area to scan when it matches a standard paper size. In the 

scrolling list, touch the desired paper size. 
− Custom Scan Area allows you to specify the height and width of the area to scan. To specify an 

area, touch the Length (Y) and Width (X)arrows. 
− Mixed Size Originals allows you to scan standard-size originals of varying sizes. Use the 

diagram on the screen to determine which original sizes can be mixed in the same job. 
4. Touch OK. 
 

Adding a Message 
1. Touch the Services Home button, then touch Internet Fax. 
2. Touch the Internet Fax Options tab, then touch Message. 
3. Type a message using the touch screen keyboard. 
4. Touch OK. 
 

Specifying a Reply To Address 
1. Touch the Services Home button, then touch Internet Fax. 
2. Touch the Internet Fax Options tab, then touch Reply To. 
3. Type an email address using the touch screen keyboard. 
4. Touch OK. 
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Printing an Acknowledgment Report 

If the status of each recipient is known, you can print a delivery status report. The printer waits for a 
delivery receipt from each recipient, then prints the report. 
 

Note: The report could be delayed depending on the response time of the recipients. 
 

To print an acknowledgment report: 
1. Touch the Services Home button, then touch Internet Fax. 
2. Touch the Internet Fax Options tab, then touch Acknowledgment Report. 
3. Touch Print Report. 
4. Touch OK. 
 

Building a Fax Job 

For details, see Building a Fax Job on page 161. 
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Sending a LAN Fax 

Local Area Network (LAN) Fax allows you to send faxes from the print driver on your computer to a fax 
machine over a telephone line. The Fax window allows you to enter recipients, create a cover page with 
notes, and set options. Using the options you can select confirmation sheets, send speed, fax resolution, 
send time, and fax dialing options. 

Notes: 

• When the Fax job type is selected, some features, such as Edge Enhancement, Thin Line 
Enhancement, and Black Enhancement, are turned off. 

• Not all printer models support this feature. 

To send a LAN fax: 
1. With the desired document or graphic open in your application, open the Print dialog box. For most 

software applications, click File>Print or press CTRL+P. 
2. Select your printer, then click Properties to open the print driver dialog box. 
3. On the Paper/Output tab, from the Job Type list, select Fax. 
4. Click Recipients. 
5. Do one or more of the following: 

− Click the Phonebook button, select a phone book from the list, select a name from the upper list, 
then add it to the Fax Recipients. Repeat the procedure to add more names. Click OK. 

− Click the Add Recipients button, type the recipient name and fax number, add other 
information, then click OK. Add new recipients as needed. 

6. To include a cover sheet, click Cover Sheet, then from the Cover Sheet Options list, select Print a 
Cover Sheet. 

7. On the Cover Sheet information tab, type notes that you want to appear on the cover sheet. 
8. On the Options tab, select the options for this fax. 
9. Click OK. 
10. In the Printer Properties window, click OK. 
11. In the Print window, click OK. 
12. To confirm the recipients, click OK. 
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Using the Address Book 

This section includes: 
• Adding an Individual Entry to the Device Address Book ................................................................................ 173 
• Editing an Individual Address Book Entry ............................................................................................................. 174 
• Editing or Deleting Favorites in the Device Address Book .............................................................................. 175 
• Printing a Fax Report .................................................................................................................................................... 175 
 

Adding an Individual Entry to the Device Address Book 

The Device Address Book can contain up to 5000 contacts. If the Add button is unavailable, the address 
book has reached its limit. 

Before you can use this feature, the system administrator must enable Create/Edit Contact from Touch 
Screen for All Users. 

To add a recipient to the Device Address Book: 
1. Press the Services Home button, then touch Email. 
2. Touch New Recipient. 
3. Touch the Enter email address and select Add field, then use the touch screen keyboard to type the 

email address. 
4. At the end of the address field, touch the Add to Address Book icon. 

− To add the recipient to the address book, touch Create New Contact. 
− To add the new recipient information to an existing address book contact, touch Add to 

Existing Contact. 
5. To add name and company information for the new entry, to the right of the contact field, touch the 

i button. 
a. Enter a name into the First Name, Last Name, or Company field, then touch OK. 

Note: The first entry into one of the fields becomes the display name for the contact information. 

b. Enter names into the remaining fields, then touch OK after each entry. 
6. At the Additional Contact Information page, touch OK. 
7. To enter a fax number for the contact, to the right of the green fax icon, touch the field. 
8. Touch Enter Fax Number, use the alphanumeric keypad to enter the number, then touch OK. 
9. To enter an Internet fax number for the contact, to the right of the blue Internet Fax icon, touch the 

field. Touch Enter Internet Fax Number, use the alphanumeric keypad to enter the number, then 
touch OK. 

10. To mark a contact as a favorite, to the right of the global address book, email, fax, or Internet fax 
fields, touch the corresponding star. 

11. To save the contact to the Device Address Book, touch OK. 
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To add a recipient to the Device Address Book using the Fax feature: 
1. Press the Services Home button, then touch Fax. 
2. Touch the Enter Fax Number field. 

− To add the recipient to the address book, touch Create New Contact. 
− To add the new recipient information to an existing address book contact, touch Add to 

Existing Contact. 
3. To add name and company information for the new entry, to the right of the contact field, touch the 

i button. 
a. Enter a name into the First Name, Last Name, or Company field, then touch OK. 

Note: The first entry into one of the fields becomes the display name for the contact information. 

b. Enter names into the remaining fields, then touch OK after each entry. 
c. At the Additional Contact Information page, touch OK. 

4. To add an email contact for the recipient, touch the field to the right of the email icon. 
a. Touch Enter Email Address. 
b. Enter a valid email address. 
c. Touch OK. 

5. To enter an Internet fax number for the contact, to the right of the blue Internet Fax icon, touch the 
field. Touch Enter Internet Fax Number, use the alphanumeric keypad to enter the number, then 
touch OK. 

6. To mark a contact as a favorite, to the right of the global address book, email, fax, or Internet fax 
fields, touch the corresponding star. 

7. To save the contact to the Device Address Book, touch OK. 
 

Editing an Individual Address Book Entry 
1. Press the Services Home button, then touch Email. 
2. Touch Address Book. 
3. Under Names, touch a contact name. 
4. Touch Details. 
5. To change the display name of the contact, touch the i button, edit the information in the fields, 

then touch OK. 
6. To enter or change a fax number for the contact, to the right of the green fax icon, touch the field. 
7. Touch Enter Fax Number, use the alphanumeric keypad to enter the number, then touch OK. 
8. To enter an Internet fax number for the contact, to the right of the blue Internet Fax icon, touch the 

field. Touch Enter Internet Fax Number, use the alphanumeric keypad to enter the number, then 
touch OK. 

9. To mark a contact as a favorite, to the right of the global address book, email, fax, or Internet fax 
fields, touch the corresponding star. 

10. To save the contact to the Device Address Book, touch OK. 
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Editing or Deleting Favorites in the Device Address Book 
1. Press the Services Home button, then touch Fax. 
2. Touch Address Book. 
3. Touch the Down arrow, then touch Contacts or All Contacts. 
4. Touch the desired entry, using the scroll arrows as needed. 
5. Touch Details. 
6. To mark a contact as a favorite, to the right of the global address book, email, fax, or Internet fax 

fields, touch the corresponding star. 
7. To delete a favorite, to the right of the global address book, fax, or Internet fax field, touch the 

corresponding orange star. 
8. Touch OK. 
9. To return to the main menu, press the Services Menu button. 
 

Printing a Fax Report 

You can print the following fax reports from the printer control panel: 
• Activity Report 
• Protocol Report 
• Fax Address Book Report 
• Options Report 
• Pending Jobs Report 

To print a fax report: 
1. At the printer control panel, press the Machine Status button, then touch the Tools tab. 
2. Touch Service Settings>Embedded Fax Settings. 
3. Touch Print Fax Reports, then touch the arrows to scroll if needed. 
4. Touch the desired report, then touch Print Now. 
5. Touch Close, then log out. 
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General Precautions 
 

 CAUTION: When cleaning your printer do not use organic or strong chemical solvents or aerosol 
cleaners. Do not pour fluids directly into any area. Use supplies and cleaning materials only as directed 
in this documentation. 

  

 WARNING: Keep all cleaning materials out of the reach of children. 
  

 WARNING: Do not use pressurized spray cleaning aids on or in the printer. Some pressurized sprays 
contain explosive mixtures and are not suitable for use in electrical applications. Use of pressurized 
spray cleaners increases the risk of fire and explosion. 

  

 WARNING: Do not remove the covers or guards that are fastened with screws. You cannot maintain 
or service any parts that are behind these covers and guards. Do not attempt any maintenance 
procedure that is not described in the documentation supplied with your printer. 

  

 WARNING: Internal parts of the printer can be hot. Use caution when doors and covers are open. 
 

• Do not place anything on top of the printer. 
• Do not leave the covers and doors open for any length of time, especially in well-lit places. Light 

exposure can damage the imaging units. 
• Do not open covers and doors during printing. 
• Do not tilt the printer while it is in use. 
• Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print 

quality to deteriorate. 
• Ensure any parts removed during cleaning are replaced before you plug in the printer. 
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Cleaning the Printer 

This section includes: 
• Cleaning the Document Glass and Document Cover ....................................................................................... 179 
• Cleaning the Document Feed Rollers ..................................................................................................................... 180 
• Cleaning the Second-Side Scanning Lens Assembly ......................................................................................... 181 
• Cleaning the Printer Exterior ...................................................................................................................................... 183 
• Cleaning the Printer Interior ...................................................................................................................................... 184 
 

Cleaning the Document Glass and Document Cover 

To ensure optimum print quality, clean the document glass regularly. Cleaning helps avoid output with 
streaks, smears, and other marks that transfer from the glass while scanning documents. 
1. Use a lint-free cloth lightly dampened with Xerox® Lens/mirror Cleaner or another suitable 

non-abrasive glass cleaner. Clean the document glass and the CVT glass to its left. 
 

  
 

2. Use a lint-free cloth and Xerox® Cleaning Fluid to clean the underside of the document cover and the 
document feeder. 
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Cleaning the Document Feed Rollers 

Dirt on the document feed rollers can cause paper jams or deteriorate print quality. For best performance, 
clean the document feed rollers once a month. 
1. Lift the lever and open the top cover of the document feeder. 

 
2. While turning the rollers, wipe them with a clean, lint-free cloth moistened with water. 
 

 CAUTION: Do not use alcohol or chemical cleaners on the document feed rollers. 
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Cleaning the Second-Side Scanning Lens Assembly 

The second-side scanning lens assembly allows you to make 2-sided scans and copies with a single pass of 
the original. The assembly is on the left side of the document cover and includes a mirrored glass strip, a 
metal strip, a white-plastic strip, and rollers. 

Note: Xerox recommends that you clean all parts of the second-side scanning lens assembly 
regularly. 

To clean the second-side scanning lens assembly: 
1. To access the second-side scanning lens assembly, lower the lever under the left side of the 

document cover. 

 
2. To separate the left end of the document cover from the lens assembly, continue to lower the lever. 
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3. Using a soft cloth moistened with water, wipe the mirrored glass, metal strip, both sides of the 
white-plastic strip, and the rollers. If dirt is difficult to remove, moisten a soft cloth with a small 
amount of neutral detergent. Then wipe them dry with a soft cloth. 

 

 CAUTION: To prevent damage to the film around the glass, do not press heavily on the mirrored 
glass. 

 

 
4. Return the document cover to its original position, ensuring the lever is locked in place. If you touch 

the document cover with your bare hands, clean the cover before closing the document feeder. 
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Cleaning the Printer Exterior 

Regular cleaning keeps the touch screen and control panel free from dust and dirt. 

To clean the printer exterior: 
1. To avoid activating buttons and menus, press the Energy Saver button. 

 
2. To remove fingerprints and smudges, clean the touch screen and control panel with a soft, lint-free 

cloth. 

 
3. To return the printer to Ready mode, press the Energy Saver button. 
4. Use a soft, lint-free cloth to clean the outside of the output tray, paper trays, and other exterior areas 

of your printer. 
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Cleaning the Printer Interior 

Cleaning the Printhead Lenses 

The printer is constructed with four printhead lenses. Clean all lenses as described in the following 
procedure. 
 

 CAUTION: Do not perform this procedure when the printer is copying or printing. 
 

1. Open the front cover of the printer. 

 
2. Turn the orange lever to the left. 

 
3. Pull the drum cartridge cover down until it clicks into the open position. 
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4. Each of the four printheads has its own cleaning tool. Slowly pull the printhead lens cleaner out until 
the three dots are visible. 

 

Note: The printhead lens cleaner does not detach from the printer. 

 
5. Slowly push the printhead lens cleaner back into the printhead until it stops. 

 
6. Repeat Steps 4 and 5 for each printhead. 
7. Close the drum cartridge cover. 

 
8. Turn the orange lever to the right to return it to the locked position. 

 
9. Close the printer front cover. 
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Routine Maintenance 

This section includes: 
• Replacing the Toner Cartridges ................................................................................................................................ 186 
• Replacing the Waste Toner Container ................................................................................................................... 189 
• Replacing the Drum Cartridges................................................................................................................................. 190 
• Replacing the Transfer Belt Cleaner ....................................................................................................................... 193 
• Replacing the Second Bias Transfer Roller ........................................................................................................... 197 
• Resetting Supply Life Counters ................................................................................................................................. 199 
• Replacing Staple Cartridges ....................................................................................................................................... 200 
• Emptying the Hole Punch Waste Container ........................................................................................................ 203 
 

Replacing the Toner Cartridges 

A message appears on the control panel when a toner cartridge must be replaced. 
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 CAUTION: Do not perform this procedure when the printer is copying or printing. 
 

1. Open the front cover of the printer. 

 
2. Place your fingers under the lip of the toner cartridge, then pull the toner cartridge straight out of the 

printer. 

 

 
3. Remove the new toner cartridge from the packaging. Tilt the cartridge up and down, then left and 

right 10 times. 
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4. Hold the new toner cartridge with the arrow facing up, then push the cartridge in slowly until it stops. 

 
5. Push gently on the toner cartridge to ensure that it is seated. 

 
6. Close the printer front cover. 
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Replacing the Waste Toner Container 

A message appears on the control panel when the waste toner container must be replaced. 

When replacing the waste toner container, clean the printhead lenses. For details, see Cleaning the 
Printhead Lenses on page 184. 
 

 CAUTION: Spread paper on the floor to catch possible toner spills. 
  

 WARNING: If you spill any toner in the printer, wipe it up using a moist cloth. Never use a vacuum 
cleaner to remove spilled toner. Sparks inside the vacuum cleaner can cause a fire or explosion. 

 
 

 WARNING: If you accidentally get toner on your clothes, lightly dust them off as best as you can. If 
some toner remains on your clothes, use cool water, not hot, to rinse off the toner. If toner gets on 
your skin, wash it off with cool water and a mild soap. If you get toner in your eyes, wash it out 
immediately with cool water and consult a doctor. 

  

 CAUTION: Do not perform this procedure when the printer is copying or printing. 
 

1. Open the front cover of the printer. 

 
2. Remove the new waste toner container from the packaging. Retain the packaging. 
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3. Pull the used waste toner container out slowly while supporting it with your other hand. 

 
4. Place the used waste toner container in the plastic bag, then seal it firmly using the zipper. 

 
5. Place the used waste toner container in the empty box. 

 
6. Hold the left side of the new waste toner container and slide it into the printer until it clicks. 

 
7. Clean the printhead lenses. For details, see Cleaning the Printhead Lenses on page 184. 
8. Close the front cover. 
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Replacing the Drum Cartridges 

A message appears on the control panel when a drum cartridge must be replaced. 
 

 CAUTION: Do not expose the drum cartridge to direct sunlight or strong indoor fluorescent lighting. 
Do not touch or scratch the surface of the drum. 

  

 CAUTION: Do not perform this procedure when the printer is copying or printing. 
 

1. Open the front cover of the printer. 

 
2. Grip the orange handle of the drum cartridge as shown and pull the drum cartridge straight out of 

the printer. Place the used drum cartridge in the plastic bag and place in the box. 
 

 WARNING: Do not touch any toner adhering to the drum cartridge. 
  

Note: If you want to return used supplies for recycling, follow the instructions included with the new 
supplies. If the instructions or shipping label are not available, for more information, go to 
www.xerox.com/gwafor more information. 
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3. Remove the packing material from the end of the new drum cartridge. 
4. Rest the new cartridge, along with its black plastic protective shield, in the cartridge slot. Make sure 

to load the cartridge in the direction of the arrow on the top of the shield. 

 
5. While keeping the guides inserted in the slot, remove the black paper sheet by pulling it in the 

direction shown. 
6. Remove the tape from the top of the cartridge shield. 
7. Hold the shield and push the cartridge into the printer using the orange handle. 

 
8. Continue pushing the orange handle until it stops. 
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9. Carefully remove the protective shield. 
10. Push the drum cartridge until it stops. 

 
11. Close the drum cartridge cover. 

 
12. Turn the orange lever to the right to return it to the locked position. 

 
13. Close the printer front cover. 
14. Dispose of the protective shield and tape as normal office waste. 
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Replacing the Transfer Belt Cleaner 

A message appears on the control panel when the transfer belt cleaner must be replaced. 
 

 CAUTION: Do not perform this procedure when the printer is copying or printing. 
 

1. Open the front cover of the printer. 

 
2. Turn the orange lever to the right to unlock the belt cleaner. 

 
3. Turn the orange knob counterclockwise until it releases. 
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4. Pull the transfer belt cleaner straight out of the printer. 
 

 WARNING: Do not touch any toner adhering to the transfer belt cleaner. Do not tilt the transfer belt 
cleaner or toner could spill. 

 
5. Remove the new transfer belt cleaner from the packaging. Retain the packaging. 
6. Place the used transfer belt cleaner in the plastic bag. 

 
7. Remove the protective cover from the new transfer belt cleaner. 
 

 CAUTION: Do not touch the surface of the transfer belt cleaner. Doing so could deteriorate image 
quality. 
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8. Support the new transfer belt cleaner with your left hand and slide it straight into the opening until it 
stops. 

 
9. Push the orange knob in, then turn it clockwise until snug. 

 
10. Turn the orange lever to the left to lock the belt cleaner. 

 
11. Close the printer front cover. 
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Replacing the Second Bias Transfer Roller 
1. A message appears on the control panel when the second bias transfer roller must be replaced. 

Remove paper from the left tray, then fold up the tray. 

 
2. Open tray 5 (bypass) as shown (1). 
3. While lifting up the release lever (2), open the top left cover A as shown (3). 

 
 

 WARNING: The area around the fuser can be hot. Use caution to avoid injury. 
  

 CAUTION: Do not touch the transfer belt. Touching the belt can reduce image quality or damage the 
transfer belt. Do not touch the transfer roller. Touching the roller can reduce image quality. 
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4. Remove the new transfer roller from the packaging. Retain the packaging. 
5. Push the orange lever in the direction shown. 

 
6. Lift the used transfer roller out of the printer. 

Note: Do not touch any toner adhering to the transfer roller. 

 
7. Place the used transfer roller in the plastic bag. 
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8. Place the new transfer roller in the printer as shown. Press down until the transfer roller clicks into 
place. 

 
9. Remove the protective cover from the transfer roller. 

 
10. Close cover A. 
 

Resetting Supply Life Counters 

You must reset the supply life counters when you replace some supplies. 

Note: To access this feature at the control panel, log in as an administrator. 

1. Press the Log In/Out button, enter the system administrator login information, then press Enter. 
2. On the control panel, press Machine Status. 
3. Touch the Tools tab, then touch Troubleshooting. 
4. Touch Supply Counter Reset. 
5. Touch the desired supply item, then touch Reset Counter. 
6. On the confirmation screen, touch Reset. 
7. Touch Close. 
8. Press the Log In/Out button, then touch Logout. 
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Replacing Staple Cartridges 

This section includes: 
• Replacing Staples in the Main Stapler of the Business Ready Finisher ..................................................... 200 
• Replacing Staples in the Booklet Maker of the Business Ready Finisher .................................................. 202 

A message appears on the control panel when a staple cartridge is empty. 
 

Replacing Staples in the Main Stapler of the Business Ready Finisher 
1. Open the front door of the Business Ready finisher. 

 
2. Hold the stapler assembly by the orange lever R1 and push it to the right. 
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3. Grip the staple cartridge by the orange handle and pull it firmly toward you to remove it. 

 
4. Pinch both sides of the staple case (1) and remove the staple case from the cartridge (2). 

 
5. Insert the front side of the new staple case into the staple cartridge (1), then push the rear side into 

the cartridge (2). 
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Replacing Staples in the Booklet Maker of the Business Ready Finisher 
1. Open the front door of the Business Ready finisher. 

 
2. Grasp the booklet maker handle and pull the unit toward you until the staple cartridges appear on 

the top edge of the device. 

 
3. To remove the staple cartridge from the booklet maker, push down on the staple cartridge handle, as 

shown, then pull the cartridge out and up. 
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4. Turn the staple cartridge over. 
5. To permit the staple cartridge handle to open out and away from the staple case, press in the green 

tabs, then pull back the handle. 

 
6. To remove the staple case, press the rear of the case as shown. 

 
7. Replace the staple case, then return the staple cartridge to the booklet maker. 
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Emptying the Hole Punch Waste Container 

A message appears on the control panel when the hole punch waste container is full. 
 

Emptying the Hole Punch Waste Container in the Business Ready Finisher 
 

 WARNING: Do not perform this procedure while the printer is copying or printing. 
 

1. Open the front door of the Business Ready finisher. 

 
2. Remove the hole punch waste container from its slot near the top left of the finisher. 

Notes: 

− When you remove the hole punch waste container, wait 10 seconds before you reinsert it into 
the printer. The hole punch counter resets after 10 seconds. 

− If you remove the hole punch waste container before the device instructs you to, empty the 
container before you reinsert it into the finisher. 
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3. Empty the container. 

 
4. Insert the container all the way into the finisher. 

 
5. Close the front door of the Business Ready finisher. 
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Billing and Usage Information 

Billing and printer usage information appears on the Billing Information screen. The impression counts 
shown are used for billing. 

To view Billing and Usage information: 
1. At the printer control panel, press the Machine Status button. 
2. To view basic impression counts, touch the Billing Information tab: 

− Black Impressions: Total number of pages printed with no color specified. 
− Color Impressions: Total number of pages printed that specify color. 
− Total Impressions: Total number of color impressions plus black impressions. 

3. To view detailed usage information, touch Usage Counters, then select an option. 
4. To return to the Services Home menu, press the Services Home button. 
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Ordering Supplies 

This section includes: 
• Locating the Serial Number ....................................................................................................................................... 207 
• Consumables ................................................................................................................................................................... 207 
• Routine Maintenance Items ...................................................................................................................................... 207 
• Other Supplies ................................................................................................................................................................. 208 
• When to Order Supplies ............................................................................................................................................... 208 
• Viewing Printer Supply Status ................................................................................................................................... 208 
• Recycling Supplies .......................................................................................................................................................... 208 
 

Locating the Serial Number 

To contact Xerox for assistance, you need the printer serial number. The serial number is behind door A, 
toward the rear of the printer on a metal plate. 

To view the serial number at the printer control panel, press the Machine Status button, then touch the 
Machine Information tab. 
 

Consumables 

Consumables are printer supplies that get depleted during the operation of the printer. Consumable 
supplies for this printer are the Genuine Xerox® Toner Cartridges in Cyan, Magenta, Yellow, and Black. 
 

Note: Each consumable includes installation instructions. 
  

 CAUTION: Use of toner other than Genuine Xerox® Toner can affect print quality and printer 
reliability. It is the only toner designed and manufactured under strict quality controls by Xerox for 
specific use with this printer. 

 
 

Routine Maintenance Items 

Routine maintenance items for this printer include the following: 
• Cyan, Magenta, Yellow, and Black Drum Cartridges 
• Waste Container 
• Second Bias Transfer Roller 
• Transfer Belt Cleaner 

Note: Each routine maintenance item includes installation instructions. 
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Other Supplies 

Other supplies are items required for options on certain printer configurations or accessories but are not 
required for daily use. 

Other supplies for this printer include the following items:  
• Staple cartridge for the Business Ready finisher 
• Staple cartridge for the Business Ready Booklet Maker finisher 
• Staple refills for the Business Ready finisher 
• Staple refills for the Business Ready Booklet Maker finisher 
 

When to Order Supplies 

A warning appears on the control panel when supplies near their replacement time. Verify that you have 
replacements on hand. It is important to order these items when the messages first appear to avoid 
interruptions to your printing. An error message appears on the control panel when supplies must be 
replaced. 

Order supplies from your local reseller or go to www.xerox.com/office/WC7970supplies. 
 

 CAUTION: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreement, 
and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance 
caused by use of non-Xerox supplies, or the use of Xerox supplies not specified for this printer. The 
Total Satisfaction Guarantee is available in the United States and Canada. Coverage could vary 
outside these areas. Please contact your Xerox representative for details. 

 
 

Viewing Printer Supply Status 

You can check the status of printer supplies at any time. 
1. To view basic information about toner cartridges, press the Machine Status button, then touch the 

Supplies tab. 
2. To view details about a specific cartridge, including the part number for reordering, touch Cyan, 

Magenta, Yellow, or Black. 
3. To return to the Supplies tab, touch Close. 
4. To view more details, touch Other Supplies. Scroll through the list, then select an option. 
5. To print the Supplies Usage page, touch Print Supplies Report. 
6. To return to the other supplies screen, touch Close. 
7. To return to the main screen, press the Services Home button. 
 

Recycling Supplies 

For information on Xerox® supplies recycling programs, go to www.xerox.com/gwa. 

Supplies include a prepaid return label. Please use it to return used components in their original boxes for 
recycling. 
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Moving the Printer 

• Always turn off the printer and wait for the printer to shut down. To turn off the printer, verify that 
there are no jobs in the queue, then turn off the secondary power switch first. Wait 10 seconds after 
the touch screen goes dark, then turn off the main power switch. For details, see Turning the Printer 
On and Off on page 39. 

• Disconnect the power cord from the back of the printer. 
• Keep the printer level to avoid spilling toner. 

Note: When moving the printer over a long distance, remove the drum cartridges and toner 
cartridges to prevent toner from spilling. Pack the printer inside a box. 

 

 CAUTION: Failure to repackage the printer properly for shipment can result in damage not covered by 
the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee. The Xerox® Warranty, 
Service Agreement, or Total Satisfaction Guarantee do not cover damage to the printer caused by 
improper moving. The Xerox® Total Satisfaction Guarantee is available in the United States and 
Canada. Coverage could vary outside these areas. Please contact your Xerox representative for details. 
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General Troubleshooting 

This section includes: 
• Printer Has Two Power Switches .............................................................................................................................. 212 
• Restarting the Printer ................................................................................................................................................... 213 
• Printer Does Not Turn On ............................................................................................................................................ 213 
• Printer Resets or Turns Off Frequently ................................................................................................................... 214 
• Printing Takes Too Long .............................................................................................................................................. 214 
• Document Fails to Print ............................................................................................................................................... 215 
• Document Prints from Wrong Tray ......................................................................................................................... 216 
• Printer is Making Unusual Noises ............................................................................................................................. 216 
• Automatic 2-Sided Printing Problems .................................................................................................................... 216 
• Date and Time Are Incorrect ..................................................................................................................................... 217 
• Scanner Errors .................................................................................................................................................................. 218 

This section contains procedures to help you locate and resolve problems. Resolve some problems by 
simply restarting the printer. 
 

Printer Has Two Power Switches 

This printer has two power switches. The secondary power switch on the top of the printer, beneath the 
control panel, controls power only to the electronic components of the printer. The main power switch, 
located behind the front cover, controls the power into the printer. Turn on both switches to operate the 
printer. First turn on the main power switch behind the front cover, then turn on the secondary switch. 

 
 

Power Switches Power Switches with Business Ready Finisher 
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Restarting the Printer 
1. Locate the two power switches. 
2. Turn off the switch on the top of the printer. A message appears on the control panel that warns that 

the printer is turning off. 
3. If the printer turns off, then turn on the switch to restart the printer. 
4. If the printer does not turn off after two minutes, then open the front cover and turn off the second 

switch. 
5. Turn on the bottom switch, then turn on the top switch to restart the printer. 

If the problem is not resolved by restarting the printer, see the table in this chapter that best describes the 
problem. 
 

Printer Does Not Turn On 
 

Probable Causes Solutions 

The power cord is not correctly plugged into 
the outlet. 

Turn off the printer, and plug the power cord securely into the outlet. 

Something is wrong with the outlet connected 
to the printer. 

• Plug another electrical appliance into the outlet and see if it 
operates properly. 

• Try a different outlet. 

One of the power switches is not turned on. Turn off both of the power switches. Wait two minutes then turn on 
both of the switches. 

The printer is connected to an outlet with a 
voltage or frequency that does not match the 
printer specifications. 

Use a power source with the specifications listed in Electrical 
Specifications. 

 

 CAUTION: Plug the three-wire cord (with grounding prong) directly into a grounded AC outlet only. 
Do not use a power strip. If necessary, contact a licensed electrician to install a properly grounded 
outlet. 
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Printer Resets or Turns Off Frequently 
 

Probable Causes Solutions 

The power cord is not correctly plugged into 
the outlet. 

Turn off the printer, confirm that the power cord is correctly plugged 
into the printer and the outlet, then turn on the printer. For details, 
see Turning the Printer On and Off on page39. 

The printer is plugged into an uninterruptible 
power supply (UPS), extension cord, or power 
strip. 

Only use an extension cord designed to handle the electrical current 
capacity of the printer. 

A network configuration problem exists. Unplug the network cable. If the problem is resolved, contact your 
network administrator to reconfigure your network installation. 

A system error occurred. Contact your Xerox representative with the error code and message. 
Check the control panel fault history. For details, see Viewing Fault 
and Alert Messages on the Control Panel on page 277. 

  
 

Printing Takes Too Long 
 

Probable Causes Solutions 

The printer is set to print on a paper type that 
requires slower printing. 

Certain paper types, like heavyweight paper and transparencies, 
take more time to print. Ensure that the print driver and control 
panel are set to the proper paper type. 

The printer is in Energy Saver mode. Wait. It takes time for printing to start when the printer is coming 
out of Energy Saver mode. 

The way the printer was installed on the 
network could be an issue. 

• Determine if a print spooler or a computer sharing the printer is 
buffering all print jobs and then spooling them to the printer. 
Spooling can slow print speeds. 

• To test the speed of the printer, print multiple copies of an 
information page, such as a demo page. If the page prints at the 
rated speed of the printer, you could have a network or printer 
installation issue. For additional help, contact the system 
administrator. 

The job is complex. Wait. No action needed. 
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Document Fails to Print 
 

Probable Causes Solutions 

Selected tray has wrong paper size loaded. To view the Job Status for a failed print on the touch screen: 
1. At the printer control panel, press the Job Status button. 
2. Find the failed print job in the list. 
3. Note the status of the failed print job, such as Held: Resources 

Required. 
4. For details, touch the print job, then touch Details. 
5. Note the Tray number listed under Resources and the status of 

the selected tray. 
6. Load the correct size paper in the tray or select another tray. 

Selected paper type or color is not available. To view the Job Status for a failed print on the touch screen: 
1. At the printer control panel, press the Job Status button. 
2. Find the failed print job in the list. 
3. Note the status of the failed print job, such as Held: Resources 

Required. 
4. For details, touch the print job, then touch Details. 
5. Note the Tray number listed under Resources and the status of 

the selected tray. 
6. Load the correct paper type or color in the tray, or select another 

tray. 

Incorrect network settings. To reset network settings: 
1. At the printer control panel, press the Machine Status button. 
2. Touch Tools>Network Settings>TCP/IP Settings. 

Note: If this feature does not appear, log in as a system 
administrator. For details, see Logging In as the System 
Administrator at the Control Panel on page 33. 

3. Touch Reset Defaults. 

The way the printer was installed on the 
network could be an issue. 

• Ensure that the printer is connected to the network. 
• Determine if a print spooler or a computer sharing the printer is 

buffering all print jobs and then spooling them to the printer. 
Spooling can slow print speeds. 

• To test the printer, print an information page, such as a demo 
page. If the page prints, you could have a network or printer 
installation issue. For help, contact the system administrator. 

Application and print driver have conflicting 
tray selections. 

For details, see Document Prints from Wrong Tray on page 216. 
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Document Prints from Wrong Tray 
 

Probable Causes Solutions 

Application and print driver have conflicting 
tray selections. 

1. Check the tray selected in the print driver. 
2. Go to the page setup or printer settings of the application from 

which you are printing. 
3. Set the paper source to match the tray selected in the print driver 

or set the paper source to Automatically Select. 

Note: To have the print driver select the tray, enable Auto Selection 
for the source tray on the printer. 

  
 

Printer is Making Unusual Noises 
 

Probable Causes Solutions 

One of the trays is not installed correctly. Open and close the tray from which you are printing. 

There is an obstruction or debris inside the 
printer. 

Turn off the printer and remove the obstruction or debris. If you 
cannot remove it, contact your Xerox® service representative. 

  
 

Automatic 2-Sided Printing Problems 
 

Probable Causes Solutions 

Unsupported or incorrect paper. Ensure that you are using the correct paper. Do not use 
transparencies, envelopes, labels, or reloaded paper for 
automatic 2-sided printing. For details, see Supported Paper 
Sizes and Weights for Automatic 2-Sided Printing on page 53. 

Incorrect setting. On the print driver Printing Options tab, select 2-sided Printing. 
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Date and Time Are Incorrect 

The date and time are set automatically when the printer is connected to a network that has a Network 
Time Protocol (NTP) server. NTP is used to synchronize the internal clocks of computers over a network 
connection at system startup and every subsequent 24-hour period thereafter. This feature ensures that 
the internal clock of the printer stays synchronized with the NTP server you specify. 
 

Probable Causes Solutions 

The Date and Time Setup is set to Manual 
(NTP Disabled). 

Change the Date and Time to Automatic by enabling NTP. Enable 
NTP using CentreWare Internet Services: 
1. At your computer, open a Web browser, in the address field, type 

the IP address of the printer, then press Enter or Return. 

Notes: 

• If you do not know the IP address of your printer, see Finding 
the IP Address of Your Printer on page 34. 

• If this feature does not appear, log in as a system administrator. 
For details, see Logging In as the System Administrator at the 
Control Panel on page 33. 

2. Click the Properties tab. 
3. In the navigation pane, click the arrow to the left of General 

Setup. 
4. From the expanded General Setup menu, select Date and Time. 
5. In the Date and Time page, click the arrow at the right of Date 

and Time Setup. 
6. Select Automatic using NTP. 
7. In the NTP Server Settings, enter the IP address for the NTP 

server. 
8. Click Apply. 

The time zone, date, or time is set incorrectly. Set the time zone, date, and time manually: 
1. At the printer control panel, press the Machine Status button, 

then touch the Tools tab. 
2. Touch Device Settings>General>Date and Time. 

Note: If this feature does not appear, log in as a system 
administrator. For details, see Logging In as the System 
Administrator at the Control Panel on page 33. 

3. To set the time zone, touch Time Zone, then touch the arrows to 
adjust the time zone. 

4. To set the date, touch Date, select a format, then set the date. 
5. To use 24 hour format, select Display 24 hour clock. To set the 

time, touch Time, then set the time. 

Note: The date and time are set automatically through Network 
Time Protocol (NTP). To modify these settings, go to the Properties 
tab in CentreWare Internet Services and change the Date and Time 
Setup to Manual (NTP Disabled). 

6. Touch Save. 
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Scanner Errors 
 

Probable Causes Solutions 

Scanner is not communicating. Turn off the printer, and check the scanner cable. Wait two minutes 
and turn the printer on again. 
If the problem is not resolved, contact your Xerox® service 
representative. 
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Jams 

This section includes: 
• Clearing Paper Jams...................................................................................................................................................... 220 
• Clearing Jams in the Business Ready Finisher ..................................................................................................... 234 
• Clearing Jams in the CZ Folder ................................................................................................................................. 246 
• Minimizing Paper Jams ................................................................................................................................................ 256 
• Troubleshooting Paper Jams ..................................................................................................................................... 257 
• Clearing Staple Jams .................................................................................................................................................... 260 
• Clearing Hole Punch Jams .......................................................................................................................................... 264 
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Clearing Paper Jams 

This section includes: 
• Clearing Jams at Trays 1–4 ........................................................................................................................................ 221 
• Clearing Jams at Tray 5 (Bypass Tray) .................................................................................................................. 222 
• Clearing Jams at Door A .............................................................................................................................................. 223 
• Clearing Jams at Door B .............................................................................................................................................. 227 
• Clearing Jams at Door C .............................................................................................................................................. 228 
• Clearing Jams at Door D ............................................................................................................................................. 229 
• Clearing Jams in the Document Feeder ................................................................................................................ 231 

To avoid damage, always remove jammed paper carefully without tearing it. Try to remove the paper in 
the same direction it normally moves through the printer. Even a small piece of paper left in the printer 
can cause a jam. Do not reload paper that has jammed. 
 

Note: Do not touch the printed side of the paper when removing it. The printed side of jammed 
pages could smudge, and the toner could stick to your hands. Avoid spilling any toner inside the 
printer. 

  

 WARNING: If you accidentally get toner on your clothes, lightly dust them off as best as you can. If 
some toner remains on your clothes, use cool water, not hot, to rinse off the toner. If toner gets on 
your skin, wash it off with cool water and a mild soap. If you get toner in your eyes, wash it out 
immediately with cool water and consult a doctor. 
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Clearing Jams at Trays 1–4 
1. Before removing the tray from the printer, look at the jam message on the control panel. If another 

jam is shown, clear that jam inside the printer first. 
2. Pull the tray out toward you until it stops. 

 
3. Remove the paper from the tray. 
4. If the paper is torn, remove the tray completely and check inside the printer for torn pieces of paper. 

 
5. Reload the tray with undamaged paper, then push the tray in until it stops. Paper Settings - Tray X 

appears on the control panel. 
6. Verify the size, type, and color of the paper. Change the selection for any incorrect setting. 
7. On the printer touch screen, touch Confirm. 
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Clearing Jams at Tray 5 (Bypass Tray) 
1. Remove the jammed paper from the tray. Make sure the paper feed entrance where the tray 

connects to the printer is clear. 

 
2. If the paper is torn, check inside the printer for torn pieces of paper. 
3. Fan the paper you removed and make sure that all four corners are neatly aligned. 
4. Insert the paper into tray 5 with the printing side face down. The leading edge of the paper should 

lightly touch the paper feed entrance. 

 
Paper Settings - Tray 5 (Bypass) appears on the control panel. 

5. Verify the size, type, and color of the paper. Change the selection for any incorrect setting. 
6. On the printer touch screen, touch Confirm. 
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Clearing Jams at Door A 
1. Remove paper from the left tray, then fold up the tray. 

 
2. Open Tray 5 as shown. 

 
3. Lift release lever 2. 
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4. Open door A as shown. 

 
 

 WARNING: The area around the fuser can be hot. Use caution to avoid injury. 
  

 CAUTION: Do not touch the transfer belt. Touching the belt can reduce image quality or damage the 
transfer belt. Do not touch the transfer roller. Touching the roller can reduce image quality. 

 

 
5. Remove the jammed paper. 
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6. If the paper is jammed at the exit to the center output tray, pull the paper in the direction shown. 

Note: Toner can adhere to the transfer roller. The toner that does adhere to the transfer roller does 
not affect print quality. 

 
7. If paper is jammed in the fuser, to open the fuser exit gate, pull the green lever A1. 

 
8. Remove the paper as shown. 

 
Note: If the paper is torn, remove all torn pieces from the printer. 
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9. If the paper is jammed at the bottom entry of the fuser, remove it as shown. 

 
10. Return the green lever A1 to its locked position. 

 
11. Close door A, then close Tray 5. 
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Clearing Jams at Door B 
1. Open tray 5 as shown (1). 

 
2. While lifting the release lever (2), open door B as shown (3). 
3. Remove the jammed paper as shown. 
 

Note: If the paper is torn, remove all torn pieces from the printer. 
 

 
4. Close door B, then close tray 5. 
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Clearing Jams at Door C 
1. Pull the release lever and open door C. 

 
2. Remove the jammed paper as shown. 
 

Note: If the paper is torn, remove all torn pieces from the printer. 
 

 
3. For paper jammed in the upper position, look inside the printer to remove it. 

Note: If the paper is inaccessible, see Clearing Jams at Door A on page 223. 

4. For paper jammed in the tray feed roller, open the tray and remove the paper. 

 
5. Close door C. 
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Clearing Jams at Door D 
1. Remove paper from the left tray, then fold up the tray. 

 
2. Open tray 5 as shown (1). 
3. While lifting the release lever (2), open the top left cover A as shown (3). 

 
 

 WARNING: The area around the fuser can be hot. Use caution to avoid injury. 
  

 CAUTION: Do not touch the transfer belt. Touching the belt can reduce image quality or damage the 
transfer belt. Do not touch the transfer roller. Touching the roller can reduce image quality. 
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4. Open the left tray as shown. 
5. Lift the lever up to open door D. 

 
6. Remove the jammed paper as shown. 
 

Note: If the paper is torn, remove all torn pieces from the printer. 
 

 
7. Close door D. 
8. Close door A, then close tray 5. 
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Clearing Jams in the Document Feeder 
1. Lift the lever and open the top cover of the document feeder as shown. 

 
2. If the original is not caught in the entry to the document feeder, pull it straight out in the direction 

shown. 

 
3. If the message on the control panel instructs you to turn the green wheel, turn it in the direction 

shown. Turning the green wheel moves the original out of the feeder. 

 

 Xerox® WorkCentre® 7970 Multifunction Printer 231 
 User Guide 
 



Troubleshooting 

 

4. If the message instructs you to open the inner cover, lift the lever with the green tab to open the 
inner cover. 

5. Turn the green wheel in the direction shown to move the original out of the feeder. Carefully remove 
the jammed original. 

 
6. Close the inner cover, then close the top cover, pressing it down until it clicks into place. 
7. If the original is not visible when the top cover is opened, lift the document cover and remove the 

original. 

 
8. If the original is not visible when the document cover is opened, lift up the document feeder tray, 

then remove the paper. 
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9. Lower the document feeder tray. 
10. If the original is not wrinkled or torn, load it into the feeder again following the instructions on the 

touch screen. 
 

Note: After clearing a document feeder jam, reload the entire document, including the pages already 
scanned. The printer automatically skips the scanned pages and scans the remaining pages. 

 

 CAUTION: Torn, wrinkled, or folded originals can cause jams and damage the printer. To copy torn, 
wrinkled, or folded originals, use the document glass. 
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Clearing Jams in the Business Ready Finisher 

This section includes: 
• Clearing Jams in the Center Tray ............................................................................................................................. 234 
• Clearing Jams in the Finisher Transport ................................................................................................................ 235 
• Clearing Jams at 3a in the Finisher ......................................................................................................................... 236 
• Clearing Jams at 3c in the Finisher.......................................................................................................................... 238 
• Clearing Jams at 3d in the Finisher ......................................................................................................................... 240 
• Clearing Jams at 4 in the Finisher ............................................................................................................................ 242 
• Clearing Jams in the Booklet Tray ........................................................................................................................... 244 
 

Clearing Jams in the Center Tray 
1. If the paper is jammed at the exit to the center output tray, pull the paper in the direction shown. 

 
2. Open, then close, the finisher transport cover. 
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Clearing Jams in the Finisher Transport 
1. Open the finisher transport cover. 

 
2. Remove the jammed paper. 

Note: If the paper is torn, remove all torn pieces from the finisher. 

 
3. Close the finisher transport cover. 
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Clearing Jams at 3a in the Finisher 
1. If the paper is visible at the output tray exit, remove the paper by pulling it in the direction shown. 

 
2. Open the front door of the Business Ready finisher. 

 
3. Lift green handle 3a. 
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4. Carefully remove the paper. 

Note: If the paper is torn, remove all torn pieces from the finisher. 

 
5. Return green handle 3a to its original position. 

 
6. Close the front door of the Business Ready finisher. 
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Clearing Jams at 3c in the Finisher 
1. Open the front door of the Business Ready finisher. 

 
2. Move green lever 3c to the left. 

 
3. Carefully remove the paper. 

Notes: 

• If the paper is torn, remove all torn pieces from the finisher. 
• If the paper is inaccessible, or if the control panel prompts you, to release the paper, turn green 

knob 3b in the direction shown. 
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4. Return green lever 3c to its original position. 

 
5. Close the front door of the Business Ready finisher. 
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Clearing Jams at 3d in the Finisher 
1. Open the front door of the finisher, then locate green lever 3d. 

 
2. Move green lever 3d to the right. 

 
3. Carefully remove the paper. 

Note: If the paper is torn, remove all torn pieces from the finisher. 
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4. Return green lever 3d to its original position. 

 
5. Close the front door of the Business Ready finisher. 
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Clearing Jams at 4 in the Finisher 
1. Open the front door of the Business Ready finisher. 

 
2. Using the green handle, pull out unit 4 until it stops. 

 
3. To remove the jammed paper, turn green knob 4 in either direction as shown. 

Note: If the paper is torn, remove all torn pieces from the finisher. 
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4. Return unit 4 to its original position. 

 
5. Close the front door of the Business Ready finisher. 
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Clearing Jams in the Booklet Tray 
1. Open the front door of the Business Ready finisher. 

 
2. To release the jammed paper, turn green knob 4 in the direction shown. 
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3. To remove the paper, pull it in the direction shown. 

Note: If the paper is torn, remove all torn pieces from the finisher. 

 
4. Close the front door of the Business Ready finisher. 
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Clearing Jams in the CZ Folder 

This section includes: 
• Clearing Jams at 2a in the CZ Folder...................................................................................................................... 246 
• Clearing Jams at 2b in the CZ Folder...................................................................................................................... 248 
• Clearing Jams at 2e in the CZ Folder ...................................................................................................................... 250 
• Clearing Jams at 2f in the CZ Folder ...................................................................................................................... 252 
• Clearing Jams at 2g in the CZ Folder...................................................................................................................... 254 
 

Clearing Jams at 2a in the CZ Folder 
1. Open the front door of the CZ folder. 

 
2. Lift green handle 2a up. 
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3. Carefully remove the paper. 

Note: If the paper is torn, remove all torn pieces from the folder. 

 
4. Return green handle 2a to its original position. 

 
5. Close the front door of the CZ folder. 

 
 

 Xerox® WorkCentre® 7970 Multifunction Printer 247 
 User Guide 
 



Troubleshooting 

 

Clearing Jams at 2b in the CZ Folder 
1. Open the front door of the CZ folder. 

 
2. Move green lever 2b to the left. 

 
3. Carefully remove the paper. 

Note: If the paper is torn, remove all torn pieces from the folder. 
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4. Return lever 2b to its original position. 

 
5. Close the front door of the CZ folder. 
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Clearing Jams at 2e in the CZ Folder 
1. To access lever 2e, open the front door of the CZ folder, then open the Folder tray 2d. 

 
2. Move green lever 2e to the right. 

 
3. Carefully remove the paper. 

Note: If the paper is torn, remove all torn pieces from the folder. 
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4. Return green lever 2e to its original position. 

 
5. Close the Folder tray, then close the front door of the CZ folder. 
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Clearing Jams at 2f in the CZ Folder 
1. To access lever 2f, open the front door of the CZ folder, then open the Folder tray 2d. 

 
2. Move green lever 2f to the right. 

 
3. Carefully remove the paper. 

Note: If the paper is torn, remove all torn pieces from the folder. 
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4. Return green lever 2f to its original position. 

 
5. Close the Folder tray, then close the front door of the CZ folder. 
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Clearing Jams at 2g in the CZ Folder 
1. Open the front door of the CZ folder. 

 
2. Move green lever 2g to the right. 

 
3. Carefully remove the paper. 

Note: If the paper is torn, remove all torn pieces from the folder. 
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4. Return green lever 2g to its original position. 

 
5. Close the front door of the CZ folder. 
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Minimizing Paper Jams 

The printer is designed to function with minimal paper jams using Xerox supported paper. Other paper 
types can cause jams. If supported paper is jamming frequently in one area, clean that area of the paper 
path. To avoid damage, always remove jammed paper carefully without tearing it. Try to remove the 
paper in the same direction it normally moves through the printer. Even a small piece of paper left in the 
printer can cause a jam. Do not reload paper that has jammed. 

The following can cause paper jams: 
• Selecting the incorrect paper type in the print driver. 
• Using damaged paper. 
• Using unsupported paper. 
• Loading paper incorrectly. 
• Overfilling the tray. 
• Adjusting the paper guides improperly. 

Most jams can be prevented by following a simple set of rules: 
• Use only supported paper. For details, see Supported Paper on page 50. 
• Follow proper paper handling and loading techniques. 
• Always use clean, undamaged paper. 
• Avoid paper that is curled, torn, moist, creased, or folded. 
• To separate the sheets before loading into the tray, fan the paper. 
• Observe the paper tray fill line; never overfill the tray. 
• Remove transparencies from the output tray immediately after printing. 
• Adjust the paper guides in all trays after inserting the paper. A guide that is not properly adjusted 

can cause poor print quality, misfeeds, skewed prints, and printer damage. 
• After loading the trays, select the correct paper type and size on the control panel. 
• When printing, select the correct type and size in the print driver. 
• Store paper in a dry location. 
• Use only Xerox paper and transparencies designed for the printer. 

Avoid the following: 
• Polyester coated paper that is designed specially for inkjet printers. 
• Highly glossy or coated paper. 
• Paper that is folded, wrinkled, or excessively curled. 
• Fanning transparencies before loading in the paper tray. 
• Loading more than one type, size, or weight of paper in a tray at the same time. 
• Loading hole punched paper or paper with folded corners or staples in the document feeder. 
• Overfilling the paper trays. 
• Allowing the output tray to overfill. 
• Allowing the output tray to fill with more than a few transparencies. 

Refer to the control panel Paper and Media Information Pages for information on supported paper, or see 
Supported Paper on page 50. 
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Troubleshooting Paper Jams 

This section includes: 
• Multiple Sheets Pulled Together .............................................................................................................................. 257 
• Jams in the Document Feeder .................................................................................................................................. 257 
• Paper Misfeeds and Paper Size Jams ..................................................................................................................... 258 
• Label and Envelope Misfeeds .................................................................................................................................... 258 
• Paper Jam Message Stays On ................................................................................................................................... 259 
• Jams During Automatic 2-Sided Printing .............................................................................................................. 259 
 

Multiple Sheets Pulled Together 
 

Probable Causes Solutions 

The paper tray is too full. Remove some of the paper. Do not load paper past the fill line. 

The edges of the paper are not even. Remove the paper, align the edges, and then reload it. 

The paper is moist from humidity. Remove the paper from the tray, and replace it with new, dry paper. 

Too much static electricity is present. • Try a new ream of paper. 
• Do not fan transparencies before loading in tray. 

Using unsupported paper. Use only Xerox-approved paper. For details, see Supported Paper on 
page 50. 

Humidity is too high for coated paper. Feed paper one sheet at a time. 
 
 

Jams in the Document Feeder 
 

Probable Causes Solutions 

Unsupported paper of the wrong size, 
thickness, or type. 

Use only Xerox-approved paper. For details, see Supported Paper on 
page 50. 

Originals are torn, previously stapled, bent, or 
folded. 

Ensure that the originals are not torn, bent, or folded. If previously 
stapled, remove all staples and separate the sheets by fanning 
them. 

The documents loaded in the document 
feeder exceed the maximum capacity 
allowed. 

Place fewer documents in the document feeder. 

Improperly adjusted document feeder guides. Adjust the paper guides to fit snugly against the paper loaded in the 
document feeder. 
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Paper Misfeeds and Paper Size Jams 
 

Probable Causes Solutions 

The paper is not correctly positioned in the 
tray. 

• Remove the misfed paper and reposition it properly in the tray. 
• Adjust the paper guides in the tray to match the size of the 

paper. 

The paper tray is too full. Remove some of the paper. Do not load paper past the fill line. 

The paper guides are not correctly adjusted to 
the paper size. 

1. Remove the paper. 
2. Adjust the paper guides in the tray to match the size of the 

paper. 
3. Replace the paper. 

The tray contains warped or wrinkled paper. Remove the paper, smooth it out, and reload it. If it still misfeeds, do 
not use that paper. 

The paper is moist from humidity. Remove the moist paper and replace it with new, dry paper. 

Using paper of the wrong size, thickness, or 
type. 

Use only Xerox approved paper. For details, see Supported Paper on 
page 50. 

 
 

Label and Envelope Misfeeds 
 

Probable Causes Solutions 

The label sheet is facing the wrong way in the 
tray. 

Load label sheets according to the instructions from the 
manufacturer. 
• Load labels face up in trays 1–4. 
• Load labels face down in tray 5. 

Envelopes are loaded in the wrong tray. Use tray 5 to print envelopes. 

Envelopes are loaded incorrectly in tray 5. To load envelopes in tray 5: 
• Load envelopes long-edge feed, flap-side up, flaps closed, with 

the flaps leading into the printer. 
• Load C4 and custom-size envelopes longer than 320 mm 

(12.6 in.) short-edge feed, with the flaps closed, flap-side up. The 
flaps are toward the back or leading into the printer. For 
custom-size envelopes, define a custom size on the control panel. 

Envelopes are loaded incorrectly in the 
envelope tray. 

Load envelopes in the optional envelope tray with the flaps closed, 
flap-side down, and the long edge toward the left. 
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Paper Jam Message Stays On 
 

Probable Causes Solutions 

Some paper remains jammed in the printer. Recheck the media path and make sure that you have removed all of 
the jammed paper. 

One of the printer doors is open. Check the doors on the printer. Close any door that is open. 
  

Note: Check for, and remove, torn pieces of paper in the paper path. 
 
 

Jams During Automatic 2-Sided Printing 
 

Probable Causes Solutions 

Using paper of the wrong size, thickness, or 
type. 

Use paper of the correct size, thickness, or type. For details, see 
Supported Paper Sizes and Weights for Automatic 2-Sided Printing 
on page 53. 

Paper type is set incorrectly in the print driver. Ensure that the paper type is set correctly in the driver and that the 
paper is loaded in the correct tray. For details, see Supported Paper 
on page 50. 

Paper is loaded in the wrong tray. The paper must be loaded in the correct tray. For details, see 
Supported Paper on page 50. 

Tray is loaded with mixed paper. Load the tray with only one type and size of paper. 
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Clearing Staple Jams 

This section includes: 
• Clearing Main Staple Jams in the Business Ready Finisher ........................................................................... 260 
• Clearing Staple Jams in the Business Ready Finisher Booklet Maker ......................................................... 262 
 

Clearing Main Staple Jams in the Business Ready Finisher 
1. Open the front door of the Business Ready finisher. 

 
2. Hold the stapler assembly by the orange lever R1 and push it to the right. 
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3. Grip the staple cartridge by the orange handle and pull it firmly toward you to remove it. 

 
4. Pull the staple cartridge clamp firmly in the direction shown to open it. 

 
5. Remove the jammed staples (1), then push the clamp in the direction shown until it snaps into the 

locked position (2). 
 

 WARNING: The points of the jammed staples are sharp. Remove the jammed staples carefully. 
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6. Return the staple cartridge assembly to its original position. 

 
7. Close the finisher front door. 
 

Clearing Staple Jams in the Business Ready Finisher Booklet Maker 
1. Open the front door of the Business Ready finisher. 

 
2. Grasp the booklet maker handle and pull the unit toward you until the staple cartridges appear on 

the top edge of the device. 

 

262 Xerox® WorkCentre® 7970 Multifunction Printer 
 User Guide 
 



Troubleshooting 

 

3. To remove the staple cartridge from the booklet maker, push down on the staple cartridge handle, as 
shown, then pull the cartridge out and up. 

 
4. Turn the staple cartridge over. 
5. To permit the staple cartridge handle to open out and away from the staple case, press in the green 

tabs, then pull back the handle. 

 
Note: If you do not see the staple jam, remove the staple case. 

6. To remove the staple case, press the rear of the case as shown. 

 
Note: If you can see the staple jam, open the staple cartridge clamp. 
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7. To open to the staple cartridge, pull it firmly in the direction shown. 

 
 

 WARNING: The points of the jammed staples are sharp. Remove the jammed staples carefully. 
 

 
8. Remove the jammed staples, then push the clamp in the direction shown until it snaps into the 

locked position. 
9. Return the staple cartridge to the booklet maker, then return the booklet maker to its original 

position. 
 

Clearing Hole Punch Jams 

Clearing Hole Punch Jams in the Finisher 

If the printer stops printing and reports a hole punch jam, empty the hole punch waste container. For 
more information, see Emptying the Hole Punch Waste Container on page 203. 
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Print-Quality Problems 

This section includes: 
• Controlling Print Quality .............................................................................................................................................. 266 
• Troubleshooting Print-Quality Problems ............................................................................................................... 268 

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems, 
use the information in this section to troubleshoot the problem. For more information, go to 
www.xerox.com/office/WC7970support. 
 

 CAUTION: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does not 
cover damage caused by using unsupported paper or specialty media. The Xerox Total Satisfaction 
Guarantee is available in the United States and Canada. Coverage could vary outside these areas. 
Please contact your local representative for details. 

  

Notes: 

• To enhance print quality, the toner/print/drum cartridges for many models of equipment are 
designed to cease functioning at a predetermined point. 

• Grayscale images printed with the composite black setting increment the color pages counter, 
because color consumables are used. Composite black is the default setting on most printers. 
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Controlling Print Quality 

Various factors can affect the quality of the output of your printer. For consistent and optimum print 
quality, use paper designed for your printer, and correctly set the Print-Quality Mode and Color 
Adjustments. Follow the guidelines in this section to maintain optimum print quality from your printer. 

Temperature and humidity affect the quality of the printed output. For details, see Environmental 
Specifications on page 289. 
 

Paper and Media 

Your printer is designed to use various paper and other media types. Follow the guidelines in this section 
for the best print quality and to avoid jams: 
• Use only Xerox approved paper. For details, see Supported Paper on page 50. 
• Use only dry, undamaged paper. 
 

 CAUTION: Some paper and other media types can cause poor output quality, increased paper jams, 
or damage your printer. Do not use the following: 

• Rough or porous paper 
• Inkjet paper 
• Non-laser glossy or coated paper 
• Paper that has been photocopied 
• Paper that has been folded or wrinkled 
• Paper with cutouts or perforations 
• Stapled paper 
• Envelopes with windows, metal clasps, side seams, or adhesives with release strips 
• Padded envelopes 
• Plastic media 

  

• Ensure the paper type selected in your print driver matches the paper type on which you are printing. 
• If you have the same size paper loaded in more than one tray, ensure that the proper tray is selected 

in the print driver. 
• Store your paper and other media properly for optimum print quality. For details, see Paper Storage 

Guidelines on page 51. 
 

Print-Quality Modes 

Select the correct print-quality setting for your print job from the print driver. For instructions on setting 
the print quality, see Selecting Printing Options on page 77. To control the print quality: 
• Use the print-quality settings in the print driver to control print quality. If the print quality is not 

suitable, adjust the print-quality setting to an higher level. 
• Use only Xerox approved paper. For details, see Supported Paper on page 50. 
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Color Corrections and Color Adjustments 

Set the Color Correction to Xerox Automatic Color for best printing results of mixed text, graphics, and 
images on a range of supported paper. For instructions on setting the Color Correction, see Using Color 
Corrections. Follow these guidelines to control the Color Corrections and Color Adjustments: 
• For best results on most paper, ensure that the Color Correction in the print driver is set to Xerox 

Automatic Color. 
• To produce more vivid results, select a mode of Color Correction. For example, when printing graphics 

in which the sky does not look blue enough, for a more vibrant blue sky, select Vivid Color. 
• To match the color output to another output device, select a custom Color Correction. 
• To apply different Color Corrections to Text and Graphics, and Images, select Custom Automatic 

Color. This feature provides custom color corrections using color systems such as RGB Color, CMYK 
Color, Spot Color, or CIE Color. 

• To adjust particular characteristics of the printed color, such as Lightness, Contrast, Saturation, and 
Color Casts, select Color Adjustments. 
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Troubleshooting Print-Quality Problems 

This section includes: 
• Printing the Troubleshooting Print-Quality Pages ............................................................................................. 268 
• Eliminating the Paper or Media as the Problem ................................................................................................. 268 
• Isolating the Problem to the Printer or to the Application ............................................................................. 269 
• Troubleshooting Print-Quality Problems in the Application, Print Driver, or Print Server ................... 269 
• Troubleshooting Print-Quality Problems in the Printer .................................................................................... 270 
• Performing the Print Calibration Procedure ......................................................................................................... 270 
• Print-Quality Problems and Solutions ..................................................................................................................... 271 

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems, 
use the information in this section to troubleshoot the problem. For more information, go to 
www.xerox.com/office/WC7970support. 
 

 CAUTION: The Xerox Warranty, Service Agreement, or Xerox Total Satisfaction Guarantee does not 
cover damage caused by using unsupported paper or specialty media. The Xerox Total Satisfaction 
Guarantee is available in the United States and Canada. Coverage could vary outside these areas. 
Please contact your local representative for details. 

  

Note: To enhance the print quality, toner/print/drum cartridges for many models of equipment are 
designed to cease functioning at a predetermined point. 

 
 

Printing the Troubleshooting Print-Quality Pages 
1. To print procedures on resolving print-quality problems, at the printer control panel, press the 

Machine Status button. 
2. Touch the Machine Information tab. 
3. Touch Information Pages. 
4. Touch Troubleshooting Print Quality Page, then touch Print. 
5. Compare your print-quality problems to the examples on the pages. 
 

Eliminating the Paper or Media as the Problem 

Damaged or unsupported paper or media can cause print-quality problems even when the printer, 
application, and print driver are working perfectly. Use the following guidelines to eliminate the paper as 
the source of the print-quality problem: 
• Make sure that the printer supports the paper or media. 
• Make sure that the printer is loaded with undamaged, dry paper. 
• If the condition of the paper or media is in doubt, replace it with new paper or media. 
• Make sure that you have the proper tray selected in the print driver and from the control panel. 
• Make sure that you have the correct paper type selected in the print driver and in the control panel of 

the printer. 
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Isolating the Problem to the Printer or to the Application 

When you are sure that the paper is supported and in good condition, use the following steps to isolate 
the problem: 
1. From the control panel of the printer, print the pages for Diagnosing Print Quality. For details, see 

Printing the Troubleshooting Print Quality Pages on page 268. 
− If the pages printed properly, the printer is working properly and the print-quality problem is an 

application, print driver, or print server problem. 
− If the pages still have print-quality problems, the problem is in the printer. 

2. If the pages printed properly, see Troubleshooting Print-Quality Problems in the Application, Print 
Driver, or Print Server on page 269. 

3. If the pages still had print-quality issues, or did not print, see Troubleshooting Print-Quality Problems 
in the Printer on page 270. 

 
 

Troubleshooting Print-Quality Problems in the Application, Print Driver, or Print 
Server 

If the printer is printing properly from the control panel but you still have print-quality problems, the 
application, print driver, or print server could be the cause. 

To isolate the problem: 
1. Print a similar document from another application and look for the same print-quality problems. 
2. If the document has the same print-quality problem, it is probably a print driver or print server 

problem. Check the print driver used for the print job. 
a. Navigate to the list of printers on your computer: 

• For Windows XP SP3, click Start>Settings>Printers and Faxes. 
• For Windows Server 2003 and later, click Start>Settings>Printers. 
• For Windows 7, click Start>Devices and Printers. 

b. Right-click on the name of the printer. 
c. From the drop-down list, select Properties. 

• Ensure that the model name in the middle of the driver matches the model name of the 
printer. 

• If the names do not match, install the proper print driver for the printer. 
3. If the print driver is correct, to set the Print Quality Mode and Color Correction, see Selecting Printing 

Options on page 77. 
− Set the Print-Quality mode to Standard or Enhanced. 
− Set the Color Correction to Xerox® Automatic Color. 

4. If the problem persists, delete then reinstall the print driver. 
5. If the document printed without a print-quality problem, the application is probably the cause. 

Restart your printer, restart the application, then print the document again. For more information, 
see Restarting the Printer on page 213. 

6. If the problem still persists, ensure that you are not printing through a print server. If the problem 
persists, for online support information, go to www.xerox.com/office/WC7970support. 
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Troubleshooting Print-Quality Problems in the Printer 

If you have print-quality problems when printing a Demo Page or the Configuration Report from the 
control panel, the problem is in the printer. 

To find the source of the problem: 
1. At the control panel, print the Troubleshooting Print-Quality Pages. For details, see Printing the 

Troubleshooting Print Quality Pages on page 268. 
2. If the prints are too light to see print details, verify the following: 

− The printer is loaded with undamaged, dry supported paper. 
− The toner levels of one or more of the toner cartridges is not too low. 

3. If the pages are printed with a solid color, one or more of the drum cartridges could be defective. 
Correct the problem before continuing. 

4. If the colors of the pages do not match your expectations, run the control panel Print Calibration. 
5. Compare the print-quality problems in your document to each of the examples in the 

Troubleshooting Print-Quality Pages. 

If you find a match in the Troubleshooting Print-Quality Pages, look in the Solutions column for the action 
to take to resolve the problem. 

If the problem persists, for online support information, go to www.xerox.com/office/WC7970support. 
 

Performing the Print Calibration Procedure 
1. At the printer control panel, press the Machine Status button, then touch the Tools tab. 
2. Touch Troubleshooting>Calibration>Print Calibration>Next. 
3. Follow the onscreen instructions to run the Print Calibration procedure. 
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Print-Quality Problems and Solutions 

Use the following table to find solutions to print-quality problems. 

Note: To print procedures on resolving print-quality problems, at the printer control panel, press the 
Machine Status button. Then touch Machine Information>Information Pages>Troubleshooting 
Print Quality Page>Print. 

 

Problem Solution 

Smears, Smudges, and Streaks 
Dark or light marks appear on your 
output. 

 

Run a print job consisting of several blank pages through the printer to 
remove toner accumulated on the fuser. 
If the problem persists, print the test pages to help determine which 
component is causing the image-quality problem. 
• If the defect occurs in one color only, replace the corresponding imaging 

unit. 
• If the defect occurs in all colors and is visible on all the test pages, replace 

the fuser. 

Repeating Spots or Lines 
Spot or lines appear at regular intervals 
on the prints. 

 

1. To identify the part of the printer that is causing the problem, print the 
Repeating Defects page. At the control panel, press Machine Status, 
then touch Tools>Troubleshooting>Support Pages>Repeating Defects 
Page>Print. 

2. To identify the part responsible for the repeating spots or lines, follow 
the instructions on the Repeating Defects page. 

3. To correct the problem, replace the printer part identified on the 
Repeating Defects page. 

Colors Look Wrong 
Colors are off or look drastically wrong. 

 

1. Verify that the printer is on a solid, level, and flat surface. 
2. Perform the Calibrate Color procedure. At the control panel, press 

Machine Status, then touch Tools>Troubleshooting>Calibration>Print 
Calibration>Next, then follow the instructions. 
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Problem Solution 

Colors Too Light or Too Dark 
The print or color density is too light, 
missing, or the background is foggy. 

 

1. Verify that the paper you are using is the correct type for the printer and 
is loaded properly. For details, see Supported Paper on page 50. 

2. Verify that the paper loaded in the tray matches the paper type selected 
at the control panel and in the print driver. 

3. To print procedures on resolving print-quality problems, at the control 
panel, press Machine Status. Then touch Machine 
Information>Information Pages>Troubleshooting Print Quality 
Page>Print. 
If the Color Reference page looks correct, the printer is printing properly. 
Your application or incorrect settings in the print driver can be causing 
the print-quality problems. 

4. If the Color Reference page did not print correctly, perform the Calibrate 
Color procedure. At the control panel, press Machine Status, then touch 
Tools>Troubleshooting>Calibration>Print Calibration>Next, then 
follow the onscreen instructions. 

Vertical White Lines or Streaks - One Color 
Lines or streaks appear in one color of 
your output. 

 

1. Print the test pages to identify the affected color. 
2. To clean the printhead lenses for the affected color, pull out the cleaning 

rod until it stops, then move it all the way in. Repeat three more times. 
Then repeat this procedure for each affected color. For details, see 
Cleaning the Printhead Lenses on page 184. 

Note: To print procedures on resolving print-quality problems, at the control 
panel, press Machine Status. Then touch Machine 
Information>Information Pages>Troubleshooting Print Quality 
Page>Print. 

Toner Missing or Easy to Rub Off 
Toner appears to be missing from the 
print or is easy to rub off. 

 

1. Verify that the paper you are using is the correct type for the printer and 
is loaded properly. For details, see Supported Paper on page 50. 

2. Perform the Calibrate Paper Type procedure. For details, see Optimizing 
Printer Performance on page 41. 

3. At the control panel, select a heavier paper. 

Notes: Papers from lightest to heaviest are: 

• For uncoated paper: Plain, Lightweight Cardstock, Cardstock, and 
Heavyweight Cardstock 

• For coated paper: Lightweight Glossy Cardstock, Glossy Cardstock, and 
Heavyweight Glossy Cardstock. 

 

272 Xerox® WorkCentre® 7970 Multifunction Printer 
 User Guide 
 



Troubleshooting 

 

Copy and Scan Problems 

If the copy or scan quality is poor, refer to the following table. 
 

Symptoms Solutions 

Lines or streaks only present in copies made 
from the document feeder. 

There is debris on the document glass. When scanning, the paper 
from the document feeder passes over the debris creating lines or 
streaks. Clean all glass surfaces with a lint-free cloth. 

Spots present in copies taken from the 
document glass. 

There is debris on the document glass. When scanning, the debris 
creates a spot on the image. Clean all glass surfaces with a lint-free 
cloth. 

The reverse side of the original is showing on 
the copy or scan. 

Turn on Background Suppression. 

Image is too light or too dark. • Copy: Use the Image Quality settings to lighten, darken, or 
adjust contrast. 

• Scan: Use the Advanced Settings Tab to lighten, darken, or 
adjust contrast. 

Colors are inaccurate. • Copy: Use the Image Quality settings to adjust color balance. 
• Scan: Confirm the correct Original Type is set. 

If the problem persists, for online support information, go to www.xerox.com/office/WC7970support. 
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Fax Problems 

This section includes: 
• Problems Sending Faxes .............................................................................................................................................. 274 
• Problems Receiving Faxes ........................................................................................................................................... 275 
 

Note: If you cannot send and receive faxes, ensure that you are connected to an approved analog 
telephone line. The fax cannot send or receive when connected directly to a digital telephone line 
without the use of an analog filter. It can also require you to set the fax starting rate to Forced (4800 
bps). For details, see Selecting the Starting Rate on page 157. 

 
 

Problems Sending Faxes 
 

Symptoms Probable Causes Solutions 

The document is not feeding 
properly through the document 
feeder. 

The document is too thick, too thin, or 
too small. 

Use the document glass. 

The document is scanned at an 
angle. 

The document feeder width guides are 
not adjusted to fit the width of the 
document. 

Adjust the document feeder width 
guides so that they fit against the 
document. 

The fax received by the recipient 
is blurry. 

The document is positioned incorrectly. Position the document correctly. 

The document glass is dirty. Clean the document glass. 

The text in the document is too light. Adjust the resolution. Adjust the 
contrast. 

There is a problem with the telephone 
connection. 

Verify that the telephone line is working, 
then send the fax again. 

There is a problem with one of the fax 
machines. 

Make a copy to verify that the printer 
can make clean copies and prints. If the 
copy prints correctly, have the recipient 
verify that their fax machine is 
operating correctly. 

The fax received by the recipient 
is blank. 

The document was loaded incorrectly. • If using the document feeder, place 
the original document face up. 

• If using the document glass, place 
the original document face down. 

Fax was not transmitted. The fax number is wrong. Verify the fax number. 

The telephone line is connected 
incorrectly. 

Verify the telephone line connection. If 
the telephone line is disconnected, 
connect it. 

There is a problem with the fax 
machine of the recipient. 

Contact the recipient. 
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Symptoms Probable Causes Solutions 

The fax feature is not installed or is not 
enabled. 

Ensure that the fax feature is installed 
and enabled. 

Server fax is enabled. Ensure that server fax is disabled. 

An access number is required to 
connect to an outside line. 

If the printer is connected to a PBX 
system, it could be necessary to enter a 
number to access the outside telephone 
line. 

The fax number needs a pause 
between the prefix for an outside line 
and the telephone number. 

To insert a pause, press the Dial Pause 
button. A comma (,) appears in the 
corresponding location. 

If the problem persists, for online support information, go to www.xerox.com/office/WC7970support. 
 

Problems Receiving Faxes 
 

Symptoms Probable Causes Solutions 

The fax received by the recipient 
is blank. 

There is a problem with the telephone 
connection or with the fax machine of 
the sender. 

Verify that the printer can make clean 
copies. If it can, have the sender fax the 
document again. 

The sender loaded the pages 
incorrectly. 

Contact the sender. 

The printer answers the call but 
does not print the fax. 

The memory is full. To increase available memory, delete 
stored jobs and wait for the existing 
jobs to complete. 

The received fax size is reduced 
in size. 

The paper supply in the printer does 
not match the document size sent. 

Confirm the original size of the 
documents, then load the appropriate 
paper size in the printer. 

Faxes are not received 
automatically. 

The printer is set to receive faxes 
manually. 

Set the printer to receive faxes 
automatically. 

The memory is full. If the printer is out of paper, faxes and 
print jobs can deplete the printer of 
memory. Load paper and print the jobs 
stored in the memory. 

The telephone line is connected 
incorrectly. 

Verify the telephone line connection. If 
the telephone line is disconnected, 
connect it. 

There is a problem with the fax 
machine of the sender. 

Make a copy to verify that the printer 
can make clean copies and prints. If the 
copy prints correctly, have the recipient 
verify that their fax machine is 
operating correctly. 

If the problem persists, for online support information, go to www.xerox.com/office/WC7970support. 
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Getting Help 

This section includes: 
• Control Panel Messages .............................................................................................................................................. 276 
• Using the Integrated Troubleshooting Tools ...................................................................................................... 277 
• More Information .......................................................................................................................................................... 280 

Xerox provides several automatic diagnostic utilities to help you maintain productivity and print quality. 
 

Control Panel Messages 

The printer control panel provides information and troubleshooting help. When a fault or alert condition 
occurs, the control panel displays a message informing you of the problem. In many cases, the control 
panel also displays an animated graphic showing the location of the problem, such as the location of a 
paper jam. For many status and alert messages, the control panel Help button provides additional 
information. 
 

Control Panel Help 

To view more information about error or status messages on the control panel, touch the Help button. 

 

The control panel menu items also have associated help text that describes the menu item. 
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Viewing Fault and Alert Messages on the Control Panel 

When a fault or alert condition occurs, a message appears on the control panel to inform you of the 
problem. Alert messages inform you about printer conditions, such as low supplies or open doors, that 
require your attention. Fault messages warn you about printer conditions that prevent the printer from 
printing or degrade printing performance. If more than one condition occurs, only one appears on the 
control panel. 

To view a complete list of active fault and alert messages: 
1. At the printer control panel, press the Machine Status button. 
2. Touch the Active Messages tab. 
3. Touch the Down arrow and select Faults, Alerts, or Faults & Alerts. 
4. To view details, touch a fault or alert. 
 

Viewing the Fault History on the Control Panel 

When faults occur, they are logged in to a fault history file by date, time, and fault code. Use this list to 
identify trends and resolve problems. 

To view the fault history: 
1. At the printer control panel, press the Machine Status button. 
2. Touch the Active Messages tab. 
3. Touch Fault History. 

The screen displays the number, date, time, and image count for each fault code. 
 

Using the Integrated Troubleshooting Tools 

You can use several integrated tools, such as Information pages and CentreWare Internet Services, to 
troubleshoot print-quality problems and jams. 
 

Printing Information Pages 
1. At the printer control panel, press the Machine Status button. 
2. On the Machine Information tab, touch Information Pages, then touch the desired information 

page. 
3. Touch Print. 
 

Note: Information pages can also be printed from CentreWare Internet Services. 
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Specifying the Source Tray for Printing Information Pages 
1. At the printer control panel, press the Machine Status button, then touch the Tools tab. 
2. Touch Device Settings>Paper Management>Tray Settings. 
3. Determine the tray with the lowest priority value. If it is the tray you want to use, no further action is 

required. 
4. Touch the specific tray you want the printer to use, then touch Change Settings. 
5. Touch the number under Priority, then use the alphanumeric keypad on the control panel to enter a 

lower value than any other tray. 

Note: Tray priority values are from 1 through 99, with 1 being the highest priority and 99 the lowest. 

6. To confirm the setting, touch Save. 
7. To return to the Tools tab, touch Close, or, to return to the main screen touch Services Home. 
 

Printing the Configuration Report 
1. At the printer control panel, press the Machine Status button. 
2. On the Machine Information tab, touch Information Pages>Configuration Report>Print. 
3. After the report prints, touch Close. 

Note: By default, the Configuration Report prints each time the printer is turned on. To turn off this 
setting, press Machine Status, then touch Tools>Device Settings>Configuration/Information 
Pages. Under Print Configuration at power on?, touch No, then Save. 

 

Viewing Billing and Usage Information 
1. At the printer control panel, press the Machine Status button. 
2. To view basic impression counts, touch the Billing Information tab: 

− Black impressions are the number of pages printed with no color specified. 
− Color impressions are the number of pages printed that specify color. 
− Total impressions are the total number of color impressions plus black impressions. 

Note: A page is one side of a sheet of paper that can be printed on one or two sides. A sheet printed 
on two sides counts as two impressions. 

3. To view detailed usage information, touch Usage Counters. 
 

Locating the Serial Number on the Control Panel 
1. At the printer control panel, press the Machine Status button. 
2. To see the model, serial number, and software version, touch the Machine Information tab. 
 

278 Xerox® WorkCentre® 7970 Multifunction Printer 
 User Guide 
 



Troubleshooting 

 

Viewing Printer Supply Status 
1. At the control panel, press Machine Status, then touch the Supplies tab. 
2. To view details about a toner cartridge, including the part number for reordering, touch Black, Cyan, 

Magenta, or Yellow. 
3. To return to the Supplies tab, touch Close. 
4. For details about other supply items, touch Other Supplies. Then touch an item to display additional 

details. 
5. To return to the Other Supplies screen, touch Close. 
6. To return to the Supplies tab, touch Close. 
7. To print the Supplies Usage page, touch Print Supplies Report. 
8. To return to the main screen, touch Services Home. 
 

CentreWare Internet Services 

CentreWare Internet Services is the administration and configuration software installed on the 
embedded Web server in the printer. It allows you to configure and administer the printer from a Web 
browser. 

CentreWare Internet Services requires: 
• A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux 

environments. 
• TCP/IP and HTTP enabled in the printer. 
• A network-connected computer with a Web browser that supports JavaScript. 

For details, see the Help in CentreWare Internet Services or the System Administrator Guide. 
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More Information 

You can obtain more information about your printer from these sources: 
 

Resource Location 

Installation Guide Packaged with the printer. 

Other documentation for your printer www.xerox.com/office/WC7970docs 

Recommended Media List United States: www.xerox.com/paper 
European Union: www.xerox.com/europaper 

Technical support information for your printer; 
including online technical support, Online Support 
Assistant, and driver downloads. 

www.xerox.com/office/WC7970support 

Information about menus or error messages Press the control panel Help (?) button. 

Information Pages Print from the control panel, or from CentreWare 
Internet Services, click Status>Information Pages. 

CentreWare Internet Services documentation In CentreWare Internet Services, click Help. 

Order supplies for your printer www.xerox.com/office/WC7970supplies 

A resource for tools and information, including 
interactive tutorials, printing templates, helpful tips, 
and customized features to meet your individual 
needs. 

www.xerox.com/office/businessresourcecenter 

Local sales and support center www.xerox.com/office/worldcontacts 

Printer registration www.xerox.com/office/register 

Xerox® Direct online store www.direct.xerox.com/ 
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Specifications 

 

Printer Configurations and Options 

Standard Features 

The Xerox® WorkCentre® 7970 Multifunction Printer provides the following features: 
• Copy, print, scan, Internet fax, and server fax 
• Scan to USB and Print from USB mass storage devices 
• Copy speed of up to 70 ppm for color or black and white on A4 (210 x 297 mm) or Letter (8.5 x 11 in.) 

paper. 
• 1200 x 2400 dpi HiQ LED imaging and copying quality 
• Copy document sizes up to A3/11 x 17 in. 
• Print document size, with short-edge feed, up to SRA3/12 x 19 in. 
• Automatic 2-sided printing 
• Single-pass duplex automatic document feeder 
• Color touch screen control panel 
• Tray 5 with 100-sheet capacity 
• High-Capacity Tandem Tray with standard SRA3/12 x 18 in. support, 2000 A4/Letter sheets 
• 2 GB memory plus 1 GB page memory 
• Internal 250 GB hard drive 
• Ethernet 10/100/1000Base-TX 
• Universal Serial Bus (USB 2.0) 
• Adobe PostScript and PCL fonts and support 
• Remote driver installation 
• Bonjour, SSDP, and SAP device discovery 
• Job-based accounting 
• Secure Print 
• Data security 
• Xerox Extensible Interface Platform 
• Earth Smart features 
• CentreWare Internet Services 
• Xerox® CentreWare® Web 
• Email alerts 
• Automated supplies replenishment 
• Proactive supplies management 
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Options and Upgrades 
• Business Ready finisher with 2/3 or 2/4 hole punch 
• Business Ready Booklet Maker finisher with 2/3 or 2/4 hole punch 
• CZ folder 
• Swedish Hole Punch 
• Envelope tray 
• 2000-Sheet high-capacity feeder 
• Standard work surface 
• One line and dual line fax kits 
• Embedded PDL support for XPS 
• Xerox Secure Access Unified ID System 
• FreeFlow SMARTsend 
• Convenience stapler 
• Xerox® Common Access Card Enablement Kit 
• Xerox® Copier Assistant 
• Wireless network adapter 
• Foreign device interface 
• Unicode print 
• McAfee enhanced security features 
• Network accounting 
• Scan to PC Desktop 
• Scanning software solutions. For details, go to www.xerox.com/office/software-solutions. 
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Physical Specifications 

Base Configuration 
• Width: 110.7 cm (43.6 in.) 
• Depth: 69.9 cm (27.5 in.) 
• Height: 114.9 cm (45.2 in.) 
• Weight: 151.9 Kg (334.2 lb.) 
 

Configuration with Business Ready Finisher and Booklet Maker 
• Width: 183.7 cm (72.3 in.) 
• Depth: 69.9 cm (27.5 in.) 
• Height: 114.9 cm (45.2 in.) 
• Weight: 212.3 Kg (467.1 lb.) 
 

Configuration with Business Ready Finisher, Booklet Maker, and CZ Folder 
• Width: 207 cm (81.5 in.) 
• Depth: 72.6 cm (28.6 in.) 
• Height: 114.9 cm (45.2 in.) 
• Weight: 264.4 Kg (581.7 lb.) 
 

Configuration with Business Ready Finisher, Booklet Maker, CZ Folder, and 
High-Capacity Feeder 
• Width: 207 cm (81.5 in.) 
• Depth: 72.6 cm (28.6 in.) 
• Height: 114.9 cm (45.2 in.) 
• Weight: 293.4 Kg (645.5 lb.) 
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Clearance Requirements 

Clearance Requirements for Base Configuration 
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Clearance Requirements for Configuration with Business Ready Finisher and Booklet 
Maker 
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Clearance Requirements for Configuration with Business Ready Finisher, Booklet 
Maker, and CZ Folder 
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Clearance Requirements for Configuration with Business Ready Finisher, Booklet 
Maker, CZ Folder, and High-Capacity Feeder 
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Environmental Specifications 

Temperature 

Operating: 10–28°C (50–83°F) 
 

Relative Humidity 

Operating: 15% to 85% (non-condensing) 
 

Elevation 

For optimum performance, use the printer at elevations below 2500 m (8200 ft.). 
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Electrical Specifications 

Power Supply Voltage Frequency 
 

Current Required 

110–127 VAC +/-10% 50 Hz +/- 3 Hz 
60 Hz +/- 3 Hz 

16 A 

220–240 VAC +/-10% 50 Hz +/- 3 Hz 
60 Hz +/- 3 Hz 

10 A 
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Performance Specifications 

Printing Resolution 

Maximum Resolution: 1200 x 2400 dpi 
 

Print Speed 

Xerox reports speeds for continuous printing using long-edge feed on A4 (210 x 297 mm, 8.27 x 11.69 in.) 
or Letter (216 x 279 mm, 8.5 x 11 in.) Bond 60–105 g/m² (18–28 lb.) paper from any tray except for tray 
5. 

Several factors affect print speed: 
• Paper orientation: For faster print speeds, you can load paper long-edge feed. 
• Paper size: Letter (8.5 x 11 in.) and A4 (210 x 297 mm) sizes share the fastest print speed. 
• Paper weight: Lightweight prints faster than heavier paper, such as Cardstock and Labels. 
• Paper type: Plain prints faster than Glossy. 

You can achieve maximum print speed when you print on Plain, Letter/A4 paper, using long-edge feed. 

The slowest print speed is approximately 13 ppm when you print from tray 5 using large size, 
Heavyweight Glossy Cardstock. 
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Environmental, Health, and Safety Contact 
Information 

For more information on Environment, Health, and Safety in relation to this Xerox product and supplies, 
contact the following customer help lines: 
United States and Canada: 1-800-ASK-XEROX (1-800-275-9376) 

Europe: +44 1707 353 434 

For product safety information in the United States and Canada, go to www.xerox.com/environment. 

For product safety information in Europe, go to www.xerox.com/environment_europe. 
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Regulatory Information 

 

Basic Regulations 

Xerox has tested this printer to electromagnetic emission and immunity standards. These standards are 
designed to mitigate interference caused or received by this printer in a typical office environment. 
 

United States FCC Regulations 

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant 
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This equipment generates, 
uses, and can radiate radio frequency energy. If the equipment is not installed and used in accordance 
with these instructions, it can cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference. Users are required to correct the 
interference at their own expense. 

If this equipment does cause harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try to correct the interference 
by one or more of the following measures: 
• Reorient or relocate the receiving antenna. 
• Increase the separation between the equipment and receiver. 
• Connect the equipment into an outlet on a circuit different from that to which the receiver is 

connected. 

Consult the dealer or an experienced radio/TV technician for help. 

Changes or modifications to this equipment not approved by Xerox can void the authority of the user to 
operate this equipment. 
 

 WARNING: To ensure compliance with Part 15 of the FCC rules, use shielded interface cables. 
 
 

Canada 

This Class A digital apparatus complies with Canadian ICES-003. 

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada. 
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Certifications in Europe 

 

The CE mark applied to this equipment symbolizes a declaration of conformity by Xerox 
with the following applicable Directives of the European Union as of the dates indicated: 
• December 12, 2006 Council Directive 2006/95/EC as amended. This is a directive on 

the approximation of the laws of the member states related to low voltage equipment. 
• December 15, 2004 Council Directive 2004/108/EC as amended. This directive is an 

approximation of the laws of the member states related to electromagnetic 
compatibility. 

• A full declaration of conformity, defining the relevant directives and referenced 
standards, can be obtained from your authorized local dealer. 

  

 WARNINGS: 

• Changes or modifications to this equipment not specifically approved by the Xerox Corporation 
may void the user's authority to operate this equipment. 

• External radiation from Industrial, Scientific, and Medical (ISM) equipment can interfere with the 
operation of this Xerox device. If external radiation from ISM equipment interferes with this 
device, contact your Xerox representative for assistance. 

• This is a class A product. In a domestic environment, this product can cause radio frequency 
interference, in which case the user can be required to take adequate measures. 

• Shielded cables must be used with this equipment to maintain compliance with Council Directive 
2004/108/EC. 

 
 

 Xerox® WorkCentre® 7970 Multifunction Printer 295 
 User Guide 
 



Regulatory Information 

 

European Union Lot 4 Imaging Equipment Agreement Environmental 
Information 

Environmental Information Providing Environmental Solutions and Reducing Cost 

The following information has been developed to assist users and has been issued in relation to the 
European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging 
Equipment. This requires manufacturers to improve environmental performance of in scope products and 
supports the EU action plan on energy efficiency. 

In scope products are Household and Office equipment that meet the following criteria. 
• Standard monochrome format products with a maximum speed less than 66 A4 images per minute 
• Standard color format products with a maximum speed less than 51 A4 images per minute 
 

Environmental Benefits of Duplex Printing 

Most Xerox products have duplex printing, also known as 2-sided printing, capability. This enables you to 
print on both sides of the paper automatically, and therefore helps to reduce the use of valuable 
resources by reducing your paper consumption. The Lot 4 Imaging Equipment agreement requires that 
on models greater than or equal to 40 ppm color or greater than or equal to 45 ppm monochrome the 
duplex function has been auto enabled, during the setup and driver installation. Some Xerox models 
below these speed bands may also be enabled with 2-sided printing settings defaulted on at the time of 
install. Continuing to use the duplex function will reduce the environmental impact of your work. 
However, should you require simplex/1-sided printing, you may change the print settings in the print 
driver. 
 

Paper Types 

This product can be used to print on both recycled and virgin paper, approved to an environmental 
stewardship scheme, which complies with EN12281 or a similar quality standard. Lighter weight paper 
(60 g/m²), which contains less raw material and thus save resources per print, may be used in certain 
applications. We encourage you to check if this is suitable for your printing needs. 
 

ENERGY STAR 
 
 
 
 

 

The ENERGY STAR program is a voluntary scheme to promote the development and 
purchase of energy efficient models, which help to reduce environmental impact. Details 
on the ENERGY STAR program and models qualified to ENERGY STAR can be found at 
the following website: 
www.energystar.gov/index.cfm?fuseaction=find_a_product.showProductGroup&pgw_c
ode=IEQ 

The ENERGY STAR and ENERGY STAR mark are registered United States trademarks. 

The ENERGY STAR Imaging Equipment Program is a team effort between United States, 
European Union, and Japanese governments and the office equipment industry to 
promote energy-efficient copiers, printers, fax, multifunction printers, personal 
computers, and monitors. Reducing product energy consumption helps combat smog, 
acid rain, and long-term changes to the climate by decreasing the emissions that result 
from generating electricity. 
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Power Consumption and Energy Saver Activation Time 

The amount of electricity a product consumes depends on the way the device is used. This product is 
designed and configured to enable you to reduce your electricity costs. 

After the last print, the device switches to Ready mode. In this mode, the device can print again 
immediately. If the device is not used for an interval of time, the device switches to Energy Saver mode. 
In Energy Saver mode, only essential functions remain active, which permits reduced product power 
consumption. 

The product takes slightly longer to produce the first print after it exits Energy Saver mode than it takes in 
Ready mode. This delay is the result of the system waking up from Energy Saver mode and is typical of 
most imaging products on the market. 

Before you turn off Energy Saver mode or set a long activation time, consider the increase in product 
power consumption. 

To learn more about Xerox participation in sustainability initiatives, go to: 
www.xerox.com/about-xerox/environment/enus.html. 
 

Default Energy Saver Settings for Product 

The Xerox® WorkCentre® 7970 Multifunction Printer is ENERGY STAR® qualified under the ENERGY STAR 
Program Requirements for Imaging Equipment. The transition time from Standby to Energy Saver mode, 
which can be up to 30 minutes, is set to a default value of 2 minutes. The transition time from Energy 
Saver mode to Sleep, which can be up to 30 minutes, is set to a default value of 0 minutes. The transition 
time from Standby to Sleep for this printer can be up to 60 minutes. 

To configure Energy Saver settings, see Setting Energy Saver Mode on page 42. 
 

Germany 

Germany - Blue Angel 
 

 

RAL, the German Institute for Quality Assurance and Labeling, has awarded this device 
the Blue Angel Environmental Label. This label distinguishes it as a device that satisfies 
Blue Angel criteria for environmental acceptability in terms of device design, 
manufacture, and operation. For more information, go to: www.blauer-engel.de. 

 
 

Blendschutz 

Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz 
vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht 
im unmittelbaren Gesichtsfeld platziert werden. 
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Lärmemission 

Maschinenlärminformations-Verordnung 3. GPSGV: Der höchste Schalldruckpegel beträgt 70 dB(A) oder 
weniger gemäß EN ISO 7779. 
 

Importeur 

Xerox GmbH 

Hellersbergstraße 2-4 

41460 Neuss 

Deutschland 
 

Turkey RoHS Regulation 

In compliance with Article 7 (d), we hereby certify “it is in compliance with the EEE regulation.” 

“EEE yönetmeliğine uygundur.” 
 

Eurasian Economic Community Certification 
 

 

Russia, Belarus, and Kazakhstan are working to establish a common customs union, the 
Eurasian Economic Community, or EurAsEC. The Eurasian Economic Community 
members anticipate sharing a common regulatory scheme and common EurAsEC 
certification mark, the EAC Mark. 

 
 

Regulatory Information for 2.4 GHz Wireless Network Adapter 

This product contains a 2.4 GHz Wireless LAN radio transmitter module which complies with the 
requirements specified in FCC Part 15, Industry Canada RSS-210 and European Council Directive 99/5/EC. 

Operation of this device is subject to the following two conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any interference received, including interference that may 
cause undesired operation. 

Changes or modifications to this device not specifically approved by the Xerox Corporation may void the 
user's authority to operate this equipment. 
 

Ozone Release 

This printer produces ozone during normal operation. The amount of ozone produced is dependent on 
copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone. 
Install the printer in a well-ventilated room. 

For more information in the United States and Canada, go to www.xerox.com/environment. In other 
markets, please contact your local Xerox representative or go to www.xerox.com/environment_europe. 
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Copy Regulations 

United States 

Congress, by statute, has forbidden the reproduction of the following subjects under certain 
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such 
reproductions. 
1. Obligations or Securities of the United States Government, such as: 

− Certificates of Indebtedness. 
− National Bank Currency. 
− Coupons from Bonds. 
− Federal Reserve Bank Notes. 
− Silver Certificates. 
− Gold Certificates. 
− United States Bonds. 
− Treasury Notes. 
− Federal Reserve Notes. 
− Fractional Notes. 
− Certificates of Deposit. 
− Paper Money. 
− Bonds and Obligations of certain agencies of the government, such as FHA and so on. 
− Bonds. United States Savings Bonds may be photographed only for publicity purposes in 

connection with the campaign for the sale of such bonds. 
− Internal Revenue Stamps. If it is necessary to reproduce a legal document on which there is a 

canceled revenue stamp, this may be done provided the reproduction of the document is 
performed for lawful purposes. 

− Postage Stamps, canceled or uncanceled. For philatelic purposes, Postage Stamps may be 
photographed, provided the reproduction is in black and white and is less than 75% or more 
than 150% of the linear dimensions of the original. 

− Postal Money Orders. 
− Bills, Checks, or Drafts of money drawn by or upon authorized officers of the United States. 
− Stamps and other representatives of value, of whatever denomination, which have been or may 

be issued under any Act of Congress. 
− Adjusted Compensation Certificates for Veterans of the World Wars. 

2. Obligations or Securities of any Foreign Government, Bank, or Corporation. 
3. Copyrighted materials, unless permission of the copyright owner has been obtained or the 

reproduction falls within the “fair use” or library reproduction rights provisions of the copyright law. 
Further information of these provisions may be obtained from the Copyright Office, Library of 
Congress, Washington, D.C. 20559. Ask for Circular R21. 
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4. Certificate of Citizenship or Naturalization. Foreign Naturalization Certificates may be 
photographed. 

5. Passports. Foreign Passports may be photographed. 
6. Immigration papers. 
7. Draft Registration Cards. 
8. Selective Service Induction papers that bear any of the following Registrant’s information: 

− Earnings or Income. 
− Court Record. 
− Physical or mental condition. 
− Dependency Status. 
− Previous military service. 
− Exception: United States military discharge certificates may be photographed. 

9. Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of the 
various Federal Departments, such as FBI, Treasure, and so on (unless photograph is ordered by the 
head of such department or bureau). 

Reproducing the following is also prohibited in certain states: 
• Automobile Licenses. 
• Drivers’ Licenses. 
• Automobile Certificates of Title. 

The preceding list is not all inclusive, and no liability is assumed for its completeness or accuracy. In case 
of doubt, consult your attorney. 

For more information about these provisions contact the Copyright Office, Library of Congress, 
Washington, D.C. 20559. Ask for Circular R21. 
 

Canada 

Parliament, by stature, has forbidden the reproduction of the following subjects under certain 
circumstances. Penalties of fine or imprisonment may be imposed on those guilty of making such 
reproductions. 
• Current bank notes or current paper money 
• Obligations or securities of a government or bank 
• Exchequer bill paper or revenue paper 
• The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or of a 

court of law 
• Proclamations, orders, regulations, or appointments, or notices thereof (with intent to falsely cause 

same to purport to have been printed by the Queens Printer for Canada, or the equivalent printer for 
a province) 

• Marks, brands, seals, wrappers, or designs used by or on behalf of the Government of Canada or of a 
province, the government of a state other than Canada or a department, board, Commission, or 
agency established by the Government of Canada or of a province or of a government of a state 
other than Canada 
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• Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or of a 
province or by the government of a state other than Canada 

• Documents, registers, or records kept by public officials charged with the duty of making or issuing 
certified copies thereof, where the copy falsely purports to be a certified copy thereof 

• Copyrighted material or trademarks of any manner or kind without the consent of the copyright or 
trademark owner 

This list is provided for your convenience and assistance, but it is not all-inclusive, and no liability is 
assumed for its completeness or accuracy. In case of doubt, consult your solicitor. 
 

Other Countries 

Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may be 
imposed on those found guilty of making such reproductions. 
• Currency notes 
• Bank notes and checks 
• Bank and government bonds and securities 
• Passports and identification cards 
• Copyright material or trademarks without the consent of the owner 
• Postage stamps and other negotiable instruments 

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of 
doubt, contact your legal counsel. 
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Fax Regulations 

United States 

Fax Send Header Requirements 

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or 
other electronic device, including a fax machine, to send any message unless such message clearly 
contains in a margin at the top or bottom of each transmitted page or on the first page of the 
transmission, the date and time it is sent and an identification of the business or other entity, or other 
individual sending the message and the telephone number of the sending machine or such business, 
other entity, or individual. The telephone number provided may not be a 900 number or any other 
number for which charges exceed local or long-distance transmission charges. 

For instructions on programming the Fax Send Header information, refer to the section of the System 
Administrator Guide on Setting Transmission Defaults. 
 

Data Coupler Information 

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the 
Administrative Council for Terminal Attachments (ACTA). On the cover of this equipment is a label that 
contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If requested, 
this number must be provided to the Telephone Company. 

A plug and jack used to connect this equipment to the premises wiring and telephone network must 
comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant 
telephone cord and modular plug is provided with this product. It connects to a compatible modular jack 
that is also compliant. See installation instructions for details. 

You can safely connect the printer to the following standard modular jack: USOC RJ-11C using the 
compliant telephone line cord (with modular plugs) provided with the installation kit. See installation 
instructions for details. 

The Ringer Equivalence Number (REN) is used to determine the number of devices that can be connected 
to a telephone line. Excessive RENs on a telephone line could result in the devices not ringing in response 
to an incoming call. In most but not all areas, the sum of RENs should not exceed five (5.0). To be certain 
of the number of devices that can be connected to a line, as determined by the RENs, contact the local 
Telephone Company. For products approved after July 23, 2001, the REN is part of the product identifier 
that has the format US:AAAEQ##TXXXX. The digits represented by ## are the REN without a decimal 
point (for example, 03 is a REN of 0.3). For earlier products, the REN is separately shown on the label. 
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To order the correct service from the local Telephone Company, you could also have to quote the codes in 
the following list: 
• Facility Interface Code (FIC) = 02LS2 
• Service Order Code (SOC) = 9.0Y 
 

 CAUTION: Ask your local Telephone Company for the modular jack type installed on your line. 
Connecting this machine to an unauthorized jack can damage telephone company equipment. You, 
not Xerox, assume all responsibility and/or liability for any damage caused by the connection of this 
machine to an unauthorized jack. 

If this Xerox® equipment causes harm to the telephone network, the Telephone Company could 
temporarily discontinue service to the telephone line to which it is connected. If advance notice is not 
practical, the Telephone Company notifies you of the disconnection as soon as possible. If the Telephone 
Company interrupts your service, they can advise you of your right to file a complaint with the FCC if you 
believe that it is necessary. 

The Telephone Company could change its facilities, equipment, operations, or procedures which could 
affect the operation of the equipment. If the Telephone Company changes something that affects the 
operation of the equipment, they should notify you in order for you to make necessary modifications to 
maintain uninterrupted service. 

If you experience trouble with this Xerox® equipment, please contact the appropriate service center for 
repair or warranty information. Contact information is contained in the Machine Status menu on the 
printer and in the back of the Troubleshooting section of the User Guide. If the equipment is causing 
harm to the telephone network, the Telephone Company may request you to disconnect the equipment 
until the problem is resolved. 

Only a Xerox Service Representative or an authorized Xerox Service provider are authorized to make 
repairs to the printer. This applies at any time during or after the service warranty period. If unauthorized 
repair is performed, the remainder of the warranty period is null and void. 

This equipment must not be used on party lines. Connection to party line service is subject to state tariffs. 
Contact the state public utility commission, public service commission, or corporation commission for 
information. 

Your office could have specially wired alarm equipment connected to the telephone line. Make sure that 
the installation of this Xerox® equipment does not disable your alarm equipment. 

If you have questions about what could disable alarm equipment, consult your Telephone Company or a 
qualified installer. 
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Canada 

This product meets the applicable Industry Canada technical specifications. 

A representative designated by the supplier should coordinate repairs to certified equipment. Repairs or 
alterations made by the user to this device, or device malfunctions, could cause the telecommunications 
company to request you to disconnect the equipment. 

For user protection, make sure that the printer is properly grounded. The electrical ground connections of 
the power utility, telephone lines, and internal metallic water pipe systems, if present, must be connected 
together. This precaution could be vital in rural areas. 
 

 WARNING: Do not attempt to make such connections yourself. Contact the appropriate electric 
inspection authority, or electrician, to make the ground connection. 

The REN assigned to each terminal device provides an indication of the maximum number of terminals 
allowed to be connected to a telephone interface. The termination on an interface could consist of any 
combination of devices. The only limitation to the number of devices is the requirement that the sum of 
the RENs of the devices does not exceed 5. For the Canadian REN value, please see the label on the 
equipment. 
 

Canada CS-03 Issue 9 

This product has been tested to and is compliant with CS–03 issue 9. 
 

European Union 

Radio Equipment and Telecommunications Terminal Equipment Directive 

This Xerox device has been self-certified by Xerox for pan-European single terminal connection to the 
analog public switched telephone network (PSTN) in accordance with Directive 1999/5/EC. 

This device has been designed to work with the national public switched telephone networks and 
compatible PBX devices of the following countries: 
 

 Pan-European Analog PSTN and 
Compatible PBX Certifications  

 

Austria Greece Netherlands 

Belgium Hungary Norway 

Bulgaria Iceland Poland 

Cyprus Ireland Portugal 

Czech Republic Italy Romania 

Denmark Latvia Slovakia 

Estonia Liechtenstein Slovenia 
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 Pan-European Analog PSTN and 
Compatible PBX Certifications  

 

Finland Lithuania Spain 

France Luxembourg Sweden 

Germany Malta United Kingdom 

This product has been tested to and is compliant with TBR21 OR ES 103 021-1/2/3 or ES 203 021-1/2/3 
technical specifications for terminal equipment for use on analog-switched telephone networks in the 
European Economic Area. 

If you have problems with your product, contact your local Xerox representative. This product can be 
configured to be compatible with other country networks. Before reconnecting the device to a network in 
another country, contact your Xerox representative for assistance. 
 

Notes: 

• Although this product can use either loop disconnect (pulse) or DTMF tone signaling, Xerox 
recommends that you use DTMF signaling. DTMF signaling provides reliable and faster call setup. 

• Modification of this product, or connection to external control software or control apparatus not 
authorized by Xerox, invalidates its certification. 

 
 

New Zealand 
1. The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has 

accepted that the item complies with minimum conditions for connection to its network. It indicates 
no endorsement of the product by Telecom, it does not provide any sort of warranty, and it does not 
imply that any Telepermitted product is compatible with all Telecom network services. Above all, it 
provides no assurance that any item will work correctly in all respects with another item of 
Telepermitted equipment of a different make or model. 
The equipment may not be capable of correct operation at the higher data speeds designated. 
33.6 kbps and 56 kbps connections are likely to be restricted to lower bit rates when connected to 
some PSTN implementations. Telecom will accept no responsibility for difficulties that arise in such 
circumstances. 

2. Immediately disconnect this equipment should it become physically damaged, then arrange for its 
disposal or repair. 

3. This modem shall not be used in any manner which could constitute a nuisance to other Telecom 
customers. 

4. This device is equipped with pulse dialing, while the Telecom standard is DTMF tone dialing. There is 
no guarantee that Telecom lines will always continue to support pulse dialing. 

5. Use of pulse dialing, when this equipment is connected to the same line as other equipment, may 
give rise to 'bell tinkle' or noise and cause a false answer condition. If you encounter such problems, 
do not contact the Telecom Faults Service. 

306 Xerox® WorkCentre® 7970 Multifunction Printer 
 User Guide 
 



Regulatory Information 

 

6. DTMF tones dialing is the preferred method because it is faster than pulse (decadic) dialing and is 
readily available on almost all New Zealand telephone exchanges. 

 

 WARNING: No '111' or other calls can be made from this device during a mains power failure. 

7. This equipment may not provide for the effective hand-over of a call to another device connected to 
the same line. 

8. Some parameters required for compliance with Telecom Telepermit requirements are dependent on 
the equipment (computer) associated with this device. The associated equipment shall be set to 
operate within the following limits for compliance with Telecom Specifications: 
For repeat calls to the same number: 
− There shall be no more than 10 call attempts to the same number within any 30 minute period 

for any single manual call initiation, and 
− The equipment shall go on-hook for a period of not less than 30 seconds between the end of 

one attempt and the beginning of the next attempt. 
For automatic calls to different numbers: 
The equipment shall be set to ensure that automatic calls to different numbers are spaced such that 
there is no less than five seconds between the end of one call attempt and the beginning of another. 

9. For correct operation, total of the RNs of all devices connected to a single line at any time should not 
exceed five. 

 

South Africa 

This modem must be used in conjunction with an approved surge protection device. 
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Safety Certification 

This device is certified by the following Agencies using the following safety standards. 
 

Agency Standard 

Underwriters Laboratories Inc. (US/Canada) UL60950-1 (2007) 2nd Edition 
CSA 22.2 No. 60950-1-07 2nd Edition 

Underwriters Laboratories Inc. (Europe) IEC60950-1:2005 (2nd Edition) +A1:2009 
EN60950-1:2006 (2nd Edition) +A11:2009 +A1:2010 
+A12:2011 (CB Scheme) 
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Material Safety Data Sheets 

For Material Safety Data information regarding your printer, go to: 
• North America: www.xerox.com/msds 
• European Union: www.xerox.com/environment_europe 

For the Customer Support Center phone numbers, go to www.xerox.com/office/worldcontacts. 
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All Countries 

If you are managing the disposal of your Xerox product, please note that the printer may contain lead, 
mercury, perchlorate, and other materials whose disposal may be regulated due to environmental 
considerations. The presence of these materials is fully consistent with global regulations applicable at 
the time that the product was placed on the market. For recycling and disposal information, contact your 
local authorities. Perchlorate Material: This product may contain one or more Perchlorate-containing 
devices, such as batteries. Special handling may apply, please see 
www.dtsc.ca.gov/hazardouswaste/perchlorate. 
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North America 

Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox representative 
(1-800-ASK-XEROX) to determine if this Xerox product is part of the program. For more information about 
Xerox environmental programs, visit www.xerox.com/environment, or for recycling and disposal 
information, contact your local authorities. 
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European Union 

Some equipment may be used in both a domestic/household and a professional/business application. 
 

Domestic/Household Environment 

 

Application of this symbol on your equipment is confirmation that you 
should not dispose of the equipment in the normal household waste 
stream. 

In accordance with European legislation, end of life electrical and electronic equipment subject to 
disposal must be segregated from household waste. 

Private households within EU member states may return used electrical and electronic equipment to 
designated collection facilities free of charge. Please contact your local disposal authority for 
information. 

In some member states, when you purchase new equipment, your local retailer may be required to take 
back your old equipment free of charge. Please ask your retailer for information. 
 

Professional/Business Environment 

 

Application of this symbol on your equipment is confirmation that you 
must dispose of this equipment in compliance with agreed national 
procedures. 

In accordance with European legislation, end of life electrical and electronic equipment subject to 
disposal must be managed within agreed procedures. 

Prior to disposal, please contact your local reseller or Xerox representative for end of life take-back 
information. 
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Collection and Disposal of Equipment and Batteries 

 

These symbols on the products and/or accompanying documents mean 
that used electrical and electronic products and batteries should not be 
mixed with general household waste. 

For proper treatment, recovery, and recycling of old products and used 
batteries, please take them to applicable collection points, in 
accordance with your national legislation and the Directive 2002/96/EC 
and 2006/66/EC. 

By disposing of these products and batteries correctly, you will help to 
save valuable resources and prevent any potential negative effects on 
human health and the environment which could otherwise arise from 
inappropriate waste handling. 

For more information about collection and recycling of old products 
and batteries, please contact your local municipality, your waste 
disposal service or the point of sale where you purchased the items. 

Penalties may be applicable for incorrect disposal of this waste, in 
accordance with national legislation. 

 
 

Business Users in the European Union 

If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for 
further information. 
 

Disposal Outside of the European Union 

These symbols are only valid in the European Union. If you wish to discard these items, please contact 
your local authorities or dealer and ask for the correct method of disposal. 
 

Battery Symbol 

 

This wheeled bin symbol may be used in combination with a chemical 
symbol. Use of this symbol establishes compliance with the 
requirements set out by the Directive. 

 
 

Battery Removal 

Batteries should only be replaced by a MANUFACTURER-approved service facility. 
 

 Xerox® WorkCentre® 7970 Multifunction Printer 315 
 User Guide 
 



Recycling and Disposal 

 

Other Countries 

Please contact your local waste management authority to request disposal guidance. 

316 Xerox® WorkCentre® 7970 Multifunction Printer 
 User Guide 
 


	Contents
	Safety
	Warning Symbols
	Notices and Safety
	Emergency Turn Off
	General Guidelines

	Electrical Safety
	Electrical Supply
	Emergency Turn Off
	Power Cord Safety Information

	Operational Safety
	Printer Location
	Operational Guidelines
	Consumables Information
	Vacuum Cleaner Use for Toner Spills

	Ozone Release

	Maintenance Safety
	Printer Symbols
	Environmental, Health, and Safety Contact Information

	Features
	Parts of the Printer
	Left Front View
	Left Rear View
	Internal Components
	Document Feeder
	Control Panel
	Business Ready Finisher with Optional Booklet Maker
	Business Ready Finisher with Optional C/Z Folder
	Wireless Network Adapter

	Information Pages
	Printing the Configuration Report

	Administration Features
	Accessing the Printer
	Authentication
	Authorization
	Accounting
	Logging In
	Logging In at the Control Panel
	Logging In to CentreWare Internet Services
	Administrator Password
	Logging In as the System Administrator at the Control Panel


	CentreWare Internet Services
	Accessing CentreWare Internet Services

	Finding the IP Address of the Printer
	Automatic Data Collection
	Billing and Usage Information

	More Information
	Welcome Center
	Locating the Serial Number



	Installation and Setup
	Installation and Setup Overview
	Initial Printer Setup
	Physically Connecting the Printer to the Network
	Connecting to a Telephone Line
	Turning the Printer On and Off
	Preventing Printer Malfunction
	USB Cover
	Optimizing Printer Performance

	Modifying General Settings
	Setting Energy Saver Mode
	Setting the Date and Time at the Control Panel

	Installing the Software
	Operating System Requirements
	Installing Drivers and Utilities for Windows
	Installing Print Drivers and Utilities for Macintosh OS X Versions 10.7 and Later
	Installing Print Drivers and Utilities for UNIX and Linux Printing
	Xerox® Print Driver Package
	Xerox® Print Drivers
	Xerox® Printer Manager
	Installing Xerox® Print Driver Package
	Launching Xerox® Printer Manager

	Other Drivers


	Paper and Media
	Supported Paper
	Recommended Media
	Ordering Paper
	General Paper Loading Guidelines
	Paper That Can Damage Your Printer
	Paper Storage Guidelines
	Supported Paper Types and Weights
	Supported Standard Paper Sizes
	Supported Paper Sizes and Weights for Automatic 2-Sided Printing
	Supported Paper Sizes for the Envelope Tray
	Supported Custom Paper Sizes

	Loading Paper
	Loading Paper in Trays 1–4
	Setting the Guide Locks in the 500-Sheet Adjustable Trays
	Changing Paper Size, Type, and Color
	Loading Paper in Trays 3 and 4 of the Tandem Tray Module
	Loading Paper in Tray 5 (Bypass Tray)
	Loading Paper in Tray 6 (High-Capacity Feeder)
	Configuring Tray 6 in the High-Capacity Feeder

	Printing on Special Paper
	Envelopes
	Guidelines for Printing Envelopes
	Loading Envelopes in Tray 5
	Loading the Envelope Tray

	Labels
	Guidelines for Printing Labels
	Loading Labels in Trays 1–4
	Loading Labels in Tray 5

	Glossy Cardstock
	Guidelines for Printing on Gloss Paper
	Loading Gloss Paper in Tray 5 (Bypass Tray)

	Transparencies
	Guidelines for Printing on Transparencies



	Printing
	Printing Overview
	Selecting Printing Options
	Print Driver Help
	Windows Printing Options
	Setting Default Printing Options for Windows
	Selecting Printing Options for an Individual Job for Windows
	Selecting Finishing Options for Windows
	Saving a Set of Commonly Used Printing Options for Windows

	Macintosh Printing Options
	Selecting Printing Options for Macintosh
	Selecting Finishing Options for Macintosh
	Saving a Set of Commonly Used Printing Options for Macintosh

	Linux Printing Options
	Launching Xerox® Printer Manager
	Printing from a Linux Workstation


	Managing Jobs
	Managing Jobs at the Control Panel
	Managing Secure and Held Print Jobs
	Managing Jobs in CentreWare Internet Services

	Printing Features
	Printing on Both Sides of the Paper
	Paper Types for Automatic 2-Sided Printing
	Printing a 2-Sided Document
	2-Sided Page Layout Options

	Selecting Paper Options for Printing
	Printing Multiple Pages to a Single Sheet
	Printing Booklets
	Using Image Options
	Printing Cover Pages
	Printing Insert Pages
	Printing Exception Pages
	Scaling
	Printing Watermarks
	Printing Mirror Images
	Creating and Saving Custom Sizes
	Selecting Job Completion Notification for Windows

	Printing Special Job Types
	Secure Print
	Sending a Secure Print Job
	Releasing a Secure Print
	Deleting a Secure Print

	Sample Set
	Sending a Sample Set Print Job
	Releasing the Remaining Prints After Printing a Sample Set

	Delay Print
	Sending a Delay Print Job

	Saved Job
	Sending a Public Saved Job
	Sending a Private Saved Job


	Held Print Jobs
	Releasing Held Print Jobs

	Print From
	Printing from a USB Flash Drive
	Printing from Saved Jobs
	Printing from Mailbox
	Printing from CentreWare Internet Services


	Copying
	Basic Copying
	Document Glass
	Duplex Automatic Document Feeder

	Selecting Copy Settings
	Basic Settings
	Selecting Color or Black and White Copies
	Reducing or Enlarging the Image
	Selecting the Paper Tray
	Selecting 2-Sided Copy Options
	Selecting Collated Copies
	Selecting Uncollated Copies
	Stapling Copies

	Image-Quality Settings
	Specifying the Original Type
	Adjusting Brightness, Sharpness, and Saturation
	Automatically Suppressing Background Variation
	Adjusting the Contrast
	Selecting Color Effects
	Adjusting the Color Balance

	Layout Settings
	Specifying the Orientation of the Original
	Specifying the Size of the Original
	Selecting Book Copying
	Shifting the Image
	Erasing the Edges of Copies
	Inverting the Image

	Output Format Settings
	Creating a Booklet
	Including Covers
	Specifying Chapter Start Pagination
	Adding Inserts
	Specifying Exception Pages
	Adding Annotations
	Adding Transparency Separators
	Printing Multiple Pages Per Side
	Repeating an Image

	ID Card Copying
	Copying an ID Card
	Selecting Color or Black and White Copies
	Reducing or Enlarging the Image
	Selecting the Paper Tray
	Specifying the Original Type
	Lightening or Darkening ID Card Copies
	Automatically Suppressing Background Variation

	Advanced Copying
	Building a Copy Job
	Printing a Sample Copy
	Saving Copy Settings
	Retrieving Saved Copy Settings



	Scanning
	Basic Scanning
	Document Glass
	Duplex Automatic Document Feeder

	Scanning to a Folder
	Scanning to the Public Folder
	Scanning to a Private Folder
	Creating a Private Folder
	Retrieving Scan Files

	Scanning to Network File Repositories
	Scanning to a Predefined Network File Repository
	Adding a Scan Destination

	Scanning to Your Home Directory
	Setting Scan Options
	Changing the Basic Scan Settings
	Selecting Advanced Settings
	Selecting Layout Adjustments
	Selecting Filing Options
	Building a Scan Job

	Scanning to a USB Flash Drive
	Scanning to an Email Address
	Sending a Scanned Image to an Email Address
	Setting Email Options

	Scanning to a Destination
	Sending a Scanned Image to a Destination


	Faxing
	Basic Faxing
	Document Glass
	Duplex Automatic Document Feeder

	Sending an Embedded Fax
	Selecting Fax Options
	Adjusting Brightness and Sharpness
	Automatically Suppressing Background Variation
	Adjusting the Contrast
	Specifying the Size of the Original
	Selecting Reducing or Splitting
	Setting Up Book Faxing
	Printing a Confirmation Report
	Selecting the Starting Rate
	Sending a Delayed Fax
	Sending Header Text
	Sending a Fax to a Remote Mailbox
	Storing a Fax in a Local Mailbox
	Printing Local Mailbox Documents
	Deleting Local Mailbox Documents
	Storing a Fax for Local or Remote Polling
	Printing or Deleting Secure Faxes
	Polling a Remote Fax
	Building a Fax Job


	Sending a Server Fax
	Selecting Server Fax Options
	Adjusting Brightness
	Automatically Suppressing Background Variation
	Adjusting the Contrast
	Specifying the Orientation of the Original
	Specifying the Size of the Original
	Sending a Delayed Fax
	Building a Fax Job


	Sending an Internet Fax
	Selecting Internet Fax Options
	Adjusting Brightness and Sharpness
	Automatically Suppressing Background Variation
	Adjusting the Contrast
	Setting the Resolution
	Setting the Quality and File Size
	Specifying the Orientation of the Original
	Specifying the Size of the Original
	Adding a Message
	Specifying a Reply To Address
	Printing an Acknowledgment Report
	Building a Fax Job


	Sending a LAN Fax
	Using the Address Book
	Adding an Individual Entry to the Device Address Book
	Editing an Individual Address Book Entry
	Editing or Deleting Favorites in the Device Address Book
	Printing a Fax Report


	Maintenance
	General Precautions
	Cleaning the Printer
	Cleaning the Document Glass and Document Cover
	Cleaning the Document Feed Rollers
	Cleaning the Second-Side Scanning Lens Assembly
	Cleaning the Printer Exterior
	Cleaning the Printer Interior
	Cleaning the Printhead Lenses


	Routine Maintenance
	Replacing the Toner Cartridges
	Replacing the Waste Toner Container
	Replacing the Drum Cartridges
	Replacing the Transfer Belt Cleaner
	Replacing the Second Bias Transfer Roller
	Resetting Supply Life Counters
	Replacing Staple Cartridges
	Replacing Staples in the Main Stapler of the Business Ready Finisher
	Replacing Staples in the Booklet Maker of the Business Ready Finisher

	Emptying the Hole Punch Waste Container
	Emptying the Hole Punch Waste Container in the Business Ready Finisher


	Billing and Usage Information
	Ordering Supplies
	Locating the Serial Number
	Consumables
	Routine Maintenance Items
	Other Supplies
	When to Order Supplies
	Viewing Printer Supply Status
	Recycling Supplies

	Moving the Printer

	Troubleshooting
	General Troubleshooting
	Printer Has Two Power Switches
	Restarting the Printer
	Printer Does Not Turn On
	Printer Resets or Turns Off Frequently
	Printing Takes Too Long
	Document Fails to Print
	Document Prints from Wrong Tray
	Printer is Making Unusual Noises
	Automatic 2-Sided Printing Problems
	Date and Time Are Incorrect
	Scanner Errors

	Jams
	Clearing Paper Jams
	Clearing Jams at Trays 1–4
	Clearing Jams at Tray 5 (Bypass Tray)
	Clearing Jams at Door A
	Clearing Jams at Door B
	Clearing Jams at Door C
	Clearing Jams at Door D
	Clearing Jams in the Document Feeder

	Clearing Jams in the Business Ready Finisher
	Clearing Jams in the Center Tray
	Clearing Jams in the Finisher Transport
	Clearing Jams at 3a in the Finisher
	Clearing Jams at 3c in the Finisher
	Clearing Jams at 3d in the Finisher
	Clearing Jams at 4 in the Finisher
	Clearing Jams in the Booklet Tray

	Clearing Jams in the CZ Folder
	Clearing Jams at 2a in the CZ Folder
	Clearing Jams at 2b in the CZ Folder
	Clearing Jams at 2e in the CZ Folder
	Clearing Jams at 2f in the CZ Folder
	Clearing Jams at 2g in the CZ Folder

	Minimizing Paper Jams
	Troubleshooting Paper Jams
	Multiple Sheets Pulled Together
	Jams in the Document Feeder
	Paper Misfeeds and Paper Size Jams
	Label and Envelope Misfeeds
	Paper Jam Message Stays On
	Jams During Automatic 2-Sided Printing

	Clearing Staple Jams
	Clearing Main Staple Jams in the Business Ready Finisher
	Clearing Staple Jams in the Business Ready Finisher Booklet Maker

	Clearing Hole Punch Jams
	Clearing Hole Punch Jams in the Finisher


	Print-Quality Problems
	Controlling Print Quality
	Paper and Media
	Print-Quality Modes
	Color Corrections and Color Adjustments

	Troubleshooting Print-Quality Problems
	Printing the Troubleshooting Print-Quality Pages
	Eliminating the Paper or Media as the Problem
	Isolating the Problem to the Printer or to the Application
	Troubleshooting Print-Quality Problems in the Application, Print Driver, or Print Server
	Troubleshooting Print-Quality Problems in the Printer
	Performing the Print Calibration Procedure
	Print-Quality Problems and Solutions


	Copy and Scan Problems
	Fax Problems
	Problems Sending Faxes
	Problems Receiving Faxes

	Getting Help
	Control Panel Messages
	Control Panel Help
	Viewing Fault and Alert Messages on the Control Panel
	Viewing the Fault History on the Control Panel

	Using the Integrated Troubleshooting Tools
	Printing Information Pages
	Specifying the Source Tray for Printing Information Pages
	Printing the Configuration Report
	Viewing Billing and Usage Information
	Locating the Serial Number on the Control Panel
	Viewing Printer Supply Status
	CentreWare Internet Services

	More Information


	Specifications
	Printer Configurations and Options
	Standard Features
	Options and Upgrades

	Physical Specifications
	Base Configuration
	Configuration with Business Ready Finisher and Booklet Maker
	Configuration with Business Ready Finisher, Booklet Maker, and CZ Folder
	Configuration with Business Ready Finisher, Booklet Maker, CZ Folder, and High-Capacity Feeder
	Clearance Requirements
	Clearance Requirements for Base Configuration
	Clearance Requirements for Configuration with Business Ready Finisher and Booklet Maker
	Clearance Requirements for Configuration with Business Ready Finisher, Booklet Maker, and CZ Folder
	Clearance Requirements for Configuration with Business Ready Finisher, Booklet Maker, CZ Folder, and High-Capacity Feeder


	Environmental Specifications
	Temperature
	Relative Humidity
	Elevation

	Electrical Specifications
	Performance Specifications
	Printing Resolution
	Print Speed

	Environmental, Health, and Safety Contact Information

	Regulatory Information
	Basic Regulations
	United States FCC Regulations
	Canada
	Certifications in Europe
	European Union Lot 4 Imaging Equipment Agreement Environmental Information
	Environmental Information Providing Environmental Solutions and Reducing Cost
	Environmental Benefits of Duplex Printing
	Paper Types
	ENERGY STAR
	Power Consumption and Energy Saver Activation Time
	Default Energy Saver Settings for Product


	Germany
	Germany - Blue Angel
	Blendschutz
	Lärmemission
	Importeur

	Turkey RoHS Regulation
	Eurasian Economic Community Certification
	Regulatory Information for 2.4 GHz Wireless Network Adapter
	Ozone Release

	Copy Regulations
	United States
	Canada
	Other Countries

	Fax Regulations
	United States
	Fax Send Header Requirements
	Data Coupler Information

	Canada
	Canada CS-03 Issue 9

	European Union
	Radio Equipment and Telecommunications Terminal Equipment Directive

	New Zealand
	South Africa

	Safety Certification
	Material Safety Data Sheets

	Recycling and Disposal
	All Countries
	North America
	European Union
	Domestic/Household Environment
	Professional/Business Environment
	Collection and Disposal of Equipment and Batteries
	Business Users in the European Union
	Disposal Outside of the European Union

	Battery Symbol
	Battery Removal

	Other Countries


